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Chapter 1. Administration

1.1. Global System Preferences

Global system preferences control the way your Koha system works in general. Set these preferences before anything else in Koha.

Get there: More > Administration > Global System Preferences

System preferences can be searched (using any part of the preference name or description) using the search box on the 'Administration’ page or the search box
at the top of each system preferences page.

When editing preferences a '(modified)' tag will appear next to items you change until you click the 'Save All' button:
After saving your preferences you'll get a confirmation message telling you what preferences were saved:

Each section of preferences can be sorted alphabetically by clicking the small down arrow to the right of the word 'Preference’ in the header column

1.1.1. Acquisitions

Get there: More > Administration > Global System Preferences > Acquisitions

1.1.1.1. Policy

1.1.1.1.1. AcqCreateltem

Default: placing an order
Asks: Create an item when ___.
Values:

cataloging a record

placing an order

receiving an order

1.1.1.1.2. CurrencyFormat

Default: 360,000.00 (US)
Asks: Display currencies using the following format ____
Values:

360,000.00 (US)

360 000,00 (FR)

page 8



1.1.1.1.3. gist

Default: 0
Asks: The default tax rate is ____
Description:
This preference will allow the library to define a default Goods and Services Tax rate. The default of value of 0 will disable this preference.

Enter this value as a number (.06) versus a percent (6%).

1.1.1.2. Printing

1.1.1.2.1. OrderPdfFormat

Default: pdfformat::layout2pages

Asks: Use ____ when printing basket groups.

1.1.2. Administration

These preferences are general settings for your system.

Get there: More > Administration > Global System Preferences > Administration

1.1.2.1. CAS Authentication

The Central Authentication Service (CAS) is a single sign-on protocol for the web. If you don't know what this is, leave these preferences set to their defaults.

1.1.2.1.1. casAuthentication

Default: Don't use

Asks: ___ CAS for login authentication.

1.1.2.1.2. caslLogout

Default: Don't logout

Asks: ____ of CAS when logging out of Koha.

1.1.2.1.3. casServerUrl

Asks: The CAS Authentication Server can be found at

1.1.2.2. Interface options

These preference are related to your Koha interface

1.1.2.2.1. DebugLevel

Default: lots of
Asks: Show ___ debugging information in the browser when an internal error occurs.
Values:

lots of - will show as much information as possible

no - will only show basic error messages

some - will show only some of the information available
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Description:

This preference determines how much information will be sent to the user's screen when the system encounters an error. The most detail will be sent when
the value level is set at 2, some detail will be sent when the value is set at 1, and only a basic error message will display when the value is set at 0. This
setting is especially important when a system is new and the administration is interested in working out the bugs (errors or problems) quickly. Having detailed
error messages makes quick fixes more likely in problem areas.

1.1.2.2.2. delimiter
This preference determines how reports exported from Koha will separate data.
Default: semicolons
Asks: Separate columns in an exported report file with ____ by default.
Values:
#'s
backslashes
commas
semicolons
slashes

tabs

1.1.2.2.3. KohaAdminEmailAddress

This is the default 'From' address for emails unless there is one for the particular branch, and is referred to when an internal error occurs.
Asks: Use as the email address for the administrator of Koha.
Description:

This preference allows one email address to be used in warning messages set to the OPAC. If no email address is set for the branch this address will receive
messages from patrons regarding modification requests, purchase suggestions, and questions or information regarding overdue notices. It is recommended
that a email address that can be accessed by multiple staff members be used for this purpose so that if one librarian is out the others can address these
requests. This email address can be changed when needed.

1.1.2.2.4. noltemTypelmages

Default: Show
Asks: ___itemtype icons in the catalog.
Values:

Shows

Don't show

Description:

This preference allows the system administrator to determine if users will be able to set and see an item type icon the catalog on both the OPAC and the Staff
Client. The images will display in both the OPAC and the Staff Client/Intranet. If images of item types are disabled, text labels for item types will still appear in
the OPAC and Staff Client.

1.1.2.2.5. virtualshelves

Default: Allow
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Asks: ___ staff and patrons to create and view saved lists of books.
Values:
Allow

Don't Allow

1.1.2.3. Login options

These preferences are related to logging into your Koha system

1.1.2.3.1. AutoLocation

Default: Don't require
Asks: ____ staff to log in from a computer in the IP address range specified by their library (if any).
Set IP address range in the library administration area

Get there: More > Administration > Basic Parameters > Libraries & Groups

Values:
Don't require

Require

Description:

This preference protects the system by blocking unauthorized users from accessing the staff client program and settings. Authorized and unauthorized users
are determined by their computer's IP addresses. When the preference is set to 'Require’, IP authorization is in effect and unauthorized IP addresses will be
blocked. This means that staff cannot work from home unless their IP address has been authorized. When set to 'Don't require’, anyone with a staff client login
will have access no matter which IP address they are using.

1.1.2.3.2. IndependantBranches

Default: Don't prevent
Asks: ___ staff (but not superlibrarians) from modifying objects (holds, items, patrons, etc.) belonging to other libraries.
Values:

Don't prevent

Prevent

Description:

This preference should only be used by library systems which are sharing a single Koha installation among multiple branches but are considered independent
organizations, meaning they do not share material or patrons with other branches and do not plan to change that in the future. If set to 'Prevent' it increases
the security between library branches by: prohibiting staff users from logging into another branch from within the staff client, filtering out patrons from patron
searches who are not a part of the login branch conducting the search, limiting the location choices to the login branch when adding or modifying an item
record, preventing users from other branch locations from placing holds or checking out materials from library branches other than their own, and preventing
staff from editing item records which belong to other library branches. All of these security safeguards can be overridden only by the superlibrarian, the highest
level of privileges.

It is important that this value be set before going live and that it NOT be changed

1.1.2.3.3. insecure

Default: Don't allow
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Asks: ___ staff to access the staff client without logging in.
Description:

This preference controls whether or not authentication (user login) will be required to gain access to the staff client. If set to 'Allow’, all authentication is
bypassed. If set to 'Don't allow' authentication (login) on the staff client is required.

Values:
Allow
Don't allow

Enabling this is dangerous, and should not be done in production environments.

1.1.2.3.4. SessionStorage

Default: in the MySQL database
Asks: Store login session information ____
Values:

as temporary files

in the MySQL database

in the PostgreSQL database

PostgreSQL is not yet supported

Description:

This preference allows administrators to choose what format session data is stored in during web sessions.

1.1.2.3.5. timeout

Default: 12000000

Asks: Automatically log out users after ____ seconds of inactivity.
Description:

This preference sets the length of time the Staff Client or OPAC accounts can be left inactive before re-logging in is necessary. The value of this preference is
in seconds. At this time, the amount of time before a session times out must be the same for both the Staff Client and the OPAC.

1.1.3. Authorities

Get there: More > Administration > Global System Preferences > Authorities

1.1.3.1. BiblioAddsAuthorities

Default: allow
Asks: When editing records, ____ them too automatically create new authority records if needed, rather than having to reference existing authorities.
Values:

allow

This setting allows you to type values in the fields controlled by authorities and then adds a new authority if one does not exist

don't allow

This setting will lock the authority controlled fields, forcing you to search for an authority versus allowing you to type the information in yourself.
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1.1.3.2. dontmerge

Default: Don't
Asks: ___ automatically update attached biblios when changing an authority record.
Values:

Do

Don't

If this is set to not merge you will need to ask your administrator to enable the merge_authorities.pl cronjob.

1.1.4. Cataloging

Get there: More > Administration > Global System Preferences > Cataloging

1.1.4.1. Display

1.1.4.1.1. authoritysep

Default: --

Asks: Separate multiple displayed authors, series or subjects with ___.

1.1.4.1.2. hide_marc
Default: Display
Asks: ___ MARC tag numbers, subfield codes and indicators in MARC views.
Values:
Display -- shows the tag numbers on the cataloging interface

Don't display -- shows just descriptive text when cataloging

1.1.4.1.3. IntranetBiblioDefaultView

Default: ISBD form
Asks: By default, display biblio records in ____
Values:
ISBD form -- displays records in the staff client in the old card catalog format

See ISBD preference for more information

Labelled MARC form -- displays records in the staff client in MARC with text labels to explain the different fields
MARC form -- displays records in the staff client in MARC

normal form -- visual display in the staff client (for the average person)

Description:

This setting determines the bibliographic record display when searching the catalog on the staff client. This setting does not affect the display in the OPAC
which is changed using the BiblioDefaultView preference under the OPAC preference tab. This setting changes the look of the record when first displayed.
The MARC and ISBD views can still be seen by clicking in the sidebar.
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1.1.4.1.4.1SBD

Default: MARC21 Default Appendix or UNIMARC Default Appendix

Asks: Use the following as the ISBD template:
Description:

This determines how the ISBD information will display. Elements in the list can be reordered to produce a different ISBD view. ISBD, the International
Standard Bibliographic Description, was first introduced by IFLA (International Federation of Library Associations) in 1969 in order to provide guidelines for
descriptive cataloging. The purpose of ISBD is to aid the international exchange of bibliographic records for a variety of materials.

1.1.4.1.5. LabeIMARCView

Default: Don't
Asks: ___ collapse repeated tags of the same type into one tag entry.
Values:
Do -- will combine all identical tag numbers under one heading in the MARC view in the OPAC and Staff Client

Don't -- will list all of the tags individually in the MARC view in the OPAC and Staff Client

1.1.4.1.6. OpacSuppression

Default: Don't hide
Asks: ____items marked as suppressed from OPAC search results.
Values:
Don't hide -- will show items in OPAC search results if they are marked suppressed
Hide -- will not show items in OPAC search results if they're marked as suppressed
Each bib record with items you want to hide from the OPAC simply need to have the 942n field set to 1. The index then hides it from display in OPAC but
will still display it in the Staff Client
Description:

An authorized value for 942$n field should be set to eliminate errors. One example would be to create an authorized value titted SUPRESS with a value of O
for don't suppress and 1 for suppress.

If this preference is set to 'hide' and you have the 942n field set to 1, it will hide the entire bib record - not just an individual item.
You must have the Suppress index set up in Zebra and at least one suppressed item, or your searches will be broken.

1.1.4.1.7. URLLinkText

Default: Online Resource
Asks: Show ____ as the text of links embedded in MARC records.
Description:

If the 856 field does not have a subfield 3 or y defined, the OPAC will say 'Click here to access online." If you would like the field to say something else enter
that in this field.

1.1.4.2. Interface

1.1.4.2.1. advancedMARCeditor

Default: Don't display
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Asks: ___ descriptions of fields and subfields in the MARC editor.
Description:

This preference determines whether or not MARC field names will be present when editing or creating MARC records.

Values:
Display

Don't display

1.1.4.2.2. DefaultClassificationSource

Default: Dewey Decimal System
Asks: Use ____ as the default classification source.
Values:
ANSCR (Sound Recordings)
Dewey Decimal Classification
Library of Congress Classification
Other/Generic Classification Scheme
SuDoc Classification (U.S. GPO)

Universal Decimal Classification

1.1.4.3. Record Structure

1.1.4.3.1. autoBarcode

Default: generated in the form <branchcode>yymm0001
Asks: Barcodes are ____
Values:
generated in the form <branchcode>yymmO0001
generated in the form <year>-0001
<year>-0002. generated in the form 1, 2, 3

not generated automatically

Description:

This setting is for libraries wishing to generate barcodes from within Koha (as opposed to scanning in pre-printed barcodes or manually assigning them).

1.1.4.3.2. item-level itypes

Default: specific item
Asks: Use the item type of the ___ as the authoritative item type (for determining circulation and fines rules, etc).
Values:

biblio record
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specific item

Description:

This preference determines whether the item type Koha uses for issuing rules will be an attribute of the bibliographic record or the item record. Most libraries
refer to the item record for item types.

1.1.4.3.3. itemcallnumber

Default: 082ab
Asks: Map the MARC subfield to an item's callnumber.

This can contain multiple subfields to look in; for instance 082ab would look in 082 subfields a and b.
Description:

This setting determines which MARC field will be used to determine the call number that will be entered into item records automatically (952%0). The value is
set by providing the MARC field code (050, 082, 090, 852 are all common) and the subfield codes without the delimiters ($a, $b would be ab).

Examples:

Dewey: 082ab or 092ab; LOC: 050ab or 090ab; from the item record: 852hi

1.1.4.3.4. marcflavour

Default: MARC21
Asks: Interpret and store MARC records in the ___ format.
Description:

This preference defines global MARC style (MARC21 or UNIMARC) used for encoding. MARC21 is the standard style for the US, Canada and Britain.
UNIMARC is a variation of MARC21 that is used in France, Italy, Russia, and many other countries.

Values:
MARC21

UNIMARC

1.1.4.3.5. MARCOrgCode

Default: OSt
Asks: Fill in the MARC organization code ____ by default in new MARC records (leave blank to disable).
Description:

The MARC Organization Code is used to identify libraries with holdings of titles and more.

Learn more and find your library's code on the MARC Code list for Organizations or in Canada on the Canadian Symbols Directory.

1.1.4.3.6. NewltemsDefaultLocation

Asks: When items are created, give them the temporary location of ___ (should be a location code, or blank to disable).

1.1.4.3.7. z3950NormalizeAuthor & z3950AuthorAuthFields

Defaults: Don't copy & 701,702,700

Asks: ___ authors from the UNIMARC ___ tags (separated by commas) to the correct author tags when importing a record using Z39.50.
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Description for z3950NormalizeAuthor:

This preference allows for ‘Personal Name Authorities' to replace authors as the bibliographic authority. This preference should only be considered by libraries
using UNIMARC.

Values for z3950NormalizeAuthor:
Copy

Don't copy

Description for z3950AuthorAuthFields:

This preference defines which MARC fields will be used for ‘Personal Name Authorities' to replace authors as the bibliographic authorities. This preference
only applies to those using UNIMARC encoding. The MARC fields selected here will only be used if ‘zZ3950NormalizeAuthor’ is set to “Copy". The default field
are 700, 701, and 702.

1.1.4.4. Spine Labels

1.1.4.4.1. SpineLabelAutoPrint

Default: don't
Asks: When using the quick spine label printer, ___ automatically pop up a print dialog.
Values:

do

don't

1.1.4.4.2. SpineLabelFormat

Default: <itemcallnumber><copynumber>

Asks: Include the following fields on a quick-printed spine label: (Enter in columns from the biblio, biblioitems or items tables, surrounded by < and >.)

1.1.4.4.3. SpineLabelShowPrintOnBibDetails

Default: Don't display
Asks: ___ buttons on the bib details page to print item spine labels.
Values:

Display

Don't display

1.1.5. Circulation

Get there: More > Administration > Global System Preferences > Circulation

1.1.5.1. Checkout Policy

1.1.5.1.1. AllowNotForLoanOverride

Default: Allow

Asks: staff to override and check out items that are marked as not for loan.
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Values:
Allow

Don't allow

Description:

This parameter is a binary setting which controls the ability of staff (patrons will always be prevented from checking these items out) to check out items that
are marked as “not for loan". Setting it to “Allow" would allow such items to be checked out, setting it to “Don't allow" would prevent this. This setting
determines whether items meant to stay in the library, such as reference materials, and other library resources can be checked out by patrons.

1.1.5.1.2. AllowRenewalLimitOverride

Default: Allow
Asks: ___ staff to manually override the renewal limit and renew a checkout when it would go over the renewal limit.
Values:

Allow

Don't allow

Description:

This preference is a binary setting which controls the ability of staff to override the limits placed on the number of times an item can be renewed. Setting it to
“Allow" would allow such limits to be overridden, setting it to “Don't allow" would prevent this. This is a preference in which if it is set to “allow" it would allow
the library staff to use their judgment for overriding the renew limit for special cases, setting it to “Don't allow" prevents an opportunity for abuse by the library
staff.

1.1.5.1.3. AutomaticltemReturn

Default: Do
Asks: ___ automatically transfer items to their home branch when they are returned.
Values:
Do
Don't
Description:

This preference is a binary setting which determines whether an item is returned to its home branch automatically or not. If set to “Don't", the staff member
checking an item in at a location other than the item's home branch will be asked whether the item will remain at the non-home branch (in which case the new
location will be marked as a holding location) or returned. Setting it to “Do" will ensure that items checked in at a branch other than their home branch will be
sent to that home branch.

1.1.5.1.4. ceilingDueDate

Default: no value
Asks: Make all checkouts due on or before

Description:

This preference limits the due date of all items to be before a selected date. This means that any items checked out will be due no later than the selected date.
This preference is useful if the library is going to be closed for an extended period of time. This allows for the opportunity for all materials to be returned by a
certain date (presumably the closure date).

Enter the date to match the format you set in your localization preferences (iso = YYYY-MM-DD or metric = MM/DD/YYYY)
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Get there: More > Administration > Global system preferences > 118N/L10N > dateformat

1.1.5.1.5. CircControl

Default: the library the item is from
Asks: Use the checkout and fines rules of ____
Values:

the library the item is from

The circulation and fines policies will be determined by the library that owns the item

the library the patron is from

The circulation and fines policies will be determined the patron's home library

the library you are logged in at

The circulation and fines policies will be determined by the library that checked the item out to the patron

1.1.5.1.6. globalDueDate

Default: no value
Asks: Make all checkouts have a due date of ___
Description:

This preference sets a specific date upon which all library materials must be returned, regardless of whether or not this date interferes with the normal
check-out duration. This feature is particularly useful for school libraries that close during the summer break and require the return of their materials before the
end of the academic year. No default value is set and the parameter is left blank unless a date is entered.

Enter the date to match the format you set in your localization preferences (iso = YYYY-MM-DD or metric = MM/DD/YYYY)

Get there: More > Administration > Global system preferences > 118N/L10N > dateformat

1.1.5.1.7. HomeOrHoldingBranch

Default: the library the item was checked out from

Asks: Use the checkout and fines rules of ___

Description:
This preference establishes what may be done with a loaned item once the item has been returned. It deals with situations in which one library branch has
borrowed materials from a different branch. Essentially it decides whether a library may check the borrowed item back out to its patron or if it must immediately
send the item back to the owning location.

Values:
the library the item is from
the library the item was checked out from

It is not recommend that this setting be changed after initial setup of Koha
This preference does nothing unless the IndependantBranches preference is set to 'Prevent'.

Get there: More > Administration > Global System Preferences > Admin > IndependantBranches

1.1.5.1.8. InProcessingToShelvingCart
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Default: Don't move
Asks: ___items that have the location PROC to the location CART when they are checked in.
Values:

Don't move

Move

1.1.5.1.9. IssuingInProcess

Default: Don't prevent
Asks: ___patrons from checking out an item whose rental charge would take them over the limit.
Values:

Don't prevent

Prevent

Description:

This preference determines if a patron can check items out if there is an overdue fine on the account and any of the materials the patron wishes to check out
will potentially tip the account balance over the maximum fines policy the library has in place.

Example: Your library has a $5 limit set for ‘fines' (ie, after incurring $5 in fines, a patron can no longer check out items). A patron comes to the desk with 5 items
to check out (4 books and a video) The patron has $4 in charges already on their account. One of the videos has a rental charge of $1, therefore making the total
fines on the patron's account suddenly $5 (the limit).

1.1.5.1.10. maxoutstanding

Default: 5

Asks: Prevent patrons from making holds on the OPAC if they owe more than ____ USD in fines.

1.1.5.1.11. noissuescharge

Default: 5
Asks: Prevent patrons from checking out books if they have more than ___ USD in fines.
Description:

This preference is the maximum amount of money owed to the library before the user is banned from borrowing more items. This also coincides with
maxoutstanding that limits patrons from placing holds when the maximum amount is owed to the library.

1.1.5.1.12. OverduesBlockCirc

Default: Ask for confirmation
Asks: ___ when checking out to a borrower that has overdues outstanding
Values:

Ask for confirmation

Will not let you check an item out to patrons with overdues until a librarian confirms that it is okay

Block

Block all patrons with overdue items from being able to check out
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Don't block

Allow all patrons with overdue items to continue to check out

1.1.5.1.13. OverdueNoticeBcc

Asks: Send all notices as a BCC to this email address ____

This preference makes it so that a librarian can get a copy of every notice sent out to patrons.

1.1.5.1.14. PrintNoticesMaxLines

Asks: Include up to item lines in a printed overdue notice.

If the number of items is greater than this number, the notice will end with a warning asking the borrower to check their online account for a full list of
overdue items.

Set to 0 to include all overdue items in the notice, no matter how many there are.

This preference only refers to the print notices, not those sent via email.

1.1.5.1.15. RenewalPeriodBase

Default: the old due date of the checkout
Asks: When renewing checkouts, base the new due date on ____
Values:

the old due date of the checkout

the current date

1.1.5.1.16. ReturnBeforeExpiry

Default: Don't require
Asks: ____ patrons to return books before their accounts expire (by restricting due dates to before the patron's expiration date).
Values:

Don't require

Require

Description:

This is preference may prevent a patron from having items checked out after their library card has expired. If this is set to “Require”, then a due date of any
checked out item can not be set for a date which falls after the patron's card expiration. If the setting is left “Don't require” then item check out dates may
exceed the expiration date for the patron's library card.

1.1.5.1.17. ReturnToShelvingCart

Default: Don't move
Asks: ___ all items to the location CART when they are checked in.
Values:

Don't move

Move

1.1.5.1.18. TransfersMaxDaysWarning
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Default: 3
Asks: Show a warning on the "Transfers to Receive" screen if the transfer has not been received days after it is sent.
Description:

The TransferMaxDaysWarning preference is set at a default number of days. This preference allows for a warning to appear after a set amount of time if an
item being transferred between library branches has not been received. The warning will appear in the Transfers to Receive report.

1.1.5.1.19. UseBranchTransferLimits & BranchTransferLimitsType

Defaults: Don't enforce & collection code
Asks: ___ branch transfer limits based on ____
UseBranchTransferLimits Values:

Don't enforce

Enforce

BranchTransferLimitsType Values:
collection code

item type

BranchTransferLimitsType Description:

This parameter is a binary setting which determines whether items are transferred according to item type or collection code. This value determines how the
library manager is able to restrict what items can be transferred between the branches.

1.1.5.1.20. useDaysMode

Default: Don't include
Asks: Calculate the due date using ___.
Values:
circulation rules only.
the calendar to push the due date to the next open day.

the calendar to skip all days the library is closed.

Description:

This preference controls how scheduled library closures affect the due date of a material. The 'the calendar to skip all days the library is closed' setting allows
for a scheduled closure not to count as a day in the loan period, the 'circulation rules only' setting would not consider the scheduled closure at all, and 'the
calendar to push the due date to the next open day' would only effect the due date if the day the item is due would fall specifically on the day of closure.

Example:

The library has put December 24th and 25th in as closures on the calendar. A book checked out by a patron has a due date of December 25th according to
the circulation and fine rules. If this preference is set to ‘circulation rules only' then the item will remain due on the 25th. If the preference is set to 'the calendar
to push the due date to the next open day' then the due date will be December 26th. If the preference is set to 'the calendar to skip all days the library is
closed' then the due date will be pushed to the 26th of December to accommodate for the two closed days.

The calendar is defined on a branch by branch basis. To learn more about the calendar, check out the 'Calendar & Holidays' section of this manual.

1.1.5.2. Fines Policy
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1.1.5.2.1. finesCalendar

Default: not including the days the library is closed
Asks: Calculate fines based on days overdue __
Values:

directly

not including the days the library is closed

Description:

This preference will determine whether or not fines will be accrued during instances when the library is closed. Examples include holidays, library in-service
days, etc. Choosing 'not including the days the library is closed" setting will enable Koha to access its Calendar module and be considerate of dates when the
library is closed. To make use of this setting the administrator must first access Koha's calendar and mark certain days as “holidays" ahead of time.

The calendar is defined on a branch by branch basis. To learn more about the calendar, check out the 'Calendar & Holidays' section of this manual.

1.1.5.2.2. finesMode
Default: Calculate (but only for mailing to the admin)
Asks: ___ fines
Values:
Calculate (but only for mailing to the admin)
Calculate and charge
Don't calculate

Requires that you have the fines cron job running (misc/cronjobs/fines.pl)

1.1.5.3. Holds Policy

1.1.5.3.1. AllowHoldDatelnFuture

Default: Allow
Asks: ___ hold requests to be placed that do not enter the waiting list until a certain future date.
Values:

Allow

Don't allow

1.1.5.3.2. AllowHoldsOnDamagedltems

Default: Allow
Asks: ___ hold requests to be placed on damaged items.
Values:

Allow

Don't allow

Description:
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This parameter is a binary setting which controls whether or not hold requests can be placed on items that are marked as “damaged". Setting this value to
“Don't allow" will prevent anyone from placing a hold on such items, setting it to “Allow" will allow it. This preference is important because it determines
whether or not a patron can place a request for an item that might be in the process of being repaired or not in good condition. The library may wish to set this
to “Don't allow" if they were concerned about their patrons not receiving the item in a timely manner or at all (if it is determined that the item is beyond repair).
Setting it to “Allow" would allow a patron to place a hold on an item and therefore receive it as soon as it becomes available.

1.1.5.3.3. AllowHoldPolicyOverride

Default: Allow
Asks: ___ staff to override hold policies when placing holds.
Values:

Allow

Don't allow

Description:

This preference is a binary setting which controls whether or not the library staff can override the circulation and fines rules as they pertain to the placement of
holds. Setting this value to “Don't allow" will prevent anyone from overriding, setting it to “Allow" will allow it. This setting is important because it determines
how strict the libraries rules for placing holds are. If this is set to “Allow", exceptions can be made for patrons who are otherwise normally in good standing with
the library, but there is opportunity for the staff to abuse this function. If it is set to “Don't allow", no abuse of the system is possible, but it makes the system
entirely inflexible in respect to holds.

1.1.5.3.4. AllowOnShelfHolds

Default: Allow
Asks: ____ hold requests to be placed on items that are not checked out.
Values:

Allow

Don't Allow

Description:

This preference is a binary setting which controls the ability of patrons to place holds on items that are not currently checked out. Setting it to “Don't allow"
allows borrowers to place holds on items that are checked out but not on items that are on the shelf (or assumed available in the library), setting it to “Allow"
allows borrowers to place holds on any item that is available for loan whether it is checked out or not. This setting might be set to "Allow" if the library system
is a multi branch system and patrons used the hold system to request items from other libraries, or if the library wanted to allow users to place holds on items
from home through the OPAC. Setting it to “Don't allow" would enforce a first come, first served standard.

1.1.5.3.5. canreservefromotherbranches

Default: Allow
Asks: ____auser from one library to place a hold on an item from another library
Description:

This preference is a binary setting which determines whether patrons can place holds on items from other branches. If the preference is set to “Allow" patrons
can place such holds, if it is set to “Don't allow" they cannot. This is an important setting because it determines if users can use Koha to request items from
another branch. If the library is sharing an installation of Koha with other independent libraries which do not wish to allow interlibrary borrowing it is
recommended that this parameter be set to “Don't allow".

Values:

Allow
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Don't allow (with independent branches)

1.1.5.3.6. DisplayMultiPlaceHold

Default: Don't enable
Asks: ___the ability to place holds on multiple biblio from the search results
Values:

Don't enable

Enable

1.1.5.3.7. emailLibrarianWhenHoldIsPlaced

Default: Don't enable
Asks: ___ sending an email to the Koha administrator email address whenever a hold request is placed.
Values:

Don't enable

Enable

Description:

This preference enables Koha to email the library staff whenever a patron requests an item to be held. While this function will immediately alert the librarian to
the patron's need, it is extremely impractical in most library settings. In most libraries the hold lists are monitored and maintained from a separate interface.
That said, many libraries that allow on shelf holds prefer to have this preference turned on so that they are alerted to pull an item from the shelf.

This notice can be customized by editing the HOLDPLACED notice.

1.1.5.3.8. maxreserves

Default: 50

Asks: Patrons can only have ___ holds at once.

1.1.5.3.9. OPACAIlowHoldDatelnFuture

Default: Allow
Asks: ___ patrons to place holds that don't enter the waiting list until a certain future date.
Values:

Allow

AllowHoldDatelnFuture must also be enabled for this to work

Don't allow

1.1.5.3.10. ReservesControlBranch

Default: item's home library
Asks: Check the ___ to see if the patron can place a hold on the item.
Values:

item's home library.
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patron's home library.

1.1.5.3.11. ReservesMaxPickUpDelay

Default: 7
Asks: Mark a hold as problematic if it has been waiting for more than ____ days.
Description:

This preference puts an expiration date on an item a patron has on hold. After this expiration date the staff will have the option to release the unclaimed hold
which then may be returned to the library shelf or issued to the next patron on the item's hold list.

1.1.5.3.12. ReservesNeedReturns

Default: Don't automatically
Asks: ___ mark holds as found and waiting when a hold is placed specifically on them and they are already checked in.
Values:

Automatically

Don't automatically

Description:

This preference refers to ‘item specific' holds where the item is currently on the library shelf. This preference allows a library to decide whether an ‘item
specific' hold is marked as “Waiting" at the time the hold is placed or if the item will be marked as “Waiting" after the item is checked in. This preference will tell
the patron that their item is ‘Waiting' for them at their library and ready for check out.

1.1.5.3.13. StaticHoldsQueueWeight & RandomizeHoldsQueueWeight

Defaults: 0 & in that order
Asks: Satisfy holds from the libraries ___ (as branchcodes, separated by commas; if empty, uses all libraries) ___
Descriptions:

RandomizeHoldsQueueWeight randomizes the libraries to which hold requests are sent. All available libraries may be randomized or only those libraries listed
in the StaticHoldsQueueWeight preference. RandomizeHoldsQueueWeight can work with StaticHoldsQueueWeight to determine which libraries (branch or
consortium library) will be targets for items on holds list. This hold list is produced when patron's requests for items are generated on a libraries to which holds
are sent. RandomizeHoldsQueueWeight will or will not randomize the list of libraries that in the StaticHoldsQueueWeight list. If the
RandomizeHoldsQueueWeight is set as “in random order" the hold requests will be sent randomly to the libraries on the StaticHoldsQueueWeight list. If
RandomizeHoldsQueueWeight is set as "in that order", hold requests will be sent to the libraries according to their order as designated in
StaticHoldsQueueWeight or according to their static ranking in the database. The StaticHoldsQueueWeight works in conjunction with the
RandomHoldsQueueWeight preference. The StaticHoldsQueueWeight preference allows for certain libraries or branches to have a higher weight for holds
fulfilment, allowing these libraries to receive holds before other branch libraries. Previously set library codes are entered into the preference box, separated by
commas, and these libraries would receive holds before libraries not listed.

RandomizeHoldsQueueWeight Values:
in random order

in that order

1.1.5.4. Interface

1.1.5.4.1. AllowAllIMessageDeletion

Default: Don't allow
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Asks: ___ staff to delete messages added from other libraries.
Values:
Allow

Don't allow

1.1.5.4.2. CircAutocompl

Default: Try
Asks: to automatically fill in the member when entering a patron search on the circulation screen.
Description:

This preference is a binary setting which determines whether auto-completion of fields is enabled or disabled for the circulation input field. Setting it to “Try"
would enable a staff member to begin typing a name or other value into the field and have a menu pop up with suggestions for completing it. Setting it to
“Don't try" would disable this feature. This preference can make staff members' jobs easier or it could potentially slow down the page loading process.

Values:
Don't try

Try

1.1.5.4.3. FilterBeforeOverdueReport

Default: Don't require
Asks: ___ staff to choose which checkouts to show before running the overdues report.
Values:

Don't require

Require

1.1.5.4.4. DisplayClearScreenButton

Default: Show
Asks: ____abutton to clear the current patron from the screen on the circulation screen.
Values:

Don't show

Show

1.1.5.4.5. itemBarcodelnputFilter

Default: Don't filter
Asks: ____ scanned patron barcodes.
Values:
Convert from CueCat format
Don't filter

Remove spaces from
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Remove the first number from T-prefix style

This format is common among those libraries migrating from Follett systems

1.1.5.4.6. numReturnedltemsToShow

Default: 20

Asks : Show the last returned items on the checkin screen.

1.1.5.4.7. previouslssuesDefaultSortOrder

Default: earliest to latest
Asks: Sort previous checkouts on the circulation page from ____ due date.
Values:

earliest to latest

latest to earliest

1.1.5.4.8. soundon
Default: Don't enable
Asks: ___circulation sounds during checkin and checkout in the staff interface.
Values:
Don't enable
Enable

This feature is not supported by all browsers. Requires an HTML5 compliant browser.

1.1.5.4.9. SpecifyDueDate

Default: Allow

Asks: ___ staff to specify a due date for a checkout.

Due dates are calculated using your circulation and fines rules, but staff can override that if you allow them to specify a due date at checkout.
Description:

This preference allows for circulation staff to change a due date from the automatic due date to another calendar date. This option would be used for
circumstances in which the due date may need to be decreased or extended in a specific circumstance. The “Allow" setting would allow for this option to be
utilized by staff, the “Don't allow" setting would bar staff from changing the due date on materials.

Values:
Allow

Don't allow

1.1.5.4.10. todayslssuesDefaultSortOrder

Default: latest to earliest
Asks: Sort today's checkouts on the circulation page from ___ due date.

Values:
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earliest to latest

latest to earliest

1.1.5.5. Self Checkout

1.1.5.5.1. AutoSelfCheckAllowed, AutoSelfCheckID & AutoSelfCheckPass

Most libraries will want to leave this set to 'Don't allow.' This preference turns off the requirement to log into the self checkout machine with a staff
username and password by storing the username and password for automatic login.

AutoSelfCheckAllowed Default: Don't allow
Asks: ___ the web-based self checkout system to automatically login with this staff login ___ and this password ____ .
AutoSelfCheckAllowed Values:

Allow

Don't allow

AutoSelfCheckID needs to be set to the username of a staff member with ‘circulate’ permissions.

AutoSelfCheckPass needs to be set to the password of a staff member with ‘circulate’ permissions.

1.1.5.5.2. ShowPatronimagelnWebBasedSelfCheck

Default: Don't show
Asks ___the patron's picture (if one has been added) when they use the web-based self checkout.
Values:

Don't show

Show

1.1.5.5.3. WebBasedSelfCheck

Default: Don't enable
Asks: ___ the web-based self checkout system.
Values:

Don't enable

Enable

Enabling this preference will allow access to the self checkout module in Koha.

1.1.6. Creators
These preferences have to do with creating content.

Get there: More > Administration > Global System Preferences > Creators

1.1.6.1. Patron Cards

These preferences are in reference to the Patron Card Creator tool.

1.1.6.1.1. ImageLimit
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Asks: Limit the number of creator images stored in the database to ____images.

1.1.7. Enhanced Content

Get there: More > Administration > Global System Preferences > Enhanced Content

Always read the terms of service associated with external data sources to be sure that you are using the products within the allowed limits.
You cannot have more than one service for cover images set up. If you set up more than one you will get multiple cover images. Instead choose only one
source for cover images.

1.1.7.1. All

1.1.7.1.1. FRBRizeEditions

Default: Don't show
Asks: ____other editions of an item on the staff client
Values:

Don't show

Show

Description:

Using the rules set forth in the Functional Requirements for Bibliographic records, this option, when enabled, pulls all editions of the same title available in
your collection regardless of material type. Items will appear under an 'Editions' tab on the detail page for the title in question.. According to Libraries
Unlimited's Online Dictionary for Library and Information Science (http://lu.com/odlis/), FRBRizing the catalog involves collating MARC records of similar
materials. FRBRization brings together entities (sets of Works, Expressions, or Manifestations), rather than just sets of Items. It can aid patrons in selecting
related items, expressions, and manifestations that will serve their needs. When it is set to "Show", the OPAC will query one or more ISBN web services for
associated ISBNs and display an Editions tab on the details pages. Once this preference is enabled, the library must select one of the ISBN options
(ThinglSBN or XISBN). This option is only for the Staff Client; the OPACFRBRizeEditions option must be enabled to have the Editions tab appear on the
OPAC.

Requires that you turn on one or more of the ISBN services (ThingISBN, XISBN)

1.1.7.1.2. OPACFRBRIizeEditions

Default: Don't show
Asks: ___ other editions of an item on the OPAC.
Description:

Using the rules set forth in the Functional Requirements for Bibliographic records, this option, when enabled, pulls all editions of the same title available in
your collection regardless of material type. Items will appear under an 'Editions' tab on the detail page for the title in question.. According to Libraries
Unlimited's Online Dictionary for Library and Information Science (http://lu.com/odlis/), FRBRizing the catalog involves collating MARC records of similar
materials. FRBRization brings together entities (sets of Works, Expressions, or Manifestations), rather than just sets of Items. It can aid patrons in selecting
related items, expressions, and manifestations that will serve their needs. When it is set to "Show", the OPAC will query one or more ISBN web services for
associated ISBNs and display an Editions tab on the details pages. Once this preference is enabled, the library must select one of the ISBN options
(ThinglSBN or XISBN). This option is only for the OPAC; the 'FRBRizeEditions' option must be turned “On" to have the Editions tab appear on the Staff Client.

Values:
Don't show

Show

This preference pulls all editions of the same title available in your collection regardless of material type. Items will appear under an 'Editions' tab on the detail
page for the title in question.

Requires that you turn on one or more of the ISBN services (ThingISBN, XISBN)
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1.1.7.2. Amazon

1.1.7.2.1. AmazonEnabled

Default: Don't use

Asks: ___data from Amazon on the staff interface (including reviews and "Search Inside" links on item detail pages).
Values:

Don't use

Use

This requires that you have signed up for and entered an access key.

Sign up at: http://aws.amazon.com/

Enter your key in the AWSAccessKeyID system preference

Description:

This preference does not display any content but instead enables other Amazon-related preferences (AmazonCoverimages, AmazonSimilarltems,
AmazonReviews). Before turning this feature to "Use", the library must first set AWSAccessKeyID and AWSPrivateKey. Furthermore, if Amazon content is
enabled, other jacket services should be disabled to avoid interference. This preference applies only to the Staff Client. In order to display Amazon content on
the OPAC, please set the OPACAmazonEnabled preference.

1.1.7.2.2. OPACAmazonEnabled

Default: Don't use

Asks: ___ data from Amazon on the OPAC (including reviews and "Search Inside" links on item detail pages).
Values:

Don't use

Use

This requires that you have signed up for and entered an access key.

Sign up at: http://aws.amazon.com/

Set your enter your key in the AWSAccessKeyID system preference

Description:

This preference does not display any content but instead enables other Amazon-related preferences (AmazonCoverlmages, AmazonSimilarltems,
AmazonReviews). Before turning this feature to "Use", the library must first set AWSAccessKeyID and AWSPrivateKey. Furthermore, if Amazon content is
enabled, other jacket services should be disabled to avoid interference. This preference applies only to the OPAC. In order to display Amazon content on the
Staff Client, please set the AmazonEnabled preference.

1.1.7.2.3. AmazonLocale

Default: American
Asks: Use Amazon data from its ____ website.
Value:

American

British

Canadian
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French

German

Japanese

1.1.7.2.4. AWSAccessKeyID

Asks: Access Amazon content using the access key

Sign up at: http://aws.amazon.com/

Description:

If the library has signed up for an Amazon Web Services (AWS) account, it will be assigned an Access Key ID. In order to enable Amazon content, cover
images, reviews, and similar item suggestions, the library's Access Key ID must be entered here.

Once signed up your keys can be accessed by logging into your account and going to the 'Security Credentials' page. Your Access Key will be listed next to the
date it was created.

1.1.7.2.5. AWSPrivateKey

Asks: Access Amazon content (other than book jackets) using the private key _

Sign up at: http://aws.amazon.com/

Description:

If the library has signed up for an Amazon Web Services (AWS) account, it will be assigned a Secret Access Key. In order to enable Amazon reviews and
similar item suggestions, the library's Secret Access Key must be entered here.

Once signed up your keys can be accessed by logging into your account and going to the 'Security Credentials' page. Next to your Access key is a link that says
'Show,' clicking this will open up your secret access key or your AWSPrivateKey.

1.1.7.2.6. AmazonAssocTag

Asks: Put the associate tag ____ on links to Amazon.
This can net your library referral fees if a patron decides to buy an item after clicking through to Amazon from your site.
Description:

An Amazon Associates Tag allows a library to earn a percentage of all purchases made on Amazon when a patron accesses Amazon's site via links on the
library's website. More information about the Amazon Associates program is available at Amazon's Affiliate Program's website,
https://affiliate-program.amazon.com/. Before a tag can be obtained, however, the library must first apply for an Amazon Web Services (AWS) account.
Applications are free of charge and can be made at http://aws.amazon.com. Once an AWS account has been established, the library can then obtain the
Amazon Associates Tag.

Sign up at: https://affiliate-program.amazon.com/

1.1.7.2.7. AmazonCoverlmages

Default: Don't show
Asks: ___ cover images from Amazon on search results and item detail pages on the staff interface.
Values:

Don't show

Show

Description:
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This preference makes it possible to either allow or prevent Amazon cover images from being displayed in the Staff Client. Cover images are retrieved by
Amazon, which pulls the content based on the first ISBN number in the item's MARC record. Amazon offers this service free of charge, but interested libraries
must first establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value for this preference is set to "Show", the cover images will
appear in the Staff Client, and if it is set to "Don't show", the images will not appear. If activating this feature, the library must first set AWSAccessKeyID and
AWSPrivateKey. Finally, if you're using Amazon cover images, all other cover image services must be disabled. If they are not disabled, they will prevent
AmazonCoverlmages from functioning properly.

Requires that AmazonEnabled is set to 'Use'

1.1.7.2.8. AmazonReviews

Default: Don't show
Asks: ___ reviews from Amazon on item detail pages on the staff interface.
Values:

Don't show

Show

Description:

This preference makes it possible to either allow or prevent Amazon reviews from being displayed in the Staff Client. Amazon offers this service free of
charge, but interested libraries must first establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value is set to "Show", the
reviews will appear in the Staff Client, and if it is set to "Don't show", the reviews will not appear. Before setting this to "Show", the library must first set

AWSAccessKeyID and AWSPrivateKey. Finally, if AmazonReviews is enabled, all other review services should be disabled to avoid interference.

Requires that AmazonEnabled is set to 'Use’

1.1.7.2.9. AmazonSimilarltems

Default: Don't show
Asks: ____ similar items, as determined by Amazon, on item detail pages on the staff interface.
Values:

Don't show

Show

This will use Amazon data to determine if you have similar items in your collection - it will not show items that you do not already have cataloged at your
library.

Description:

This preference makes it possible to either allow or prevent Amazon's suggestions for Similar Items from being displayed in the Staff Client. Amazon offers
this service free of charge, but interested libraries must first establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value is set to
"Show", the Similar ltems suggestions will appear in the Staff Client, and if it is set to "Don't show", the suggestions will not appear. Before enabling this
preference, the library must first set AWSAccessKeylD and AWSPrivateKey. Finally, if AmazonSimilarltems is enabled, all other similar item services should

be disabled to avoid interference.

Requires that AmazonEnabled is set to 'Use'

1.1.7.2.10. OPACAmazonCoverlmages

Default: Don't show
Asks: ___ cover images from Amazon on search results and item detail pages on the OPAC.
Values:

Don't show

Show
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Description:

This preference makes it possible to either allow or prevent Amazon cover images from being displayed in the OPAC. Cover images are retrieved by Amazon,
which pulls the content based on the first ISBN number in the item's MARC record. Amazon offers this service free of charge, but interested libraries must first
establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value for this preference is set to "Show", the cover images will appear in

the OPAC, and if it is set to "Don't show", the images will not appear. If activating this feature, the library must first set AWSAccessKeyID and AWSPrivateKey.
Finally, if you're using Amazon cover images, all other cover image services must be disabled. If they are not disabled, they will prevent AmazonCoverimages

from functioning properly.

Requires that OPACAmazonEnabled is set to 'Use’

1.1.7.2.11. OPACAmazonSimilarltems

Default: Don't show
Asks: ____ similar items, as determined by Amazon, on item detail pages on the OPAC.
Values:
Don't show
Show
This will use Amazon data to determine if you have similar items in your collection - it will not show items that you do not already have cataloged at your
library.
Description:

This preference makes it possible to either allow or prevent Amazon's suggestions for Similar Items from being displayed in the OPAC. Amazon offers this
service free of charge, but interested libraries must first establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value is set to
"Show", the Similar Items suggestions will appear in the OPAC, and if it is set to "Don't show", the suggestions will not appear. Before enabling this
preference, the library must first set AWSAccessKeyID and AWSPrivateKey. Finally, if AmazonSimilarltems is enabled, all other similar item services should
be disabled to avoid interference.

Requires that OPACAmazonEnabled is set to 'Use’

1.1.7.2.12. OPACAmazonReviews

Default: Don't show
Asks: ___ reviews from Amazon on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

This preference makes it possible to either allow or prevent Amazon reviews from being displayed in the OPAC. Amazon offers this service free of charge, but
interested libraries must first establish an Amazon Web Services (AWS) account (http://aws.amazon.com). If the value is set to "Show", the reviews will
appear in the OPAC, and if it is set to "Don't show", the reviews will not appear. Before setting this to "Show", the library must first set AWSAccessKeyID and
AWSPrivateKey. Finally, if AmazonReviews is enabled, all other review services should be disabled to avoid interference.

Requires that OPACAmazonEnabled is set to 'Use’

1.1.7.3. Babelthéque

1.1.7.3.1. Babeltheque

Default: Don't

Asks: ___include information (such as reviews and citations) from Babelthéque in item detail pages on the OPAC.
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Description:

This preference makes it possible to display a Babeltheque tab in the OPAC, allowing patrons to access tags, reviews, and additional title information provided
by Babeltheque. The information which Babeltheque supplies is drawn from the French language-based Babelio.com, a French service similar to LibraryThing
for Libraries. More information about Babeltheque is available through its website, http://www.babeltheque.com. Libraries that wish to allow access to this
information must first register for the service at http://www.babeltheque.com. Please note that this information is only provided in French.

Values:

Do

Don't

1.1.7.4. Baker & Taylor

This is a pay service, you must contact Baker & Taylor to subscribe to this service before setting these options.

1.1.7.4.1. BakerTaylorEnabled

Default: Don't add

Asks: ___ Baker and Taylor links and cover images to the OPAC and staff client. This requires that you have entered in a username and password (which can be
seen in image links).

Values:
Add

Don't add

Description:

This preference makes it possible to display Baker & Taylor content (book reviews, descriptions, cover images, etc.) in both the Staff Client and the OPAC.
Libraries that wish to display Baker & Taylor content must first register and pay for this service with Baker & Taylor (http://www.btol.com). If Baker & Taylor
content is enabled be sure to turn off other cover and review services to prevent interference.

To use this you will need to also set the BakerTaylorUsername & BakerTaylorPassword system preferences

1.1.7.4.2. BakerTaylorBookstoreURL

Asks: Baker and Taylor "My Library Bookstore" links should be accessed at https:// ____isbn
Description:

Some libraries generate additional funding for the library by selling books and other materials that are purchased from or have been previously leased from
Baker & Taylor. These materials can be accessed via a link on the library's website. This service is often referred to as “My Library Bookstore." In order to
participate in this program, the library must first register and pay for the service with Baker & Taylor. Additional information about this and other services
provided by Baker & Taylor is available at the Baker & Taylor website, http://www.btol.com. The BakerTaylorBookstoreURL preference establishes the URL in
order to link to the library's Baker & Taylor-backed online bookstore, if such a bookstore has been established. The default for this field is left blank; if no value
is entered, the links to My Library Bookstore will remain inactive. If enabling this preference, enter the library's Hostname and Parent Number in the
appropriate location within the URL. The “key" value (key=) should be appended to the URL, and https:// should be prepended.

This should be filled in with something like koha.mylibrarybookstore.com/MLB/actions/searchHandler.do?nextPage=bookDetails&parentNum=10923&key=

Leave it blank to disable these links.
Be sure to get this information from Baker & Taylor when subscribing.

1.1.7.4.3. BakerTaylorUsername & BakerTaylorPassword

Asks: Access Baker and Taylor using username ____ and password ____

Descriptions:
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This setting in only applicable if the library has a paid subscription to the external Content Café service from Baker & Taylor. Use the box provided to enter in
the library's Content Café username and password. Also, ensure that the BakerTaylorBookstoreURL and BakerTaylorEnabled settings are properly set. The
Content Café service is a feed of enhanced content such as cover art, professional reviews, and summaries that is displayed along with Staff Client/OPAC
search results. For more information on this service please see the Baker & Taylor website: http://www.btol.com

Be sure to get this information from Baker & Taylor when subscribing.

1.1.7.5. Google

1.1.7.5.1. GoogleJackets

Default: Don't add
Asks: ____ cover images from Google Books to search results and item detail pages on the OPAC.
Values:

Add

Don't add

Description:

This setting controls the display of applicable cover art from the free Google Books database, via the Google Books API. Please note that to use this feature,
all other cover services should be turned off.

1.1.7.6. LibraryThing

LibraryThing for Libraries is a pay service. You must first contact LibraryThing directly for pricing and subscription information. Learn more at
http://www.librarything.com/forlibraries. Also, for further configuration instructions please see the LibraryThing Wiki:
http://www.librarything.com/wiki/index.php/Koha

1.1.7.6.1. ThingISBN
Default: Don't use
Asks: ___ the ThingISBN service to show other editions of a title
Values:
Don't use

Use

Description:

Set to 'Use' to display an “Editions" tab on the item's detail page. Editions are listed, complete with cover art (if you have one of the cover services enabled)
and bibliographic information. The feed comes from LibraryThing's ThingISBN web service. This is a free service to non-commercial sites with fewer than
1,000 requests per day.

Requires FRBRizeEditions and/or OPACFRBRizeEditions set to 'show'
This is separate from Library Thing for Libraries and does not have a cost associated with it.

1.1.7.6.2. LibraryThingForLibrariesEnabled

Default: Don't show
Asks: ___ reviews, similar items, and tags from Library Thing for Libraries on item detail pages on the OPAC.
Values:

Don't show

Show
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Description:

This setting is only applicable if the library has a paid subscription to the external LibraryThing for Libraries service. This service can provide patrons with the
display of expanded information on catalog items such as book recommendations. It also can offer advanced features like tagged browsing, patron written
reviews, and a virtual library display accessed from the details tab.

If this is set to 'show' you will need to enter a value in the 'LibraryThingForLibrariesID' system preference.

1.1.7.6.3. LibraryThingForLibrariesID

Asks: Access Library Thing for Libraries using the customer ID ____
Description:

This setting is only applicable if the library has a paid subscription to the external LibraryThing for Libraries service. Use the box provided to enter in the
library's LibraryThing for Libraries ID as provided to the library by LibraryThing. The ID number is a series of numbers in the form ###-##H######, and can be
found on the library's account page at LibraryThing for Libraries. This service can provide patrons with the display of expanded information on catalog items
such as book recommendations and cover art. It also can offer advanced features like tagged browsing, patron written reviews, and a virtual library display
accessed from the details tab.

1.1.7.6.4. LibraryThingForLibrariesTabbedView

Default: in line with bibliographic information
Asks: Show Library Thing for Libraries content
Values:

in line with bibliographic information

in tabs

Description:

This setting is only applicable if the library has a paid subscription to the external LibraryThing for Libraries service. This service can provide patrons with the
display of expanded information on catalog items such as book recommendations and cover art. It also can offer advanced features like tagged browsing,
patron written reviews, and a virtual library display accessed from the details tab.

11.7.7.0CLC

1.1.7.7.1. XISBN

Default: Don't use

Asks: ___the OCLC xISBN service to show other editions of a title
Description:

Set to 'Use' to display an “Editions" tab on the item's detail page. Editions are listed, complete with cover art and bibliographic information. The feed comes
from OCLC's xISBN web service. The feed limit for non-commercial sites is 1000 requests per day.

Values:
Don't use
Use

Requires ERBRizeEditions and/or OPACFRBRizeEditions set to ‘'show'

1.1.7.7.2. OCLCAffiliatelD

Asks: Use the OCLC affiliate ID ___ to access the xISBN service.
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Description:

This setting is only applicable if the library has an OCLC Affiliate ID. This allows WorldCat searching in the OPAC via the XISBN programming interface.
Simply enter the library's OCLC Affiliate ID in the box provided. Please note that using this data is only necessary if FRBRizeEditions and/or
OPACFRBRizeEditions and XISBN settings are enabled. For more information on this service please visit the OCLC website:
http://www.worldcat.org/affiliate/default.jsp.

Unless you have signed up for an ID with OCLC, you are limited to 1000 requests per day. Available at:
http://www.worldcat.org/affiliate/webservices/xisbn/app.isp

1.1.7.7.3. XISBNDailyLimit

Default: 999

Asks: Only use the xISBN service ____times a day.

Unless you have signed up for an ID with OCLC, you are limited to 1000 requests per day. Available at:
http://www.worldcat.org/affiliate/webservices/xisbn/app.ijsp

1.1.7.8. Syndetics

Syndetics is a pay service. You must first contact Syndetics directly for pricing and subscription information.

1.1.7.8.1. SyndeticsEnabled

Default: Don't use
Asks: ____content from Syndetics.
Values:

Don't use

Use

Description:
When this option is enabled any of the Syndetics options can be used.

Requires that you enter your SyndeticsClientCode before this content will appear.

1.1.7.8.2. SyndeticsClientCode

Asks: Use the client code to access Syndetics.
Description:

Once the library signs up for Syndetics' services, Syndetics will provide the library with an access code. (Visit the Syndetics homepage at
http://www.bowker.com/syndetics/ for more information.) This is the code that must be entered to access Syndetics' subscription services. Syndetics is a paid
subscription service. This value must be entered before SyndeticsEditions can be enabled. If the code is lost, corrupted, or forgotten, a new one can be
obtained from http://www.bowker.com/syndetics/.

You will need to get your client code directly from Syndetics.

1.1.7.8.3. SyndeticsCoverlmages & SyndeticsCoverlmageSize

SyndeticsCoverlmages Default: Don't show
SyndeticsCoverlmageSize Default: medium
Asks: ___ cover images from Syndetics on search results and item detail pages on the OPACina ___ size.
Descriptions:
When enabled, SyndeticsCoverlmages, allows libraries to display Syndetics' collection of full-color cover images for books, videos, DVDs and CDs on their

OPAC. For each book or item that comes up during a user search, the cover image for that title will be displayed. Since these cover images come in three
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sizes, the optimum size must be selected using the SyndeticsCoverlmageSize preference after SyndeticsCoverlmages are enabled. Syndetics cover images
come in two sizes: mid-size (187 x 187 pixels), and large (400 x 400 pixels). Syndetics is a paid subscription service. The SyndeticsClientCode must be
entered and the SyndeticsEnabled option must be activated before this service can be used. Other cover image preferences should also be disabled to avoid
interference.

SyndeticsCoverlmages Values:
Don't show

Show

SyndeticsCoverlmageSize Values:
medium

large

1.1.7.8.4. SyndeticsAuthorNotes

Default: Don't show
Asks: ___ notes about the author of a title from Syndetics on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

When this option is set to "Show", Syndetics provides notes and short author biographies for more that 300,000 authors, in both fiction and nonfiction. With
this option enabled the library can display Syndetics Author Notes on the OPAC. According to the Syndetics Solutions website
(http://www.bowker.com/syndetics/), Author Notes include lists of contributors for many multi-author texts and compilations. The SyndeticsClientCode must be
entered and the SyndeticsEnabled option must be activated before this service can be used.

1.1.7.8.5. SyndeticsAwards

Default: Don't show
Asks: ___information from Syndetics about the awards a title has won on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

When this option is set to "Show", Syndetics provides its clients with a list of awards that any title has won. With this service enabled the library can display
those awards for each book on its website. For each book or item that comes up during a user search, the list of awards for that title will be displayed. When a
user clicks on a given award, information about that award is presented along with a list of the other titles that have won that award. If the user clicks on any
title in the list, they will see holdings information about that title in their region. This option is a paid subscription service. The SyndeticsClientCode must be
entered and the SyndeticsEnabled option must be activated before this service can be used.

1.1.7.8.6. SyndeticsEditions

Default: Don't show

Asks: ____information about other editions of a title from Syndetics on item detail pages on the OPAC
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Description:
When enabled this option shows information on other editions of a title from Syndetics on the item detail pages of the OPAC. Syndetics is a paid subscription
service. The SyndeticsClientCode must be entered and the SyndeticsEnabled option must be activated before this service can be used.
Values:
Don't show
Show

Requires OPACFRBRizeEditions set to 'show’

1.1.7.8.7. SyndeticsExcerpt

Default: Don't show
Asks: ___excerpts from of a title from Syndetics on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

This preference allows Syndetics to display excerpts given to them from selected publishers. The excerpts are available from prominently reviewed new titles,
both fiction and non-fiction. The excerpts include poems, essays, recipes, forwards and prefaces. Automatic links provided by the ISBNs within local MARC
records are required to integrate Syndetics secured, high-speed Internet servers to the library OPACs. For more information see
(http://www.bowker.com/syndetics/).

1.1.7.8.8. SyndeticsReviews

Default: Don't show
Asks: ___ reviews of a title from Syndetics on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

Syndetics Reviews is an accumulation of book reviews available from a variety of journals and serials. The reviews page displays colored images of reviewed
books dust jackets, partnered with the names of the journal or serial providing the review. Clicking on an icon opens a window revealing the book title, author's
name, book cover icon and the critic's opinion of the book. Automatic links provided by the ISBNs within local MARC records are required to integrate
Syndetics secured, high-speed Internet servers to the library OPACs. For more information see (http://www.bowker.com/syndetics/).

1.1.7.8.9. SyndeticsSeries

Default: Don't show

Asks: information on other books in a title's series from Syndetics on item detail pages on the OPAC.
Values:
Don't show

Show

Description:
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Each fiction title within a series is linked to the complete series record. The record displays each title in reading order and also displays the publication order, if
different. Alternate series titles are also displayed. Automatic links provided by the ISBNs within local MARC records are required to integrate Syndetics
secured, high- speed Internet servers to the library OPACs. For more information see (http://www.bowker.com/syndetics/).

1.1.7.8.10. SyndeticsSummary

Default: Don't show
Asks: ____a summary of a title from Syndetics on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

Providing more than 5.6 million summaries and annotations derived from book jackets, edited publisher copy, or independently written annotations from Book
News, Inc. Covering fiction and non-fiction, this summaries option provides annotations on both trade and scholarly titles. For more information see
(http://www.bowker.com/syndetics/).

1.1.7.8.11. SyndeticsTOC

Default: Don't show
Asks: ___ the table of contents of a title from Syndetics on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

This preference allows staff and patrons to review the Table of Contents from a wide variety of publications from popular self-help books to conference
proceedings. Specific Information access is the main purpose for this option, allowing patrons guidance to their preferred section of the book. Special
arrangements with selected book services is used to obtain the table of contents for new publications each year. Automatic links provided by the ISBNs within
local MARC records are required to integrate Syndetics secured, high-speed Internet servers to the library OPACs. For more information see
(http://www.bowker.com/syndetics/).

1.1.7.9. Tagging

1.1.7.9.1. TagsEnabled

Default: Allow
Asks: ___ patrons and staff to put tags on items.
Values:

Allow

Don't allow

Description:

Set to 'Allow' enable tagging. A tag is metadata, a word added to identify an item. Tags allow patrons to classify materials on their own. TagsEnabled is the
main switch that permits the tagging features. TagsEnable must be set to 'Allow' to allow for other tagging features.

1.1.7.9.2. TagsModeration
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Default: Don't require
Asks: ___that tags submitted by patrons be reviewed by a staff member before being shown.
Values:

Don't require

Require

Description:

When set to 'Require," all tags to be first filtered by the tag moderator. Only approved tags will be visible to patrons. When set to '‘Don't require' tags will bypass
the tag moderator and patrons' tags to be immediately visible. When this preference is enabled the moderator, a staff member, would approve the tag in the
Staff Client. The moderator will have the option to approve or reject each pending tag suggestion.

When moderation is required all tags go through the tag moderation tool before becoming visible.

Get there: More > Tools > Tags

1.1.7.9.3. TagsShowOnList

Default: 6
Asks: Show ____ tags on search results on the OPAC.

Set the value to 0 (zero) to turn this feature off.

1.1.7.9.4. TagsInputOnList

Default: Allow
Asks: ____patrons to input tags on search results on the OPAC.
Values:

Allow

Don't allow

1.1.7.9.5. TagsShowOnDetail

Default: 10
Asks: Show ___ tags on item detail pages on the OPAC.

Set the value to 0 (zero) to turn this feature off.

1.1.7.9.6. TagsIinputOnDetail

Default: Allow

Asks: ___ patrons to input tags on item detail pages on the OPAC.
Values:

Allow

Don't allow

1.1.7.9.7. TagsExternalDictionary

Asks: Allow tags in the dictionary of the ispell executable on the server to be approved without moderation.
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Description:

The dictionary includes a “whitelist" and a “blacklist" of tags. The whitelist includes all the tags that have been pre-allowed. The blacklist includes tags that are
not allowed. This preference identifies the “whitelist” dictionary used. Ispell is an open source dictionary which can be used as the “whitelist". Since the
dictionary allows for accurately spelled obscenities, the libraries policy may dictate that modifications are made to the Ispell dictionary if this preference is use.
For more information about Ispell http://www.gnu.org/software/ispell/ispell.html. Enter the path on your server to a local ispell executable, used to set
$Lingua::Ispell::path.

1.1.8. 118N/L10ON
These preferences control your Internationalization and Localization settings.

Get there: More > Administration > Global System Preferences > 18N/L10N

1.1.8.1. dateformat
Default: mm/dd/yyyy
Asks: Format dates like ___
Values:
dd/mml/yyyy
mm/ddlyyyy

yyyy/mm/dd

Description:

This preference controls how the date is displayed. The options are the United States method, mm/dd/yyyy (04/24/2010), the metric method, dd/mm/yyyy
(24/04/2010) or ISO, which is the International Standard of Organization, yyyy/mm/dd (2010/04/24). The International Standard of Organization would primarily
be used by libraries with locations in multiple nations that may use different date formats, to have a single display type, or if the library would be in a region
that does not use the United States or metric method. More information regarding the 1ISO date format can be found at

http://www.iso.org/iso/iso catalogue.htm.

1.1.8.2. language

Default: English

Asks: Enable the following languages on the staff interface

Values:

English

To install additional languages you need to run misc/translation/install-code.pl. For example, to install French you would run the following command install-code.pl
fr-FR to make the templates, once they exist and are in the right place then they will show up as an option in this preference.

1.1.8.3. opaclanguages

Default: English

Asks: Enable the following languages on the OPAC

Values:

English

To install additional languages you need to run misc/translation/install-code.pl. For example, to install French you would run the following command install-code.pl
fr-FR to make the templates, once they exist and are in the right place then they will show up as an option in this preference.

page 43


http://www.gnu.org/software/ispell/ispell.html
http://www.iso.org/iso/iso_catalogue.htm

1.1.8.4. opaclanguagesdisplay

Default: Don't allow

Asks: ____ patrons to select their language on the OPAC.
Values:

Allow

Don't allow

1.1.9. Local Use
These preferences are defined locally.

Get there: More > Administration > Global System Preferences > Local Use

Sometimes preferences which are either new or outdated will appear in this tab, if you didn't add any preferences to this tab then it's best to ignore
preferences listed here.

1.1.10. Logs
Logs keep track of transaction on the system. You can decide which actions you want to log and which you don't using these preferences.

Get there: More > Administration > Global System Preferences > Logs

1.1.10.1. BorrowersLog

Default: Log
Asks: ___ changes to patron records.
Values:

Don't log

Log

1.1.10.2. CataloguingLog

Default: Don't log

Asks: ____any changes to bibliographic or item records.
Values:

Don't log

Log

Since this occurs whenever a book is cataloged, edited, or checked in or out it can be very resource intensive - slowing down your system.

1.1.10.3. FineslLog

Default: Log
Asks: ___ when overdue fines are charged or automatically forgiven.
Values:

Don't log

Log
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1.1.10.4. IssuelLog

Default: Log
Asks: ____ when items are checked out.
Values:

Don't log

Log

1.1.10.5. LetterLog

Default: Log
Asks: __ when an automatic claim notice is sent.
Values:

Don't log

Log

This log tracks all notices that go to patrons including the overdue notices.

1.1.10.6. ReturnLog

Default: Log
Asks: ____ when items are returned.
Values:

Don't log

Log

1.1.10.7. SubscriptionLog

Default: Log
Asks: ___ when serials are added, deleted or changed.
Values:
Don't log
Log
1.1.11. OPAC

Get there: More > Administration > Global System Preferences > OPAC

1.1.11.1. Appearance

These preferences control how things appear in the OPAC.

1.1.11.1.1. AuthorisedValuelmages

Default: Don't show

Asks: ____images for authorized values (such as lost statuses and locations) in search results and item detail pages on the OPAC.
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Values:
Don't show

Show

Get there: More > Administration > Authorized Values

1.1.11.1.2. BiblioDefaultView

Default: in simple form
Asks: By default, show bib records ____
Values:

as specified in the ISBD template.

See ISBD preference for more information

in simple form.

in their MARC format.

Description:

This preference determines the level of bibliographic detail that the patron will see on the OPAC detail page. The simple form displays the graphical interface;
MARC format displays the MARC21 cataloging view; ISBD displays the ISBD (International Standard Bibliographic Description, AACR2) view.

1.1.11.1.3. DisplayOPACiconsXSLT

Default: Don't show
Asks: On pages displayed with XSLT stylesheets on the OPAC, ____icons for itemtype and authorized values.
Values:

Don't show

Show

See the XSLT Icon Guide for more information on these icons.

1.1.11.1.4. hidelostitems

Default: Don't show

Asks: ___lost items on search and detail pages.

Description:
Items that are marked lost by the library can either be shown or not shown on the OPAC. By setting the value to “Don't show," the lost item is not shown on
the OPAC. By setting the value “Show," the lost item is shown on the OPAC for patrons to view with a status of 'lost.'

Values:
Don't show

Show

1.1.11.1.5. LibraryName

Asks: Show ___ as the name of the library on the OPAC.
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This value will appear in the title bar of the browser
Edit 'opacheader" if you'd like to add a library name above your search box on the OPAC

1.1.11.1.6. OpacAddMastheadLibraryPulldown

Default: Don't add

Asks: ___ alibrary select pulldown menu on the OPAC masthead.
Values:

Add

Don't Add

1.1.11.1.7. OPACBaseURL

Asks: The OPAC is located at http:// ___

This must be filled in correctly for RSS, unAPI, and search plugins to work.
This must be filled in to show 'OPAC View' links from bib records in the staff client:

1.1.11.1.8. opaccolorstylesheet

Default: colors.css
Asks: Include the additional CSS stylesheet /css/ ____ on all pages in the OPAC
Description:

The preference looks for stylesheets in the template directory for your OPAC language, for instance: /koha-tmpl/opac-tmpl/prog/en/css. If you upload a custom
file, opac-mystyles.css to this directory, you can specify it by entering opac-mystyles.css in your opaccolorstylesheet system preference. This adds your
custom stylesheet as a linked stylesheet alongside the OPAC's default CSS files. This method is preferable because linked stylesheets are cached by the
user's browser, meaning upon repeat visits to your site the user's browser will not have to re-download the stylesheet, instead using the copy in the browser's
cache.

Leave this field blank to disable it
This file will add a linked CSS, not replace the existing default CSS.

1.1.11.1.9. opaccredits

Asks: Include the following HTML in the footer of all pages in the OPAC:
Click the 'Click to edit; link to enter HTML to appear at the bottom of every page in the OPAC
Description:

This setting is for credits that will appear at the bottom of your OPAC pages. Credits traditionally encompass copyright information, last date updated,
hyperlinks or other information represented in an HTML format. This is static information and any updates must be entered manually.

Learn more in the OPAC Editable Regions section.

1.1.11.1.10. OPACDisplayRequestPriority

Default: Don't
Asks: ___ patrons the priority level of their holds in the OPAC.
Values:

Don't show

Show

opacuserlogin needs to be set to 'allow'
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1.1.11.1.11. opacheader

Asks: Include the following HTML in the header of all pages in the OPAC

This value will appear above the main content of your page
Edit 'LibraryName' if you'd like to edit the contents of the <title> tag

Learn more in the OPAC Editable Regions section.

1.1.11.1.12. OpacHighlightedWords

Default: Don't highlight
Asks: __ words the patron searched for in their search results.
Values:

Don't highlight

Highlight

1.1.11.1.13. opaclayoutstylesheet

Default: opac.css
Asks: Use the CSS stylesheet /css/ ____ on all pages in the OPAC, instead of the default
Description:

This setting's function is to point to the *.css file used to define the OPAC layout. A *.css file is a cascading stylesheet which is used in conjunction with HTML
to set how the HTML page is formatted and will look on the OPAC. There are two stylesheets that come with the system; opac.css and opac2.css. A custom
stylesheet may also be used. A style sheet designated in the opacstylesheet preference will override the stylesheet listed here. The stylesheets listed in the
opaclayoutstylesheet preference are held on the Koha server.

Leave this field blank to disable it and let Koha use the default file instead

1.1.11.1.14. OpacMaintenance

Default: Don't show
Asks: __awarning that the OPAC is under maintenance, instead of the OPAC itself.

this shows the same warning as when the database needs to be upgraded, but unconditionally.
Description:

This preference allows the system administrator to turn off the OPAC during maintenance and display a message to users. When this preference is switched
to “Show" the OPAC is not usable. The text of this message is not editable at this time.

Values:
Don't show
Show

When this preference is set to show the maintenance message the ability to search the OPAC is disabled and a message appears

1.1.11.1.15. OpacMainUserBlock

Default: Welcome to Koha... <hr>
Asks: Show the following HTML in its own column on the main page of the OPAC

HTML entered in this field will appear in the center of the main page of your OPAC
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Learn more in the OPAC Editable Regions section.

1.1.11.1.16. OpacNav

Default: Important links here.
Asks: Show the following HTML on the left hand column of all pages on the OPAC (generally navigation links)

Learn more in the OPAC Editable Regions section.

1.1.11.1.17. OPACNoResultsFound

No Default
Asks: Display this HTML when no results are found for a search in the OPAC

This HTML will display below the existing notice that no results were found for your search.

1.1.11.1.18. OpacPublic

Default: Enable
Asks: __ Koha OPAC as public. Private OPAC requires authentification before accessing the OPAC.
Values:

Don't enable

Enable

Description:

This preference determines if your OPAC is accessible and searchable by anyone or only by members of the library. If set to '‘Don't enable' only members who
are logged into the OPAC can search. Most libraries will leave this setting at its default of 'Enable’ to allow their OPAC to be searched by anyone and only
require login for access to personlized content.

1.1.11.1.19. OPACSearchForTitleln

Default: <li><a href="http://worldcat.org/search?q={TITLE}" target="_blank">Other Libraries (WorldCat)</a></li> <li><a
href="http://www.scholar.google.com/scholar?q={TITLE}" target="_blank">Other Databases (Google Scholar)</a></li> <li><a
href="http://www.bookfinder.com/search/?author={AUTHOR}&title={TITLE}&st=xI&ac=qr" target="_blank">Online Stores (Bookfinder.com)</a></li>

Asks: Include a "More Searches" box on the detail pages of items on the OPAC, with the following HTML (leave blank to disable)

The placeholders {CONTROLNUMBERY}, {TITLE}, {ISBN} and {AUTHOR} will be replaced with information from the displayed record.

1.1.11.1.20. OPACShowCheckoutName

Default: Don't show
Asks: ___ the name of the patron that has an item checked out on item detail pages on the OPAC.
Values:

Don't show

Show

Description:

This preference allows all patrons to see who has the item checked out if it is checked out. In small corporate libraries (where the OPAC is behind a firewall
and not publicly available) this can be helpful so coworkers can just contact the patron with the book themselves. In larger public and academic libraries
setting this to 'Show' would pose serious privacy issues.
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1.1.11.1.21. opacsmallimage

Asks: Use the image at ____ in the OPAC header, instead of the Koha logo. If this image is a different size than the Koha logo, you will need to customize the
Css.

Description:

The opacsmallimage system pref is a little tricky to deal with because you really have to tweak some CSS at the same time. The default CSS defines a region
just large enough to display the Koha logo, and if your logo doesn't match the Koha logo's dimensions (120 pixels wide by 38 pixels high), it won't display
correctly.

This should be a complete URL, starting with http://

1.1.11.1.22. opacstylesheet

Asks: Use the remote CSS stylesheet ____ on all pages in the OPAC, instead of the default.
Description:

This preference allows the administrator to completely replace the default stylesheet with their own alternate stylesheet. This allows the administrator to
completely customize the look of the OPAC. To change the stylesheet, enter a complete URL, including the http:// to the custom stylesheet. Content in the
custom/alternate stylesheet will overwrite any data in the default stylesheet defined in the opaclayoutstylesheet setting. The default stylesheet will likely be
found at http://your_koha_address/opac- tmpl/prog/en/css/opac.css

Leave this field blank to disable it and let Koha use the default file instead
This should be a complete URL, starting with http://

1.1.11.1.23. opacthemes

Default: prog
Asks: Use the __ theme on the OPAC.
Values:

prog

1.1.11.1.24. OPACURLOpenInNewWindow

Default: don't
Asks: When patrons click on a link to another website from your OPAC (like Amazon or OCLC), _ open the website in a new window.
Values:

do

don't

Description:

This preference determines if URLs in the OPAC will open in a new window or not. When clicking on a link in the OPAC, a patron does not need to worry
about navigating away from their search results.

1.1.11.1.25. OPACUserCSS

Asks: Include the following CSS on all pages in the OPAC
Description:

OPACUserCSS allows the administrator to enter styles that will overwrite the OPAC's default CSS as defined in ‘opaclayoutstylesheet'or ‘opacstylesheet'.
Styles may be entered for any of the selectors found in the default style sheet. The default stylesheet will likely be found at
http://lyour_koha_address/opac-tmpl/prog/en/css/opac.css. Unlike opaccolorstylesheet, opaclayoutstylesheet and opacstylesheet this preference will embed
the CSS directly on your OPAC pages.
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1.1.11.1.26. opacuserjs

Asks: Include the following JavaScript on all pages in the OPAC
Description:

This preference allows the administrator to enter JavaScript or JQuery that will be embedded across all pages of the OPAC. Administrators may use this
preference to customize some of the interactive sections of Koha, customizing the text for the login prompts, for example. Sample JQuery scripts used by
Koha libraries can be found on the wiki: http://wiki.koha-community.org/wiki/JQuery Library.

1.1.11.1.27. OPACXSLTDetailsDisplay

Default: normally
Asks: Show item details pages on the OPAC ____
Values:

normally

using XSLT stylesheets

XSLT stylesheets enable more detail to be displayed on the detail pages in the OPAC

1.1.11.1.28. OPACXSLTResultsDisplay

Default: normally
Asks: Show biblio records on OPAC result page
Values:

normally

using XSLT stylesheets

XSLT stylesheets enable more detail to be displayed on the search results pages in the OPAC

1.1.11.2. Features

1.1.11.2.1. OpacAuthorities

Default: Allow
Asks: ___ patrons to search your authority records.
Description:

This preference displays the link on the OPAC for the authority search (titled ‘Browse by Subject'). By setting the preference to “Allow" patrons can use this
search link of the OPAC.

While labeled '‘Browse' it is important to note that this is in fact an authority search, not an authority browse.
Values:
Allow

A link labeled '‘Browse by Subject’ will appear at the top of your OPAC under the search box

Don't allow

1.1.11.2.2. opacbookbag

page 51


http://wiki.koha-community.org/wiki/JQuery_Library

Default: Allow
Asks: ___ patrons to store items in a temporary "Cart" on the OPAC.
Values:

Allow

Don't allow

Description:

This preference allows the user to temporarily save a list of items found on the catalog. By using the Book Bag, or Cart, the user can print out or email a list of
items found. The user does not need to be logged in. This list is temporary and will be emptied, or cleared, at the end of the session.

1.1.11.2.3. OpacBrowser

This preference only applies to French systems at this time.

Default: Don't allow

Asks: ___ patrons to browse subject authorities on OPAC
Values:

Allow

Don't allow

run the Authorities Browser Cron Job to create the browser list

1.1.11.2.4. OPACFinesTab

Default: Allow
Asks: ___ patrons to access the Fines tab on the My Account page on the OPAC.
Values:

Allow

opacuserlogin needs to be set to 'allow'

Don't allow

1.1.11.2.5. OpacPasswordChange

Default: Allow
Asks: ___ patrons to change their own password on the OPAC.
Values:

Allow

opacuserlogin needs to be set to 'allow'

Don't allow

Enabling this will break LDAP authentication.

1.1.11.2.6. OPACPatronDetails

Default: Allow
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Asks: ____ patrons to notify the library of changes to their contact information from the OPAC.
Values:
Allow

opacuserlogin needs to be set to ‘allow'

Don't allow

1.1.11.2.7. OpacTopissue

Default: Don't allow
Asks: ___ patrons to access a list of the most checked out items on the OPAC.
Values:

Allow

A link to 'Most Popular' will appear at the top of your OPAC
Don't allow

Description:

This preference allows the administrator to choose to show the “Most Popular” link at the top of the OPAC under the search box. The “Most Popular" page
shows the top circulated items in the library, as determined by the number of times a title has been circulated. This allows users to see what titles are popular
in their community. It is recommended that you leave this preference set to ‘Don't allow' until you have been live on Koha for a couple of months, otherwise the
data that it shows will not be an accurate portrayal of what's popular in your library.

1.1.11.2.8. opacuserlogin

Default: Allow
Asks: ___ patrons to log in to their accounts on the OPAC.
Values:

Allow

Don't allow

The OPAC will still be searchable if patrons can't log in, this just disables the patron account access via the OPAC

1.1.11.2.9. RequestOnOpac

Default: Allow
Asks: ___ patrons to place holds on items from the OPAC.
Values:

Allow

opacuserlogin needs to be set to ‘allow'

Don't allow

1.1.11.2.10. reviewson
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Default: Allow
Asks: ___ patrons to make comments on items on the OPAC.
Values:
Allow
Patrons comments/reviews all require moderation before they appear in the OPAC

opacuserlogin needs to be set to ‘allow'

Don't allow

Description:

This button allows the patrons to submit comments on books they have read via the OPAC. If this preference is set to “'Allow" reviews are first sent to the staff
client for staff approval before the review is displayed in the OPAC. The staff member who reviews and approves comments may find the pending comments
on the Comments tool. The staff member can then choose to approve or delete the comments.

1.1.11.2.11. suggestion

Default: Allow
Asks: ____ patrons to make purchase suggestions on the OPAC.
Values:

Allow

opacuserlogin needs to be set to 'allow' unless AnonSuggestions is set to ‘allow'

Don't allow

1.1.11.3. Policy

1.1.11.3.1. OPACFineNoRenewals

Default: 99999
Asks: Only allow patrons to renew their own books on the OPAC if they have less than ___ USD in fines

Leave this field blank to disable
To allow renewals in the OPAC, opacuserlogin needs to be set to ‘allow'

1.1.11.3.2. OPACItemHolds

Default: Allow
Asks: ___ patrons to place holds on specific items in the OPAC.
Values:
Allow
Patrons can place holds on specific items as well as the next available item.

opacuserlogin needs to be set to 'allow'

Don't allow

If this is disabled, users can only put a hold on the next available item.
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1.1.11.3.3. OpacRenewalAllowed

Default: Don't allow
Asks: ____ patrons to renew their own books on the OPAC.
Values:

Allow

opacuserlogin needs to be set to 'allow'

Don't allow

Staff will still be able to renew items for patrons via the staff client

Descriptions:

This preference allows the administration to choose if patrons can renew their checked out materials via their checked out history in the OPAC. It allows
patrons to renew their materials without having to contact the library or having to return to the library.

1.1.11.3.4. OPACViewOthersSuggestions

Default: Don't show
Asks: ___ purchase suggestions from other patrons on the OPAC.
Values:

Don't show

Show

opacuserlogin needs to be set to ‘allow’

1.1.11.3.5. SearchMyLibraryFirst

Default: Don't limit

Asks: ____ patrons' searches to the library they are registered at.
Values:
Don't limit

Searching the OPAC will show results from all libraries

If you're a one branch system, choose 'Don't limit'

Limit

Patrons will still be able to search other libraries via the Advanced search page - but will be limited to searches for their library only from the basic search

box

opacuserlogin needs to be set to 'allow'

1.1.11.3.6. singleBranchMode

Default: Don't allow
Asks: ____ patrons to select their branch on the OPAC.

Values:
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Allow

opacuserlogin needs to be set to 'allow'

Don't allow

Description:

This preference is for libraries that have branches but do not want to share their items among other branches within their system. If the preference is set to
“Don't allow" then holdings will be shown for all branches within a system. On the “Home" screen of the OPAC users have the choice of narrowing down
results by item location. Setting this preference to “Allow" will display only one branch's holdings.

1.1.11.4. Privacy

1.1.11.4.1. AnonSuggestions

Default: Don't allow
Asks: ____ patrons that aren't logged in to make purchase suggestions.
If set to 'Allow', suggestions are connected to the AnonymousPatron
Values:
Allow

Don't allow

1.1.11.4.2. AnonymousPatron

Default: 0
Asks: Use borrowernumber ___ as the Anonymous Patron (for anonymous suggestions and reading history)

Before setting this preference create a patron to be used for all anonymous suggestions and/or reading history items. This patron can be any type and
should be named something to make it clear to you that they're anonymous (ex. Anonymous Patron).

1.1.11.4.3. EnableOpacSearchHistory

Default: Keep
Asks: ___ patron search history in the OPAC.
Values:

Don't keep

Keep

1.1.11.4.4. OPACPrivacy

Default: Don't allow
Asks: ____ patrons to choose their own privacy settings for their reading history.
This requires opacreadinghistory set to 'Allow' and AnonymousPatron to be set to your anonymous patron's borrowernumber.
Values:
Allow

Don't allow

page 56



1.1.11.4.5. opacreadinghistory

Default: Allow

Asks: ____ patrons to see what books they have checked out in the past.

Enabling this will make it so that patrons can view their circulation history in the OPAC unless you have OPACPrivacy set to 'Allow.'
This data is stored in the system regardless of your choice, unless your patrons have chosen to never have their reading history kept.

1.1.11.5. Shelf Browser

1.1.11.5.1. OPACShelfBrowser

Default: Show
Asks: ____a shelf browser on item details pages, allowing patrons to see what's near that item on the shelf.
Values:

Don't show

Show

Description:

This preference allows patrons to view what is located on the shelf near the item they looked up. The shelf browser option appears on the details page to the
right of each items' call number. Clicking the ‘Browse Shelf' link allows for a virtual shelf browsing experience via the OPAC and lets patrons see other books
that may relate to their search and items that sit on the shelf near the item they are looking at.

This uses up a fairly large amount of resources on your server, and should be avoided if your collection has a large number of items.

1.1.11.5.2. ShelfBrowserUsesCcode

Default: Don't use
Asks: ___the item collection code when finding items for the shelf browser.
Values:

Don't use

Use

Description:

If your library uses collection codes then you might want the shelf browser to take into consideration what collection the books belong to when populating the
virtual shelf browser.

1.1.11.5.3. ShelfBrowserUsesHomeBranch

Default: Use
Asks: ___the item home branch when finding items for the shelf browser.
Values:

Don't use

Use

Description:

If you have a multiple branch system you may want to make sure that Koha takes into consideration what branch owns the books when populating the virtual
shelf browser for accuracy.
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1.1.11.5.4. ShelfBrowserUsesLocation

Default: Use
Asks: ___the item location when finding items for the shelf browser.
Values:

Don't use

Use

Description:

If your library uses shelving locations then you might want the shelf browser to take into consideration what shelving location the books belong to when
populating the virtual shelf browser.

1.1.12. Patrons

Get there: More > Administration > Global System Preferences > Patrons

1.1.12.1. AddPatronLists

Default: specific categories
Asks: List ____under the new patron menu.
Values:

general patron types

specific categories

1.1.12.2. AutoEmailOpacUser & AutoEmailPrimaryAddress

AutoEmailOpacUser Default: Don't send

AutoEmailPrimaryAddress Default: alternate

Asks: ____an email to newly created patrons with their account details at their ___ email address.
Descriptions:

AutoEmailOpacUser allows library users to be notified by email of their account details when a new account is opened. The email will be sent to the address
specified in AutoEmailPrimaryAddress. If you choose 'first valid' as the value for AutoEmailPrimaryAddress the system will check the email fields in this order:
home, work, then alternate. The email contains the username and password given to or chosen by the patron when signing up for their account and can be
customized by editing the ACCTDETAILS notice.

AutoEmailOpacUser Values:
Don't send

Send

AutoEmailPrimaryAddress Values:
alternate
first valid
home

work
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1.1.12.3. autoMemberNum

Default: Do
Asks: ___ default the card number field on the patron addition screen to the next available card number
Values:

Do

If the largest currently used card number is 26345000012941, then this field will default to 26345000012942 for the next patron

Don't

Description:

This preference determines if the patron's barcode is automatically calculated. This prevents the person setting up the library card account from having to
assign a number to the new card. If set to ‘Do’ the system will calculate a new patron barcode by adding 1 to the maximum barcode already present in the
database.

1.1.12.4. BorrowerMandatoryField

Default: surname|cardnumber|barcode
Asks: The following database columns must be filled in on the patron entry screen

Description:

This preference enables the system administrator to choose which fields your library would like required for patron accounts. Enter field names separated by |
(bar). This ensures that basic information is included in each patron record. If a patron leaves one of the required fields blank an error message will issue and
the account will not be created.

Separate columns with |
For help with field names, ask your system administrator or view the database structure associated with the borrowers table.

1.1.12.5. borrowerRelationship

Default: fatherjmother
Asks: Guarantors can be the following of those they guarantee ____
Description:

This preference enables the system administrator to define valid relationships between a guarantor (usually a parent) & a guarantee (usually a child). Defining
values for this field does not make the guarantor field required when adding a guarantee type patron. This preference creates a drop down list identifying the
relationship of the guarantor to the guarantee.

Input multiple choices separated by |

1.1.12.6. BorrowersTitles

Default: Mr|Mrs|Miss|Ms
Asks: Borrowers can have the following titles ____
Description:
This preference allows the staff to choose the titles that can be assigned to patrons. The choices present as a drop down list when creating a patron record.

Input multiple choices separated by |

1.1.12.7. checkdigit

Default: Don't
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Asks: ___ check and construct borrower card numbers in the Katipo style.
Values:

Do

Don't

This overrides autoMemberNum if on.

1.1.12.8. EnhancedMessagingPreferences

Default: Allow
Asks: ___ patrons to choose which notices they receive and when they receive them.
Values:

Allow

Don't allow

This only applies to certain kinds of notices, overdue notices will be sent based on the library's rules, not the patron's choice.

1.1.12.9. ExtendedPatronAttributes

Default: Enable
Asks: ___ searching, editing and display of custom attributes on patrons.
Values:
Don't enable
Enable
Define attributes in Koha administration

Get there: More > Administration > Patron Attribute Types

Description:
Patron attributes are library-defined custom fields that can be applied to patron records.

Use custom attributes for fields that the default patron record does not support such as driver's license number or student ID number.

1.1.12.10. intranetreadinghistory

Default: Allow
Asks: ___ staff to access a patron's checkout history

If you have the OPACPrivacy preference set to 'Allow' and the patron has decided to not have their history kept staff will only see currently checked out
items.

Values:
Allow
Don't allow

This data is stored in the system regardless of your choice.

1.1.12.11. MaxFine

Default: 9999
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Asks: The late fine for a specific checkout will only goupto __ USD.

1.1.12.12. memberofinstitution

Default: Don't
Asks: ___ allow patrons to be linked to institutions
Values:

Do

Don't

In order to allow this, the library must have Institution patrons to link members to

1.1.12.13. minPasswordLength

Default: 3
Asks: Login passwords for staff and patrons must be at least ____ characters long.

This applies to both the staff login and the patron OPAC login.

1.1.12.14. NotifyBorrowerDeparture

Default: 30
Asks: Show a notice that a patron is about to expire ____ days beforehand.
Description:

When the patron attempts to check out materials, a warning will appear in the check out window of the Staff Client telling the librarian that the patrons account
is about to expire.

This notice will appear on the patron's record in the staff client.

1.1.12.15. patronimages

Default: Allow
Asks: ____images to be uploaded and shown for patrons on the staff client.
Values:

Allow

Don't allow

1.1.12.16. PatronsPerPage

Default: 20

Asks: By default, show ____ results per page in the staff client.

1.1.12.17. SMSSendDriver

Asks: Use the SMS::Send:: ___ driver to send SMS messages.
Some examples of values are:
SMS::Send::Us::Ipipi

SMS::Send::US::TMobile
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SMS::Send::US::Verizon

Additional values can be found here: http://search.cpan.org/search?query=sms%3A%3Asend&mode=all

You must allow EnhancedMessagingPreferences for this to work.

1.1.12.18. uppercasesurnames

Default: Don't
Asks: ____ store and display surnames (last names) in upper case.
Values:

Do

Don't

1.1.13. Searching

Get there: More > Administration > Global System Preferences > Searching

1.1.13.1. Features

1.1.13.1.1. NoZebra
Default: Use
Asks: ___the Zebra search engine. Searches are very slow on even modest sized collections when Zebra is off.
Values:
Don't use

Use

1.1.13.1.2. NoZebralndexes

Default: See the Systems Preferences Appendix

1.1.13.1.3. OpacGroupResults

Default: Don't use

Asks: ___ PazPar2 to group similar results on the OPAC.
Values:

Don't use

Use

This requires that PazPar2 is set up and running.

1.1.13.1.4. QueryAutoTruncate

Default: automatically
Asks: Perform wildcard searching (where, for example, Har would match Harry and harp) __ (The * character would be used like so: Har* or *logging.)
Values:

automatically
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only if * is added

Description:

This setting allows for searches to be automatically truncated or for additional characters to be added to the end of a search string. When set to
"automatically" the search string automatically ends with a wildcard function. For example, a search for the word “invent" with auto truncation enabled will also
retrieve results for inventor, invention, inventory, etc. If you don't want this to happen automatically you can still be perform wildecard searches manually by
adding an asterisk (*). Typing “invent*" even with auto truncation disabled will retrieve the same inventor, invention, inventory results. Auto truncation
bypasses the necessity to type long search strings in their entirety.

1.1.13.1.5. QueryFuzzy

Default: Try
Asks: ____to match similarly spelled words in a search (for example, a search for flang would also match flange and fang)
Values:

Don't try

Try

Description:

This preference enables “fuzzy" searching, in which the search engine returns results that are similar to, but not exactly matching, the word or words entered
by the user. This preference enables the search function to compensate for slightly misspelled names or phrases.

Requires that NoZebra is set to 'Use'

1.1.13.1.6. QueryRemoveStopwords

Default: Don't remove
Asks: ___ stop words specified in Koha from searches.
Values:
Don't remove
If NoZebra is set to 'Use' leave this preference set to 'Don't remove'
Remove
Requires that you have updated your Koha Stop Words list

Requires that NoZebra is set to 'Don't use'
Zebra, on its own, handles a few of the most common stop words

1.1.13.1.7. QueryStemming

Default: Try
Asks: ___ to match words of the same base in a search
Values:

Don't try

Try

A search for enabling would also match enable and enabled

Description:
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This preference enables word stemming. Stemming allows the search function to return multiple versions of the same word, as well as related terms (i.e., both
fish and fishing would be returned).

Requires that NoZebra is set to 'Use’

1.1.13.1.8. QueryWeightFields

Default: Enable
Asks: ___ranking of search results by relevance
Values:

Disable

Enable

Requires that NoZebra is set to 'Use'

1.1.13.2. Results Display

1.1.13.2.1. defaultSortField & defaultSortOrder

defaultSortField Default: author
defaultSortOrder Default: ascending
Asks: By default, sort search results in the staff clientby

Description:

These preferences set the default sort field and sort order for searches on the staff side. Regardless of your choice, the other sort options are still available in
the drop down list on the advanced search page.

defaultSortField Values:
author
call number
date added
date of publication
relevance
title

total number of checkouts

defaultSortOrder Values:
ascending
descending
fromAto Z

fromZto A

1.1.13.2.2. maxltemsinSearchResults

Default: 20

Asks: Show up to ____items per biblio in the search results
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Description:

This preference will let you set how many results display by default when a search is run on the Staff Client.

1.1.13.2.3. numSearchResults

Default: 20

Asks: By default, show ____ results per page in the staff client.

1.1.13.2.4. OPACdefaultSortField & OPACdefaultSortOrder

OPACdefaultSortField Default: relevance
OPACdefaultSortOrder Default: ascending

Asks: By default, sort search results inthe OPACby __ ,
Description:

These preferences set the default sort field and sort order for searches on the OPAC. Regardless of your choice, the other sort options are still available in the
drop down list on the advanced search page.

OPACdefaultSortField Values:
author
call number
date added
date of publication
relevance
title

total number of checkouts

OPACdefaultSortOrder Values:
ascending
descending
fromAto Z

fromZto A

1.1.13.2.5. OPACItemsResultsDisplay

Default: Don't show
Asks: ____anitem's branch, location and call number in OPAC search results.
Values:

Don't show

Show

Description:

This setting selects the information about an item that will display in the search results page of the OPAC. The results can display the status of an item and/or
full details including branch, location, and call number. While the 'Show' option allows for more information to be displayed on the search results page, the
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information can be overwhelming for large collections with multiple branches.

1.1.13.2.6. OPACnumSearchResults

Default: 20

Asks: By default, show ____ results per page in the OPAC.

1.1.13.3. Search Form

1.1.13.3.1. AdvancedSearchTypes

Default: itemtype
Asks: Show checkboxes to search by __ on the OPAC and staff advanced search pages.
Values:

collection code

itemtype

1.1.13.3.2. expandedSearchOption

Default: don't show
Asks: By default, ___ "More options" on the OPAC and staff advanced search pages.
Values:

don't show

show

1.1.14. Serials

Get there: More > Administration > Global System Preferences > Serials

1.1.14.1. OPACSeriallssueDisplayCount

Default: 3
Asks: Show the ___ previous issues of a serial on the OPAC.
Description:

This preference allows the administrator to select the number of recent issues for each serial which appear in the OPAC when the serial is accessed. This is
just the default value, patrons can always click to see a full list of serials.

1.1.14.2. RenewSerialAddsSuggestion

Default: Don't add
Asks: ___ asuggestion for a biblio when its attached serial is renewed.
Values:

Add

Don't add

Description:
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If set to "Add", this preference will automatically add a serial to the Acquisitions Purchase Suggestions menu when clicking the 'renew" option. If you don't use
the Acquisitions module to manage serials purchases it's best to leave this set as 'Don't add.'

1.1.14.3. RoutingSerials

Default: Don't add
Asks: ___ received serials to the routing list.
Description:

This preference determines if serials routing lists are enabled or disabled for the library. When set to “Add", serials routing is enabled and a serial can be
directed through a list of people by identifying who should receive it next. The list of people can be established for each serial to be passed using the Serials
module. This preference can be used to ensure each person who needs to see a serial when it arrives at the library will get it. Learn more in the routing list
section of this manual.

Values:

Add

Don't add

1.1.14.4. RoutingListAddReserves

Default: Place
Asks: ___ received serials on hold if they are on a routing list.
Values:

Place

Don't place

1.1.14.5. StaffSeriallssueDisplayCount

Default: 3
Asks: Show the ____ previous issues of a serial on the staff client.
Description:

This preference allows the administrator to select the number of recent issues for each serial which appear in the Staff Client when the serial is accessed. This
is just the default value, staff members can always click to see a full list of serials.

1.1.14.6. SubscriptionHistory

Default: a full list
Asks: When showing the subscription information for a biblio, show ____ of the serial issues.
Values:

a full list

a summary

Description:
This preference determines what information appears in the OPAC when the user clicks the More Details option. The ‘summary' option displays a one-line

summary of the volume and issue numbers of all issues of that serial held by the library. The ‘full list' option displays a more detailed breakdown of issues per
year, including information such as the issue date and the status of each issue.
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1.1.15. Staff Client

Get there: More > Administration > Global System Preferences > Staff Client

1.1.15.1. Appearance

1.1.15.1.1. intranet_includes

Default: includes

Asks: Use include files from the ____ directory in the template directory, instead of includes/. (Leave blank to disable)

1.1.15.1.2. intranetcolorstylesheet

Asks: Include the stylesheet /intranet-tmpl/prog/en/css/ ____ on all pages in the staff interface.
Description:

This preference is used to set the background color and style of the Staff Client. The value is a .css file. The system administrator should determine which file
is appropriate.

Leave this field blank to disable.

1.1.15.1.3. IntranetmainUserblock

Asks: Show the following HTML in its own column on the main page of the staff client

1.1.15.1.4. IntranetNav

Asks: Show the following HTML in the More menu at the top of each page on the staff client (should be a list of links or blank)

1.1.15.1.5. intranetstylesheet

Asks: Include the stylesheet at ___ on all pages in the staff interface, instead of the default.
Description:

The Intranetstylesheet preference is a layout and design feature for the intranet or staff client. To change the stylesheet from the original, place in this
preference the file path to the style sheet - include the entire url starting with http://. This preference allows a library to customize the appearance of the Staff
Client.

This should be a complete URL, starting with http://

1.1.15.1.6. IntranetUserCSS

Asks: Include the following CSS on all pages in the staff client

1.1.15.1.7. intranetuserjs

Asks: Include the following JavaScript on all pages in the staff interface
Description:

This preference allows the administrator to enter JavaScript or JQuery that will be embedded across all pages of the Staff Client. Administrators may use this
preference to customize some of the interactive sections of Koha, customizing the text for the login prompts, for example. Sample JQuery scripts used by
Koha libraries can be found on the wiki: http://wiki.koha-community.org/wiki/JQuery Library.

1.1.15.1.8. staffClientBaseURL

Asks: The staff client is located at http://
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1.1.15.1.9. template
Default: prog
Asks: Use the ___ theme on the staff interface.

Values:

prog

1.1.15.1.10. XSLTDetailsDisplay

Default: normally
Asks: Show item details pages in the staff client
Values:

normally

using XSLT stylesheets

XSLT stylesheets enable more detail to be displayed on the bibliographic records in the Staff Client

1.1.15.1.11. XSLTResultsDisplay

Default: using XSLT stylesheets
Asks: Show biblio records on result page in the staff client
Values:
normally
using XSLT stylesheets
XSLT stylesheets enable more detail to be displayed on the search results in the Staff Client

This preference isn't currently functional.

1.1.15.1.12. yuipath

Default: included with Koha
Asks: Use the Yahoo Ul libraries ____
Values:

from Yahoo's servers

With this option there is less demand on your servers, but if the Internet goes down there will be issues

included with Koha

With this option calls are made faster, and they will still work if the Internet goes down

Description:

The yuipath preference allows for the user to define a local path or web URL to the Yahoo User Interface Library (http:/developer.yahoo.com/yui/2/). This
library is a resource of developer tools including JavaScript and style sheets.

1.1.15.2. Options

1.1.15.2.1. HidePatronName
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Default: Show
Asks: ___ the names of patrons that have items checked out or on hold on detail pages or the "Place Hold" screen.
Values:

Don't show

Show

1.1.15.2.2. intranetbookbag

Default: Show
Asks: ___the cart option in the staff client.
Values:

Don't show

Show

1.1.15.2.3. viewISBD

Default: Allow

Asks: ____ staff to view records in ISBD form on the staff client.
Values:

Allow

Don't allow

1.1.15.2.4. viewLabeledMARC

Default: Allow

Asks: ___ staff to view records in labeled MARC form on the staff client.
Values:

Allow

Don't allow

1.1.15.2.5. viewMARC

Default: Allow

Asks: ___ staff to view records in plain MARC form on the staff client.
Values:

Allow

Don't allow

1.1.16. Web Services

Get there: More > Administration > Global System Preferences > Web Services
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1.1.16.1. ILS-DI

1.1.16.1.1. ILS-DI
Default: Disable
Asks: ____ILS-DI services for OPAC users
Values:
Disable

Enable

1.1.16.1.2. ILS-DI:Authorized IPs

Asks: ___ allowed IPs to use the ILS-DI services

1.1.16.2. OAI-PMH

1.1.16.2.1. OAI-PMH
Default: Disable
Asks: __ Koha's OAI-PMH server.
Values:
Disable

Enable

Description:

For the Open Archives Initiative-Protocol for Metadata Harvesting (OAI-PMH) there are two groups of ‘participants’: Data Providers and Service Providers.
Data Providers (open archives, repositories) provide free access to metadata, and may, but do not necessarily, offer free access to full texts or other
resources. OAI-PMH provides an easy to implement, low barrier solution for Data Providers. Service Providers use the OAl interfaces of the Data Providers to
harvest and store metadata. Note that this means that there are no live search requests to the Data Providers; rather, services are based on the harvested
data via OAI-PMH. Koha at present can only act as a Data Provider. It can not harvest from other repositories. The biggest stumbling block to having Koha
harvest from other repositories is that MARC is the only metadata format that Koha indexes natively. Visit http://www.oaforum.org/tutorial/english/page3.htm
for diagrams of how OAI-PMH works.

Learn more about OAI-PMH at: http://www.openarchives.org/pmh/

1.1.16.2.2. OAI-PMH:archivelD

Default: KOHA-OAI-TEST

Asks: Identify records at this site with the prefix ___ :

1.1.16.2.3. OAI-PMH:ConfFile

If this preference is left empty, Koha's OAIl Server operates in normal mode, otherwise it operates in extended mode. In extended mode, it's possible to parameter
other formats than marcxml or Dublin Core. OAI-PMH:ConfFile specify a YAML configuration file which list available metadata formats and XSL file used to create
them from marcxml records.

For more information, see the sample conf file in the appendix.

1.1.16.2.4. OAI-PMH:MaxCount

Default: 50
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Asks: Only return ____ records at a time in response to a ListRecords or Listldentifiers query.
Description:

This is the maximum number of records that would be returned based on ListRecord or Listldentifier queries from harvesters. ListRecords harvest the entire
records while the Listldentifier is an abbreviated form of ListRecords, retrieving only headers rather than records.

1.2. Basic Parameters

Get there: More > Administration

Configure all '‘parameters' in the order they appear.

1.2.1. Libraries & Groups

When setting up your Koha system you will want to add information for every library that will be sharing your system. This data is used in several areas of Koha.

Get there: More > Administration > Basic Parameters > Libraries, branches and groups

When visiting this page you are presented with a list of the libraries and groups that have already been added to the system.

1.2.1.1. Adding a Library

To add a new library:
Click 'New Library'
Fill in the data requested on the form that follows
Of the fields listed, only 'Library code' and 'Name' are required

Be sure to enter a library email address to make sure that notices are sent to and from the right address
An IP address is required if you have enabled AutoLocation

1.2.1.2. Editing/Deleting a Library

You will be unable to delete any library that has patrons or items attached to it.
Each library will have an 'Edit' link to the right of it. Click this link to edit/alter details associated with the library in question.

You will be unable to edit the 'Library code'

1.2.1.3. Adding a group

To add a Search Domain or Library Property Group click the ‘New Group' button at the top of the screen

Of the fields on the group form, 'Category code' and 'Name' are the only required fields

1.2.1.3.1. Search Domain Groups

Search Domain Groups allow you to search a group of libraries at the same time instead of searching just one library or all libraries.

To see Search Domain Groups in action visit the staff client advanced search page in your Koha system:

1.2.1.3.2. Library Property Groups

You can assign specific categories to your libraries by adding groups for them

Properties are then applied to libraries via the add or edit library form

1.2.2. Item Types
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Koha allows you to organize your collection by item types and collection codes.

Get there: More > Administration > Basic Parameters > Item Types

Item types typically refer to the material type (book, cd, dvd, etc), but can be used in any way that works for your library.

1.2.2.1. Adding Item Types

To add a new item type, simply click the 'New Item Type' button at the top of the Item Types page.
In the 'ltem Type' field, enter a short code for your item type
The description is the plain text definition of the item type
You can choose to have an image associated with your item type
You can choose from a series of image collections
You can link to a remote image
Or you can just have no image associated with the item type
To have your item type images appear in the OPAC you need to set noltemTypelmages to 'Show'

Get there: More > Administration > Global System Preferences > Admin

For items that do not circulate, check the 'Not for loan' options

Items marked 'Not for loan' will appear in the catalog, but cannot be checked out to patrons

Enter the total number of renewals allowed for the item type in the 'Renewals' box
For items that you charge a rental fee for, enter the total fee you charge in the 'Rental charge' field
Do not enter symbols in this field, only numbers and decimal points (ex. $5.00 should be entered as 5 or 5.00)

This will charge the patron on checkout

When finished, click 'Save Changes'
All fields, with the exception of the 'ltem Type' will be editable from the Item Types list

Your new item type will now appear on the list

1.2.2.2. Editing Iltem Types

Each item type has an Edit button beside it. To edit an item simply click the 'Edit' link.

You will not be able to edit the code you assigned as the 'ltem Type' but you will be able to edit the description for the item.

1.2.2.3. Deleting Iltem Types

Each item has a Delete button beside it. To delete an item, simply click the 'Delete’ link.

You will not be able to delete item types that are being used by items within your system.

1.2.3. Authorized Values

Authorized values can be used in several areas of Koha. One reason you would add an authorized value category would be to control the values that can be
entered into MARC fields by catalogers.

Get there: More > Administration > Basic Parameters > Authorized Values
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1.2.3.1. Existing Values

Koha installs with pre-defined values that your library is likely to use, for instance ‘Lost'".
Asortl

Used for acquisitions statistical purposes

Asort2

Used for acquisitions statistical purposes

BOR_NOTES

Values for custom patron notes that appear on the circulation screen and the OPAC

Bsortl

Used for patron statistical purposes

Bsort2

Used for patron statistical purposes

CART

Is the shelving cart location, used by InProcessingToShelvingCart and ReturnToShelvingCart

CCODE

Collection codes (appears when cataloging and working with items)

DAMAGED

Descriptions for items marked as damaged (appears when cataloging and working with items)

HINGS_AS

General Holdings: Acquisition Status Designator :: This data element specifies acquisition status for the unit at the time of the holdings report.a

HINGS_C

General Holdings: Completeness Designator

HINGS_PF

Physical Form Designators

HINGS_RD

General Holdings: Retention Designator :: This data element specifies the retention policy for the unit at the time of the holdings report.

HINGS_UT

General Holdings: Type of Unit Designator

LOC

Shelving location (usually appears when adding or editing an item)

LOST
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Descriptions for the items marked as lost (appears when adding or editing an item)

Values given to lost statuses should be numeric and not alphabetical in order for statuses to appear properly
MANUAL_INV

Values for manual invoicing types

NOT_LOAN

Reasons why a title is not for loan

PROC

The location to be used for NewltemsDefaultLocation (change description as desired), also the location expected by InProcessingToShelvingCart.

RESTRICTED

Restricted status of an item

SUGGEST

List of patron suggestion reject or accept reasons (appears when managing suggestions)

WITHDRAWN

Description of a withdrawn item (appears when adding or editing an item)

1.2.3.2. Add new Authorized Value Category

In addition to the existing categories that come by default with Koha, librarians can add their own authorized value categories to control data that is entered into
the system. To add a new category:

Click 'New Category'
Limit your Category to 11 characters (something short to make it clear what the category is for)
When adding a new category you're asked to create at least one authorized value

Enter a code for your Authorized Value into the 'Authorized value' field

Use the Description field for the actual value that will be entered

Click 'Save'

Your new category and value will appear on the list of Authorized Values

1.2.3.3. Add new Authorized Value

New authorized values can be added to any existing or new category. To add a value:
Click 'New authorized value for ..."
Enter a code for your Authorized Value into the 'Authorized value' field
Use the Description field for the actual value that will be entered
Click 'Save'

The new value will appear in the list along with existing values
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1.3. Patrons & Circulation

Settings for controlling circulation and patron information.

1.3.1. Patron Cateqgories

Patron categories allow you to organize your patrons into different roles, age groups, and patron types.

Get there: More > Administration > Patrons & Circulation > Patron Categories

Patrons are assigned to one of six main categories:
Adult

Most common patron type, usually used for a general 'Patron’ category.

Child

Children patrons can have a guardian to be attached to them.

Staff

Patrons within the staff category will have access to the staff client.

Organizational

Organizational patrons are organizations. Organizations can be used as guarantors for Professional patrons.

Professional

Professional patrons can be linked to Organizational patrons

Statistical

This patron type is used strictly for statistical purposes, such as in house use of items.

1.3.1.1. Adding a patron category

To add a new patron category click ‘New Category' at the top of the page
The 'Category Code' is an identifier for your new code.
The category code is limited to 10 characters (numbers and letters)
Enter a plain text version of the category in the 'Description’ field.

Enrollment period (in months) should be filled in if you have a limited enrollment period for your patrons (eg. Student cards expire after 9 months or until a
specific date)

You cannot enter both a month limit and a date until. Choose to enter either one or the other.
Some patron categories can have a minimum age (in years) requirement associated with them, enter this age in the 'Age required'
Patron categories can also have a maximum age (in years) associated with them (such as children), enter this age in the 'Upperage limit'
If you charge a membership fee for your patrons (such as those who live in another region) you can enter that in the 'Enrollment fee' field.
Only enter numbers and decimals in this field
If you want your patron to receive overdue notices, set the 'Overdue notice required' to 'Yes'
If you charge patrons for placing holds on items, enter the fee amount in the 'Hold fee' field.

Only enter numbers and decimals in this field
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In the 'Category type' field choose one of the six main parent categories
Finally you can assign advanced messaging preferences by default to a patron category

Requires that you have EnhancedMessagingPreferences enabled

These can be changed for individual patrons, this setting is just a default to make it easier to set up messages for an entire category

1.3.2. Cities and Towns

To standardize patron input you can define cities or towns within your region so that when new patrons are added librarians simply have to select the town from a
list instead of having to type the town and zip (or postal) code information.

Get there: More > Administration > Patrons & Circulation > Cities and Towns

1.3.2.1. Adding a City

To add a new city, click the 'New City' button at the top of the page and enter the city name, state and zip/postal code.
One you click Submit, your city will be saved and will be listed on the Cities and Towns page

Cities can be edited or deleted at any time.

1.3.2.2. Viewing Cities on Patron Add Form

If you have defined local cities using the New city form, then when adding or editing a patron record you will see those cities in a pull down menu to make city
selection easy.

This will allow for easy entry of local cities into the patron record without risking the potential for typos or mistaken zip/postal codes.

1.3.3. Road Types

To standardize patron input you can define road types within your region so that when new patrons are added librarians simply have to select the road from a list
instead of having to type it in.

If you want your patrons to have their road types abbreviated all of the time then you can enter the appropriate abbreviations here, if you'd like the road
types to always be spelled out you can do that here as well.

1.3.3.1. Adding Road Types

To add a road type, click 'New Road Type' and then enter the road type the way you'd like it displayed.

Once you submit the form, your new road type will be listed on the Road Types page

1.3.3.2. Viewing Road Types on Patron Add form

When adding or editing a patron, if you have road types defined, there will be a pull down to choose the road type from.

1.3.4. Patron Attribute Types

Patron attributes can be used to define custom fields to associate with your patron records. In order to enable the use of custom fields you need to set the
ExtendedPatronAttributes system preference.

Get there: More > Administration > Patrons & Circulation > Patron attribute types

A common use for this field would be for a student ID number or a Driver's license number.

1.3.4.1. Adding Patron Attributes

To add a new Patron Attribute Type, click the 'New Patron Attribute Type' button at the top of the page

In the 'Patron attribute type code', enter a short code to identify this field
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This field is limited to 10 characters (numbers and letters only)
This setting cannot be changed after an attribute is defined

In the 'Description’ field, enter a longer (plain text) explanation of what this field will contain
Check the box next to 'Repeatable’ to let a patron record have multiple values of this attribute.
This setting cannot be changed after an attribute is defined

If 'Unique identifier' is checked, the attribute will be a unique identifier which means, if a value is given to a patron record, the same value cannot be given to a
different record.

This setting cannot be changed after an attribute is defined
Check 'Allow password' to make it possible to associate a password with this attribute.
Check 'Display in OPAC' to display this attribute on a patron's details page in the OPAC.
Check 'Searchable’ to make this attribute searchable in the staff patron search.
Authorized value category; if one is selected, the patron record input page will only allow values to be chosen from the authorized value list.

You will first need to add an authorized value list for it to appear in this menu
Get there: More > Administration > Catalog > Authorized Values
an authorized value list is not enforced during batch patron import.

Click Save to save your new attribute

Once added your attribute will appear on the list of attributes and also on the patron record add/edit form

1.3.4.2. Editing/Deleting Patron Attributes

Each patron attribute has an edit and a delete link beside it on the list of attributes.
Some fields in the attribute will not be editable once created:

Patron attribute type code

Repeatable

Unique identifier

You will be unable to delete an attribute if it's in use.

1.3.5. Circulation and Fine Rules

These rules define how your items are circulated, how/when fines are calculated and how holds are handled.

Get there: More > Administration > Patrons & Circulation > Circulation and fines rules

The rules are applied from most specific to less specific, using the first found in this order:
same library, same patron type, all item types
same library, same patron type, alll item types
same library, all patron types, same item type
same library, all patron types, all item types
all libraries, same patron type, same item type
all libraries, same patron type, all item types

all libraries, all patron types, same item type
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all libraries, all patron types, all item types

If you are a single library system choose your branch name before creating rules (sometimes having only rules for the ‘all libraries' option can cause issues
with holds)

At the very least you will need to set an default circulation rule. This rule should be set for all item types, all libraries and all patron types. That will catch all
instances that do not match a specific rule. When checking out if you do not have a rule for all libraries, all item types and all patron types then you may
see patrons getting blocked from placing holds. You will also want a rule for your specific library set for all item types and all patron types to avoid this
holds issue. Koha needs to know what rule to fall back on.

1.3.5.1. Default Circulation Rules

Using the issuing rules matrix you can define rules that depend on patron/item type combos. To set your rules, choose a library from the pull down (or 'all libraries'
if you want to apply these rules to all branches):

From the matrix you can choose any combination of patron categories and item types to apply the rules to
First choose which patron category you'd like the rule to be applied to. If you leave this to 'All" it will apply to all patron categories
Choose the 'ltem Type' you would like this rule to apply to. If you leave this to 'All" it will apply to all item types
Limit the number of items a patron can have checked out at the same time by entering a number in the 'Current Checkouts Allowed' field
Define the period of time and item can be checked out to a patron by entering the number of days in the 'Loan Period' box.
'Fine Amount' should have the amount you would like to charge for overdue items
Enter only numbers and decimal points (no currency symbols).
The 'Fine Grace Period' is the period of time an item can be overdue before you start charging fines.
Enter the 'Fine Charging Interval' in days (ex. charge fines every 1 day, or every 2 days)
If your library ‘fines' patrons by suspending their account you can enter the number of days their fine should be suspended in the 'Suspension in Days' field
Next decide if the patron can renew this item type and if so, enter how many times they can renew it in the 'Renewals Allowed' box
If the patron can place holds on this item type, enter the total numbers of items (of this type) that can be put on hold in the 'Holds Allowed' field

Finally, if you charge a rental fee for the item type and want to give a specific patron type a discount on that fee, enter the percentage discount (without the %
symbol) in the 'Rental Discount' field

When finished, click 'Add' to save your changes. To modify a rule, create a new one with the same patron type and item type. If you would like to delete your rule,
simply click the 'Delete’ link to the right of the rule.

To save time you can clone rules from one library to another by choosing the clone option above the rules matrix.

After choosing to clone you will be presented with a confirmation message.

1.3.5.2. Default Checkouts and Hold Policy

You can set a default maximum number of checkouts and hold policy that will be used if none is defined below for a particular item type or category.
From this menu you can set a default to apply to all item types and patrons in the library.
In "Total Current Checkouts Allowed' enter the total number of items patrons can have checked out at one time
Control where patrons can place holds from using the 'Hold Policy' menu
From Any Library: Patrons from any library may put this item on hold. (default if none is defined)
From Home Library: Only patrons from the item's home library may put this book on hold.

No Holds Allowed: No patron may put this book on hold.

Once your policy is set, you can unset it by clicking the 'Unset' link to the right of the rule
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1.3.5.3. Checkouts Per Patron

For this library, you can specify the maximum number of loans that a patron of a given category can make, regardless of the item type.

If the total amount loanable for a given patron category is left blank, no limit applies, except possibly for a limit you define for a specific item type.

1.3.5.4. Item Hold Policies

For this library, you can edit rules for given itemtypes, regardless of the patron's category. Currently, this means hold policies.
The various policies have the following effects:

From Any Library: Patrons from any library may put this item on hold. (default if none is defined)

From Home Library: Only patrons from the item's home library may put this book on hold.

No Holds Allowed: No patron may put this book on hold.

Note that if the system preference AllowHoldPolicyOverride set to 'allow', these policies can be overridden by your circulation staff.

These policies are based on the patron's home branch, not the branch that the reserving staff member is from.

1.3.6. Library Transfer Limits

Limit the ability to transfer items between libraries based on the library sending, the library receiving, and the collection code involved.

Get there: More > Administration > Patrons & Circulation > Library Transfer Limits

These rules only go into effect if the preference UseBranchTransferLimits is set to ‘enforce’.

Before you begin you will want to choose which library you are setting these limits for.

Transfer limits are set based on the collections codes you have applied via the Authorized Value administration area.

Collection codes will appear as tabs above the checkboxes:

Check the boxes for the libraries that you accept checkins from for the item type you have selected at the top (in the example below - FIC)

In the above example, Centerville library will allow patrons to return items from all libraries except Liberty and Franklin to their branch.

1.3.7. Item Circulation Alerts

Libraries can decide if they want to have patrons automatically notified of circulation events (check ins and check outs).

Get there: More > Administration > Patrons & Circulation > Item Circulation Alerts

These preferences are set based on patron types and item types.
These preference can be overwritten by changes in the individual patron's messaging preferences.
To set up circulation alerts:
Choose your library from the pull down at the top of the screen

To set preferences for all libraries, keep the menu set to 'Default’

By default all item types and all patrons are notified of check ins and check outs. To change this, click on the item/patron type combo that you would like to
stop notices for.

In the above example, Juveniles and Kids will not receive check out notices.

1.4. Catalog Administration

Set these controls before you start cataloging on your Koha system.
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Get there: More > Administration > Catalog

1.4.1. MARC Bibliographic Frameworks

Think of Frameworks as templates for creating new bibliographic records. Koha comes with some predefined frameworks that can be edited or deleted, and
librarians can create their own frameworks for content specific to their libraries.

Get there: More > Administration > Catalog > MARC Bibliographic Frameworks

Do not delete or edit the Default Framework since this will cause problems with your cataloging records - always create a new template based on the
Default Framework, or alter the other Frameworks.

After clicking the 'MARC structure' link to the right of each framework you can decide how many fields you want to see on one screen by using the pagination
options at the top of the table.

1.4.1.1. Add New Framework

To add a new framework
Click 'New Framework'
Enter a code of 4 or fewer characters

Use the Description field to enter a more detailed definition of your framework

Click 'Submit'
Once your Framework is added click '"MARC structure' to the right of it on the list of Frameworks

You will be asked to choose a Framework to base your new Framework off of, this will make it easier than starting from scratch

Once your Framework appears on the screen you can edit or delete each field by following the instructions for editing subfields

1.4.1.2. Edit Existing Frameworks

Clicking 'Edit' to the right of a Framework will only allow you to edit the Description for the Framework:

To make edits to the fields associated with the Framework you must first click 'MARC Structure' and then follow the instructions for editing subfields

1.4.1.3. Add subfields to Frameworks

To add a field to a Framework click the 'New Tag' button at the top of the Framework definition
This will open up a blank form for entering MARC field data
Enter the information about your new tag:
The 'Tag' is the MARC field number
The 'Label for lib' is the text that will appear in the staff client when in the cataloging module
The 'Label for OPAC' is the text that will appear in the OPAC when viewing the MARC version of the record
If this field can be repeated, check the 'Repeatable’ box
If this field is mandatory, check the 'Mandatory' box

If you want this field to be a pull down with limited possible answers, choose which 'Authorized value' list you want to use

When you're finished, click 'Save Changes' and you will be presented with your new field

To the right of the new field is a link to 'Subfields,' you will need to add subfields before this tag will appear in your MARC editor. The process of entering the
settings for the new subfield is the same as those found in the editing subfields in frameworks section of this manual.
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1.4.1.4. Edit Framework Subfields

Frameworks are made up of MARC fields and subfields. To make edits to most Frameworks you must edit the fields and subfields. Clicking 'Edit' to the right of
each subfield will allow you to make changes to the text associated with the field

Each field has a tag (which is the MARC tag)

The 'Label for lib" is what will show in the staff client if you have advancedMARCeditor set to display labels

The 'Label for OPAC' is what will show on the MARC view in the OPAC
If you check 'Repeatable’ then the field will have a plus sign next to it allowing you to add multiples of that tag
If you check 'Mandatory' the record will not be allowed to save unless you have a value assigned to this tag

'Authorized value' is where you define an authorized value that your catalogers can choose from a pull down to fill this field in

To edit the subfields associated with the tag, click 'Subfields' to the right of the tag on the '"MARC Structure' listing
From the list of subfields you can click 'Delete' to the right of each to delete the subfields
To edit the subfields click 'Edit Subfields'
For each subfield you can set the following values
Text for librarian

what appears before the subfield in the librarian interface

Text for OPAC
what appears before the field in the OPAC.

If left empty, the text for librarian is used instead

Repeatable

the field will have a plus sign next to it allowing you to add multiples of that tag

Mandatory

the record will not be allowed to save unless you have a value assigned to this tag

Managed in tab

defines the tab where the subfield is shown. All subfields of a given field must be in the same tab or ignored. Ignore means that the subfield is not
managed.

Default value

defines what you want to appear in the field by default, this will be editable, but it saves time if you use the same note over and over or the same value
in a field often.

hidden
allows you to select from 19 possible visibility conditions, 17 of which are implemented. They are the following:
-9 => Future use
-8 => Flag
-7 => OPAC lIntranet !Editor Collapsed

-6 => OPAC Intranet !Editor !Collapsed
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-5 => OPAC Intranet |Editor Collapsed
-4 => OPAC !Intranet !Editor !Collapsed
-3 => OPAC !Intranet Editor Collapsed
-2 => OPAC !Intranet Editor !Collapsed
-1 => OPAC Intranet Editor Collapsed
0 => OPAC Intranet Editor !Collapsed
1 =>10PAC Intranet Editor Collapsed
2 => IOPAC lIntranet Editor !Collapsed
3 =>IOPAC lIntranet Editor Collapsed
4 => 10PAC Intranet Editor !Collapsed
5 => I0PAC !Intranet !Editor Collapsed
6 => IOPAC Intranet !Editor !Collapsed
7 => IOPAC Intranet !Editor Collapsed
8 => IOPAC !Intranet !Editor !Collapsed

9 => Future use URL : if checked, the subfield is an URL, and can be clicked

(! means 'not visible' or in the case of Collapsed 'not Collapsed')

Isa URL

if checked, it means that the subfield is a URL and can be clicked

Link

If you enter a field/subfield here (200b), a link appears after the subfield in the MARC Detail view. This view is present only in the staff client, not the
OPAC. If the librarian clicks on the link, a search is done on the database for the field/subfield with the same value. This can be used for 2 main topics :

on a field like author (200f in UNIMARC), put 200f here, you will be able to see all bib records with the same author.
on a field that is a link (4xx) to reach another bib record. For example, put 011a in 464$x, will find the serials that are with this ISSN.
This value should not change after data has been added to your catalog
Koha link

Koha is multi-MARC compliant. So, it does not know what the 245%a means, neither what 200$f (those 2 fields being both the title in MARC21 and
UNIMARC). So, in this list you can "map" a MARC subfield to its meaning. Koha constantly maintains consistency between a subfield and its meaning.
When the user want to search on "title", this link is used to find what is searched (245 if you're MARC21, 200 if you're UNIMARC).

Authorized value
means the value cannot by typed by the librarian, but must be chosen from a pull down generated by the authorized value list

In the example above, the 504a field will show the MARC504 Authorized Values when cataloging

Thesaurus

means that the value is not free text, but must be searched in the authority/thesaurus of the selected category

Plugin

means the value is calculated or managed by a plugin. Plugins can do almost anything.
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For example, in UNIMARC there are plugins for every 1xx fields that are coded fields. The plugin is a huge help for cataloger ! There are also two
plugins (unimarc_plugin_210c and unimarc_plugin_225a that can "magically” find the editor from an ISBN, and the collection list for the editor)

To save your changes simply click the 'Save Changes' button at the top of the screen

1.4.2. Koha to MARC Mapping

While Koha stores the entire MARC record, it also stores common fields for easy access in various tables in the database. Koha to MARC Mapping is used to tell
Koha where to find these values in the MARC record. In many cases you will not have to change the default values set by in this tool on installation, but it is
important to know that the tool is here and can be used at any time.

Get there: More > Administration > Catalog > Koha to MARC Mapping

The Koha to MARC Mapping page offers you the option of choosing from one of three tables in the database to assign values to.
After choosing the table you would like to view, click 'OK." To edit any mapping click on the 'Koha Filed' or the 'Edit' link.

Choose which MARC field you would like to map to this Koha Field and click the 'OK' button. If you would like to clear all mappings, click the 'Click to "Unmap™
button.

At this time you can map only 1 MARC field to 1 Koha field. This means that you won't be able to map both the 100a and the 700a to the author field, you
need to choose one or the other.

1.4.3. Keywords to MARC Mapping

This tool will allow you to map MARC fields to a set of predefined keywords.

Get there: More > Administration > Catalog > Keywords to MARC Mapping

At this time the only keyword in use is 'subtitle.'

Using this tool you can define what MARC field prints to the detail screen of the bibliographic record using keywords. The following example will use the subtitle
field.

Using the Framework pull down menu, choose the Framework you would like to apply this rule to. For example, the subtitle for books can be found in the 245%b
field.

However the subtitle for DVDs appears in 245%p
Using this tool you can tell Koha to print the right field as the subtitle when viewing the bibliographic record in the OPAC.

Future developments will include additional keyword assigned fields.

1.4.4. MARC Bibliographic Framework Test

Checks the MARC structure.

Get there: More > Administration > Catalog > MARC Bibliographic Framework Test

If you change your MARC Bibliographic framework it's recommended that you run this tool to test for errors in your definition.

1.4.5. Authority Types

Authority Types are basically MARC Frameworks for Authority records and because of that they follow the same editing rules found in the MARC Bibliographic
Frameworks section of this manual. Koha comes with many of the necessary Authority frameworks already installed. To learn how to add and edit Authority
Types, simply review the MARC Bibliographic Frameworks section of this manual.

Get there: More > Administration > Catalog > Authority Types

1.4.6. Classification Sources
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Source of classification or shelving scheme is an Authorized Values category that is mapped to field 942$2 in Koha's MARC Bibliographic frameworks.

Get there: More > Administration > Catalog > Classification sources

Commonly used values of this field are:
ddc - Dewey Decimal Classification

Icc - Library of Congress Classification

If you chose to install classification sources during Koha's installation, you would see other values too:
ANSCR (sound recordings)
SuDOC classification
Universal Decimal Classification

Other/Generic Classification

1.4.6.1. Adding/Editing Classification Sources

You can add your own source of classification by using the New Classification Source button. To edit use the Edit link.
When creating or editing:

You will need to enter a code and a description.

Check the 'Source in use?' checkbox if you want the value to appear in the drop down list for this category.

Select the appropriate filing rule from the drop down list.

1.4.6.2. Classification Filing Rules

Filing rules determine the order in which items are placed on shelves.
Values that are pre-configured in Koha are:

Dewey

LCC

Generic

Filing rules are mapped to Classification sources. You can setup new filing rules by using the New Filing Rule button. To edit use the Edit link.

When creating or editing:
Enter a code and a description

Choose an appropriate filing routine - dewey, generic or Icc

1.4.7. Record Matching Rules

Record matching rules are used when importing MARC records into Koha.

Get there: More > Administration > Catalog > Record Matching Rules

The rules that you set up here will be referenced with you Stage MARC Records for Import.

To create a new matching rule :
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Click 'New Record Matching Rule'
Choose a unique name and enter it in the 'Matching rule code' field
'Description’ can be anything you want to make it clear to you what rule you're picking
'Match threshold' - ??
Match points are set up to determine what fields to match on
'Search index' can be found by looking at the ccl.properties file on your system which tells the zebra indexing what data to search for in the MARC data".
'Score' - ??
Enter the MARC tag you want to match on in the 'Tag' field
Enter the MARC tag subfield you want to match on in the 'Subfields' field
'Offset’ - ??
'Length’ - ??

Koha only has one 'Normalization rule' that removes extra characters such as commas and semicolons. The value you enter in this field is irrelevant to the
normalization process.

'Required match checks' - ??

1.4.7.1. Sample Record Matching Rule: Control Number

Match threshold: 100
Matchpoints (just the one):
Search index: Control-number
Score: 101
Tag: 001
this field is for the control number assigned by the organization creating, using, or distributing the record
Subfields: a
Offset: 0
Length: 0
Normalization rule: Control-number

Required Match checks: none (remove the blank one)

1.5. Acquisitions

Get there: More > Administration > Acquisitions

1.5.1. Currencies and Exchange Rates

If you place orders from more than one country you will want to input currency exchange rates so that your acquisitions module will properly calculate totals.
Get there: More > Administration > Acquisitions > Currencies and Exchange Rates
This data is not automatically updated, so be sure to keep it up to date so that your accounting is kept correct.

The active currency is the main currency you use in your library. Your active currency will have a check mark in the 'Active’ column. If you don't have an active
currency you will see an error message telling you to choose an active currency.
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1.5.2. Budgets
Budgets are the top level used for tracking accounting values related to acquisitions.

Get there: More > Administration > Acquisitions > Budgets

An example would be to create a budget for the current year and then breaking that into Funds for different areas of the library.

1.5.2.1. Add a budget

To add a budget click the 'New Budget' button.
Choose the time period this budget is for, whether it's an academic year, a fiscal year, a quarter, etc.
The Description should be something that will help you identify the budget when ordering
In the amount box do not use any symbols, simply enter the amount of the budget with numbers and decimals.

Marking a budget active makes it usable when placing orders in the acquisitions module, even if the order is placed after the budget end date. This will allow
you to record orders that were places in a previous budget period.

Locking a budget means that Funds will not be able to be modified by librarians

Once you have made your edits, click the 'Save Changes' button. You will be brought to a list of your existing budgets.

1.5.3. Funds

Get there: More > Administration > Acquisitions > Funds

1.5.3.1. Add a Fund
A fund is added to a budget.

A budget must be defined before a fund can be created.

To add a new fund click the New button and then choose which Budget you would like to add the fund to.
In the form that appears you wan to enter the basics about your fund.
The three first fields are required, the rest are optional
Fund Code is a unique identifier for your fund
The Fund Name should be something that librarians will understand
Amount should be entered with only numbers and decimals, no other characters
Encumbrance ??
Expenditure ??
You can choose to assign this fund to a librarian. Doing so will make it so that only that librarian can make changes to the Fund
Choose which library will be using this fund
You can restrict who can order from this fund by choosing either the owner or the library from the 'Restrict access to' menu
Notes are simply for any descriptive notes you might want to add so that librarians know when to use this fund

Planning categories are used for statistical purposes. To learn more about planning categories, check out the Planning Category FAQ.

When complete, click 'Submit' and you will be brought to a list of all of the funds for the budget.

To the right of each fund you will find the 'Edit," 'Delete," and 'Add Child Fund' options. A child fund simply a sub-fund of the fund listed. An example would be to
have a fund for 'Fiction' and under that have a fund for 'New Releases' and a fund for 'Science Fiction." It is an optional way to further organize your finances.
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1.5.3.2. Budget Planning

When viewing the list of funds click the 'Planning' button and choose how you would like to plan to spend your budget.
If you choose 'Plan by MONTHS' you will see the budgeted amount broken down by months:

To hide some of the columns you can click the minus sign (-) to the right (or below as in the screenshot above) the dates. To add more columns you can click the
plus sign (+) found above the 'Auto-fill row' buttons.

From here you can plan your budget spending by manually entering values or by clicking the 'Auto-fill row' button. If you choose to auto-fill the form the system
will try to divide the amount accordingly, you may have to make some edits to split things more accurately.

Once your changes are made, click the 'Save' button. If you would like to export your data as a CSV file you can do so by entering a file name in the '‘Output to a
file named' field and clicking the 'Output' button.

1.6. Additional Parameters

Get there: More > Administration > Additional Parameters

1.6.1. Stop Words
If NoZebra is set to 'Use' this option will not appear on the administration menu
Stop words are words that you want the search system to ignore.

Get there: More > Administration > Additional Parameters > Stop Words

Koha comes with a standard list of stop words that can be edited by visiting the Stop Word administration area.
To add a new stop word to the list, click the 'New Stop Word' button and add the word you'd like ignored

If you change something in this table, ask your administrator to run misc/batchRebuildBiblioTables.pl script.

1.6.2. Z39.50 Servers

Koha has a powerful copy cataloging tool. Using Koha you can connect to any Z39.50 target that is publicly available or that you have the log in information to.

Get there: More > Administration > Additional Parameters > Z39.50 Servers

Koha comes with a default list of Z39.50 targets set up that you can add to, edit or delete

To find additional targets you use IndexData's IRSpy: http://irspy.indexdata.com

1.6.2.1. Add a Z39.50 Target

From the main Z39.50 page, click 'New Z39.50 Server'

Userid and Password are only required for servers that are password protected

1.6.2.2. Suggested Z39.50 Targets

The following targets have been used successfully by other Koha libraries (in the Americas):
BIBLIOS z3950.biblios.net:210 bibliographic
BIG COUNTRY KOHA bcls.kohalibrary.com:210 bcls_koha
CUYAHOGA COUNTY PUBLIC webcat.cuyahoga.lib.oh.us:210 INNOPAC
GREATER SUDBURY PUBLIC 216.223.90.51:210 INNOPAC

HALIFAX PUBLIC catalogue.halifaxpubliclibraries.ca:210 horizon
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HALTON HILLS PUBLIC cat.hhpl.on.ca:210 halton_hills

LIBRARY OF CONGRESS z3950.loc.gov:7090 Voyager

LONDON PUBLIC LIBRARY catalogue.londonpubliclibrary.ca:210 INNOPAC
MANITOBA PUBLIC library.gov.mb.ca:210 horizon

MILTON PL cat.mpl.on.ca:210 horizon

NATIONAL LIBRARY OF WALES cat.llgc.org.uk:210 default

TORONTO PUBLIC symphony.torontopubliclibrary.ca:2200 unicorn

TRI-UNI 129.97.129.194:7090 voyager

VANCOUVER PUBLIC LIBRARY z3950.vpl.ca:210 Horizon

Chapter 2. Tools

Tools in Koha all perform some sort of action. Often many of the items listed under Tools in Koha are referred to as 'Reports' in other library management
systems.

Get there: More > Tools

2.1. News

Get there: More > Tools > Additional Tools > News

Koha's news module allows librarians to post news to the OPAC, staff interface and circulation receipts.
To add news to either the OPAC, the Staff Client or a Circulation receipt:
Click 'New Entry"
Under 'Display Location' choose whether to put the news on the OPAC, Slip (circulation receipt) or the Librarian (Staff) Interface.
Choose a title for your entry
Using the publication and expiration date fields you can control how long your item appears
'Appear in position' lets you decide what order your news items appear in

The 'News' box allows for the use of HTML for formatting of your news item

Atfter filling in all of the fields, click 'Submit'
News in the OPAC will appear above the OpacMainUserBlock
News in the Staff Client will appear on the far left of the screen

News on the circulation receipts will appear below the items that are checked out

2.2. Label Creator

Get there: More > Tools > Catalog > Label Creator

The Label Creator allow you to use layouts and templates which you design to print a nearly unlimited variety of labels including barcodes. Here are some of the
features of the Label Creator module:

Customize label layouts
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Design custom label templates for printed labels
Build and manage batches of labels
Export single or multiple batches
Export single or multiple labels from within a batch
Export label data in one of three formats:
PDF - Readable by any standard PDF reader, making labels printable directly on a printer
CSV - Export label data after your chosen layout is applied allowing labels to be imported in to a variety of applications

XML - Included as an alternate export format

At the top of each screen within the Label Creator, you will see a toolbar allowing quick access to relevant functions. The menu to the left of each screen also
allows easy access to the different sections of the Label Creator. The breadcrumb trail near the top of each screen will give specific indication as to where you are
within the Label Creator module and allow quick navigation to previously traversed sections. And finally, you can find more detailed information on each section of
the Label Creator by clicking the online help link at the upper left-hand corner of every page.

2.2.1. Templates
Get there: More > Tools > Label Creator > Templates
A template is based on the label/card stock you are using. This might be Avery 5160 for address labels, Gaylord 47-284 for spine labels or Avery 28371 for your

patron cards, just to give a couple of examples. These labels will include all of the information you will need for setting up a Koha, this information may be on the
packaging, and if not it can usually be found on the vendor's website.

2.2.1.1. Add a Template

To add a new template, you want to click on the 'Templates' button at the top of your page and choose 'New Template'
Using the form that appears you can define the template for your sheet of labels or cards.
Template ID will be automatically generated after saving your template, this is simply a system generated unique id
Template Code should be something you can use to identify your template on a list of templates
You can use the Template Description to add additional information about the template

The Units pull down is used to define what measurement scale you're going to be using for the template. This should probably match the unit of measurement
used on the template description provided by the product vendor.

The measurements, number of columns and number of rows can be found on the vendor product packaging or website.
If you do not supply a left text margin in the template, a 3/16" (13.5 point) left text margin will apply by default.

A profile is a set of "adjustments" applied to a given template just prior to printing which compensates for anomalies unique and peculiar to a given printer (to
which the profile is assigned).

Before picking a profile try printing some sample labels so that you can easily define a profile that is right for your printer/template combination.

After finding any anomalies in the printed document, create a profile and assign it to the template.

After saving, your templates will appear on the ‘Manage Templates' page.

2.2.2. Profiles

Get there: More > Tools > Label Creator > Profiles

A profile is a set of "adjustments" applied to a given template just prior to printing which compensates for anomalies unique and peculiar to a given printer (to
which the profile is assigned). This means if you set a template up and then print a sample set of data and find that the items are not all aligned the same on each
label, you need to set up a profile for each printer to make up for the differences in printing styles, such as the shifting of text to the left, right, top or bottom.
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If your labels are printing just the way you want, you will not need a profile.

2.2.2.1. Add a Profile

To add a new profile, you want to click on the 'Profiles' button at the top of your page and choose ‘New Profile’
Using the form that appears you can create a profile to fix any problems with your template.

The Printer Name and Paper Bin do not have to match your printer exactly, they are for your reference so you can remember what printer you have set the
profile for. So if you want to use the Printer model number in printer name or you can call it ‘the printer on my desk’

Template will be filled in once you have chosen which template to apply the profile to on the template edit form
The Units pull down is used to define what measurement scale you're going to be using for your profile.

Offset describes what happens when the entire image is off center either vertically or horizontally and creep describes a condition where the distance between
the labels changes across the page or up and down the page

For these values, negative numbers move the error up and to the left and positive numbers move the error down and to the right

Example: the text is .25" from the left edge of the first label, .28" from the left edge of the second label and .31" from the left edge of the third label. This
means the horizontal creep should be set to .03" to make up for this difference.

After saving, your profiles will appear on the 'Manage Profiles' page.

Once you have saved your new profile, you can return to the list of templates and choose to edit the template that this profile is for.

2.2.3. Layouts

Get there: More > Tools > Label Creator > Layouts

A layout is used to define the fields you want to appear on your labels.

2.2.3.1. Add a Layout

To add a new layout, you want to click on the ‘Layouts' button at the top of your page and choose ‘New Layout'
Using the form that appears you can create a profile to fix any problems with your template.

After saving, your layouts will appear on the 'Manage Layouts' page.

2.2.4. Batches

Get there: More > Tools > Label Creator > Batches

Batches are made up of the barcodes you would like to print. Once in this tool you can search for the item records you would like to print out labels for.

2.2.4.1. Add a Batch

Batches can be created in one of two ways. The first is to click the 'Create Label Batch' link on the 'Staged MARC Management' page:

The other is to choose to create a new batch from the label creator tool

You will be brought to an empty batch with an 'Add item(s)' button at the top of the page. Clicking 'Add item(s)" will open a search window for you to find the items
you want to add to the batch.

From the search results, click the check box next to the items you want to add to the batch and click the 'Add checked' button. You can also add items one by one
by clicking the 'Add' link to the left of each item.

Once you have added all of the items click the 'Done’ button. The resulting page will list the items you have selected.

To print your labels, click the 'Export Batch' button. To print only some of the labels, click the 'Export Item(s)' button. Either way you will be presented with a
confirmation screen where you can choose your template and layout.
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You will then be presented with three download options: PDF, Excel, and CSV.

After saving your file, simply print to the blank labels you have in your library.

2.3. Quick Spine Label Creator

Get there: More > Tools > Catalog > Quick Spine Label Creator
This tool does not use the label layouts or templates, it simply prints a spine label in the first spot on the label sheet.
Define the fields you want to print on the spine label in the SpineLabelFormat system preference
Format your label printing by editing spinelabel.css found in koha-tmpl/intranet-tmpl/prog/en/css/

To use this tool you simply need the barcode for the book you'd like to print the spine label for.

2.4. Patron Card Creator

Get there: More > Tools > Patrons and Circulation > Patron Card Creator

The Patron Card Creator allow you to use layouts and templates which you design to print a nearly unlimited variety of patron cards including barcodes. Here are
some of the features of the Patron Card Creator module:

Customize patron card layouts

Design custom card templates for printed patron cards
Build and manage batches of patron cards

Export single or multiple batches

Export single or multiple patron cards from within a batch

Export card data as a PDF readable by any standard PDF reader, making patron cards printable directly on a printer

At the top of each screen within the Patron Card Creator, you will see a toolbar allowing quick access to relevant functions. The menu to the left of each screen
also allows easy access to the different sections of the Patron Card Creator. The breadcrumb trail near the top of each screen will give specific indication as to
where you are within the Patron Card Creator module and allow quick navigation to previously traversed sections. And finally, you can find more detailed
information on each section of the Patron Card Creator by clicking the online help link at the upper left-hand corner of every page.

2.4.1. Templates
Get there: More > Tools > Patron Card Creator > Templates
A template is the label/card stock you are using. This might be Avery 5160 for address labels, Gaylord 47-284 for spine labels or Avery 28371 for your patron

cards, just to give a couple of examples. These labels will include all of the information you will need for setting up a Koha, this information may be on the
packaging, and if not it can usually be found on the vendor's website.

2.4.1.1. Add a Template

To add a new template, you want to click on the 'Templates' button at the top of your page and choose 'New Template'
Using the form that appears you can define the template for your sheet of labels or cards.
Template ID will be automatically generated after saving your template, this is simply a system generated unique id
Template Code should be something you can use to identify your template on a list of templates
You can use the Template Description to add additional information about the template

The Units pull down is used to define what measurement scale you're going to be using for the template. This should probably match the unit of measurement
used on the template description provided by the product vendor.

The measurements can be found on the vendor product packaging or website.
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A profile is a set of "adjustments" applied to a given template just prior to printing which compensates for anomalies unique and peculiar to a given printer (to
which the profile is assigned).

Before picking a profile try printing some sample cards so that you can easily define a profile that is right for your printer/template combination.

After finding any anomalies in the printed document, create a profile and assign it to the template.

After saving, your templates will appear on the '"Manage Templates' page.

2.4.2. Profiles

Get there: More > Tools > Patron Card Creator > Profiles

A profile is a set of "adjustments” applied to a given template just prior to printing which compensates for anomalies unique and peculiar to a given printer (to
which the profile is assigned). This means if you set a template up and then print a sample set of data and find that the items are not all aligned the same on each
card, you need to set up a profile for each printer to make up for the differences in printing styles, such as the shifting of text to the left, right, top or bottom.

If your cards are printing just the way you want, you will not need a profile.

2.4.2.1. Add a Profile

To add a new profile, you want to click on the 'Profiles’ button at the top of your page and choose 'New Profile’
Using the form that appears you can create a profile to fix any problems with your template.

The Printer Name and Paper Bin do not have to match your printer exactly, they are for your reference so you can remember what printer you have set the
profile for. So if you want to use the Printer model number in printer name or you can call it 'the printer on my desk’

Template will be filled in once you have chosen which template to apply the profile to on the template edit form
The Units pull down is used to define what measurement scale you're going to be using for your profile.

Offset describes what happens when the entire image is off center either vertically or horizontally and creep describes a condition where the distance between
the labels changes across the page or up and down the page

For these values, negative numbers move the error up and to the left and positive numbers move the error down and to the right

Example: the text is .25" from the left edge of the first label, .28" from the left edge of the second label and .31" from the left edge of the third label. This
means the horizontal creep should be set to .03" to make up for this difference.

After saving, your profiles will appear on the 'Manage Profiles' page.

Once you have saved your new profile, you can return to the list of templates and choose to edit the template that this profile is for.

2.4.3. Layouts

Get there: More > Tools > Patron Card Creator > Layouts

A layout defines the text and images that will be printed on to the card and where it will appear.

2.4.3.1. Add a Layout

To add a new layout, you want to click on the 'Layouts' button at the top of your page and choose 'New Layout'

Using the form that appears you can create a profile to fix any problems with your template.
The name you assign to the layout is for your benefit, name it something that will be easy to identify at a later date
The Units pull down is used to define what measurement scale you're going to be using for your layout.
Next note if this layout is for the front or the back of the patron card

You will need a layout for both the front and back of your card if you have 2-sided library cards
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You have the option of adding up to 3 lines of text to your card. Your text can be static text of your choosing and/or fields from the patron record. If you want to
print fields from the patron record you want to put the field names in brackets like so - <firstname>

For each line of text, you can choose your font, font size and the location of the text on the card using the lower X and Y coordinates

In order to show the barcode and the patron card number you will need to check the 'Print Card Number as Barcode' option. This will turn the patron card
number into a barcode. If you want the number to print in human readable format you will need to check the 'Print Card Number as Text Under Barcode'
option.

Finally you can choose up to two images to print on the card.
One can be the patron image which you can resize to meet your needs.

The other image can be something like a library logo or symbol that you uploaded using the 'Manage Images' module of the Patron Card Creator Tool.

After saving, your layouts will appear on the 'Manage Layouts' page.

2.4.4. Batches

Get there: More > Tools > Patron Card Creator > Batches

A batch is a collection of patrons for whom you want to generate cards.

2.4.4.1. Add a Batch

To add a new batch, you want to click on the 'Batches' button at the top of your page and choose 'New Batch'

2.4.5. Manage Images

Get there: More > Tools > Patron Card Creator > Manage Images

Images uploaded using this tool will appear on the menu when creating patron card layouts. You are limited in how many images you can upload (not counting
patron images) by the ImageLimit system preference.

Images must be under 500k in size.
Pictures uploaded with this tool should be at least 300dpi which is the minimum quality for a printable image.

In the center of the screen is a simple upload form, simply browse for the file on your computer and give it a name you'll recognize later.
Once the file is uploaded you will be presented with a confirmation message.
And the image will be listed with all of your others on the right hand side of the page.

To delete one or multiple of these images, click the checkbox to the right of each image you want to delete and click the 'Delete' button.

2.5. Calendar & Holidays

Get there: More > Tools > Additional Tools > Calendar

Libraries can define library closings and holidays to be used when calculating due dates. You can make use of the Calendar by turning on the proper system
preferences:

Get there: More > Administration > Global System Preferences > Circulation > useDaysMode

Choose the method for calculating due date - either include days the library is closed in the calculation or don't include them.

Get there: More > Administration > Global System Preferences > Circulation > finescalendar

This will check the holiday calendar before charging fines

2.5.1. Adding Events
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Before adding events, choose the library you would like to apply the closings to. When adding events you will be asked if you would like to apply the event to one
branch or all branches. To add events, simply

Click on the date on the calendar that you would like to apply the closing to
In the form that appears above the calendar, enter the closing information
Library will be filled in automatically based on the library you chose from the pull down at the top of the page
The day information will also be filled in automatically based on the date you clicked on the calendar
In the description enter the reason the library is closed
Next you can choose if this event is a one time event or if it is repeatable.

Finally decide if this event should be applied to all libraries or just the one you have originally selected

After saving you will see the event listed in the summary to the right the calendar

2.5.2. Editing Events

To edit events
Click on the event on the calendar that you want to change (do this by clicking on the date on the calendar, not the event listed in the summary)
From this form you can make edits to the holiday or delete the holiday completely. Both actions require that you click 'Save' before the change will be made.
Clicking on repeatable events will offer slightly different options

In the form above you will note that there is now an option to 'Generate an exception for this repeated holiday," choosing this option will allow you to make it
so that this date is not closed even though the library is usually closed on this date.

2.5.3. Additional Help

When adding or editing events you can get additional help by clicking on the question mark next to various different options on the form

2.6. Comments/Reviews

Get there: More > Tools > Patrons and Circulation > Comments

All comments added by patrons via the OPAC to bibliographic records require moderation by the librarians. To moderate comments simply click ‘Approve' or
'Delete’ to the right of the comments awaiting moderation.

If there are no comments to moderate you will see a message saying just that

2.7. Tag Moderation

Get there: More > Tools > Patrons and Circulation > Tags

Depending on your tagging system preferences, librarians may need to approve tags before they are published on the OPAC. This is done via the Tag
Moderation Tool.

When first visiting the tool, you will be presented with a list of tags that are pending approval or rejection by a librarian
To approve a tag, you can either click the 'Approve’ button inline with the term, or check all terms you want to approve and click '‘Approve' below the table.

To reject a tag, you can either click the 'Reject’ button inline with the term, or check all terms you want to approve and click 'Reject' below the table.

Once a tag has been approved or rejected it will be moved to the appropriate list of tags. A summary of all tags will appear on the right of the screen.

Even though a tag is approved or rejected, it can still be moved to another list. When viewing approved tags each tag has the option to reject:
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To check terms against the approved and rejected lists (and possibly against the dictionary you have assigned for tag moderation) simply enter the term into the
search box on the bottom right of the screen to see the status of the term

2.8. CSV Profiles

Get there: More > Tools > Additional Tools > CSV Profiles

CSV Profiles are created to define how you would like your cart or list to export.

2.8.1. Add CSV Profiles

To add a CSV Profile
Click 'CSV Profiles' from the Tools menu
The 'Profile name' will appear on the export pull down list when choosing '‘Download’ from your cart or list
The 'Profile description' is for your own benefit
The 'CSV separator' is the character used to separate values and value groups
The 'Field separator' is the character used to separate duplicate fields

Example: You may have multiple 650 fields

The 'Subfield separator' is the character used to separate duplicate subfields

Example: You may have multiple $a subfields in a field

The 'Encoding’ field lets you define the encoding used when saving the file
Finally format your CSV file using the 'Profile marcfields' fields
Define which fields or subfields you want to export, separated by pipes. Example : 200|210%$a|301

You can also use your own headers (instead of the ones from Koha) by prefixing the field number with an header, followed by the equal sign.
Example : Personal name=200|Entry element=210$a|300]|009

2.8.2. Modify CSV Profiles

Once you have created at least one CSV Profile an 'Edit profile' tab will appear next to the 'New profile’ button.
Choose the profile you would like to edit and alter the necessary fields.

To delete a profile, check the 'Delete selected profile’ option before clicking 'Submit Query’

2.8.3. Using CSV Profiles

Your CSV Profiles will appear on the export list or cart menu under the '‘Download' button

2.9. Stage MARC Records for Import

Get there: More > Tools > Catalog > Stage MARC records for import

Importing records into Koha includes two steps. The first is to stage records for import.
First find the MARC file on your computer
Next you will be presented with options for record matching and item imports

Enter 'Comments about this file' to identify your upload when going to the 'Manage Staged MARC Records' tool
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Choose the character encoding
Choose whether or not you want to look for matching records

You can set up record matching rules through the administration area

Next choose what to do with matching records if they are found
Finally choose what to do with records that are unique

Next you can choose whether or not to import the item data found in the MARC records

Click 'Stage for import'
You will be presented with a confirmation of your MARC import

To complete the process continue to the Managed Staged MARC Records Tool

2.10. Staged MARC Record Management

Get there: More > Tools > Catalog > Staged MARC Record Management

Once you have staged your records for import you can complete the import using this tool.
From the list of staged records, click on the file name that you want to finish importing

You will note that records that have already been imported will say so under 'Status'

A summary of your import will appear along with the option to change your matching rules
Below the summary there will be a list of the records that will be imported

Review your summary before completing your import to make sure that your matching rule worked and that the records appear as you expect them to

Click 'Import into catalog' to complete the import
Once your import is complete a link to the new bib records will appear to the right of each title that was imported

You can also undo your import by clicking the 'Undo import into catalog' button

Records imported using this tool remain in the 'reservoir' until they are cleaned. These items will appear when searching the catalog from the Cataloging tool:
To clean items out of the 'reservoir"

Visit the main screen of the Manage Staged MARC Records tool

To clean a batch, click the 'Clean’ button to the right

You will be presented with a confirmation message

Accept the deletion and the records will be removed from the reservoir and the status will be changed to 'cleaned'

2.11. Export Bibliographic and Holdings Data (MARC Export)

Get there: More > Tools > Catalog > Export Bibliographic and Holdings Data

Koha comes with a tool that will allow you to export your bibliographic and/or holdings data in bulk. This can be used to send your records to fellow libraries,
organizations or services; or simply for backup purposes.

Fill in the form in order to limit your export to a specific range (all fields are optional)
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Choose to limit your export by any one or more of the following options
Limit to a bib number range
Limit to a specific item type
Limit to a specific library
Limit to a call number range

Limit to an acquisition date range

Next choose what to skip when exporting
By default items will be exported, if you would like to only export bibliographic data, check the 'Don't export items' box

To limit your export only to items from the library you're logged in as (if you leave the 'Library’ field set to 'All') or to the library you selected above check
the 'Remove non-local items' box

You can also choose what fields you don't want to export. This can be handy if you're sharing your data, you can remove all local fields before sending
your data to another library

Finally choose the file type and file name
Choose to export your data in marc or marcxml format

Choose the name you want your file to save as

Click 'Export'

2.12. Patron Import

Get there: More > Tools > Patrons and Circulation > Import Patrons

The patron import tool can be used at any time to add patrons in bulk. It is commonly used in universities and schools when a new batch of students registers.

2.12.1. Creating Patron File

Your Koha installation comes with a blank CSV file that you can use as a template for your patron records. If you would like to create the file yourself, make sure
that your file has the following fields in this order as the header row:

borrowernumber, cardnumber, surname, firstname, title, othernames, initials, streetnumber, streettype, address, address2, city, zipcode, country, email, phone,
mobile, fax, emailpro, phonepro, B_streetnumber, B_streettype, B_address, B_address2, B_city, B_zipcode, B_country, B_email, B_phone, dateofbirth,
branchcode, categorycode, dateenrolled, dateexpiry, gonenoaddress, lost, debarred, contactname, contactfirstname, contacttitle, guarantorid, borrowernotes,
relationship, ethnicity, ethnotes, sex, password, flags, userid, opacnote, contactnote, sortl, sort2, altcontactfirstname, altcontactsurname, altcontactaddress1,
altcontactaddress2, altcontactaddress3, altcontactzipcode, altcontactcountry, altcontactphone, smsalertnumber, patron_attributes

The 'password' value should be stored in plain text, and will be converted to a md5 hash (which is an encrypted version of the password).

If your passwords are already encrypted, talk to your systems administrator about options
Date formats should match your system preference, and must be zero-padded, e.g. '01/02/2008".
The fields 'branchcode' and ‘categorycode’ are required and must match valid entries in your database.
If loading patron attributes, the ‘patron_attributes' field should contain a comma-separated list of attribute types and values.

The attribute type code and a colon should precede each value.
For example: INSTID:12345,LANG:fr or STARTDATE:January 1 2010,TRACK:Day

If an input record has more than one attribute, the fields should either be entered as an unquoted string (previous examples), or with each field
wrapped in separate double quotes and delimited by a comma:

"STARTDATE:January 1, 2010"," TRACK:Day"

This syntax would be required if the data might have a comma in it, like a date string.
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2.12.2. Importing Patrons

Once you have created your file, you can use the Patron Import Tool to bring the data into Koha.
Choose your CSV file and choose to match on '‘Cardnumber’ to prevent adding of duplicate card numbers to the system
Next you can choose default values to apply to all patrons you are importing

ex. If you're importing patrons specific to one branch you can use the field on the Import form to apply the branch code to all those you are importing.

Finally you need to decide on what data you want to replace if there are duplicates.
A matching record is found using the field you chose for matching criteria to prevent duplication

If you included patron attributes in your file you can decide whether to add your values to existing values or erase existing values and enter only your new
values.

2.13. Patrons (anonymize, bulk-delete)

Get there: More > Tools > Patrons and Circulation > Patrons (anonymize, bulk-delete)

This tool allows you to bulk anonymize circulation histories (this means that you keep records of how many times items were checked out - but not the patrons
who checked the items out) or bulk delete patrons (remove them from the system completely).

Patrons with outstanding fines or items checked out are not saved. They are not completely removed from the system (moved to the delete_borrowers
table), but this tool does not provide as many checks as one may desire.

To either delete or anonymize patrons
Check the task you would like to perform (Delete or Anonymize)
Enter a date before which you want to alter the data
Click 'Next'
A confirmation will appear asking if you're sure this is what you want to happen

Clicking 'Finish' will delete or anonymize your data

2.14. Upload Patron Images

Get there: More > Tools > Patrons and Circulation > Upload Patron Images

Patron images can be uploaded in bulk if you are allowing patron images to be attached to patron records. These images can also be used when creating patron
cards.

Create a txt file and title it "DATALINK.TXT" or "IDLINK.TXT"
On each line in the text file enter the patron's card number followed by comma (or tab) and then the image file name

Make sure that your TXT file is a plain text document, not RTF.

Zip up the text file and the image files

Go to the Upload Patron Images Tool

For a single image, simply point to the image file and enter the patron card number
For multiple images, choose to upload a zip file

After uploading you will be presented with a confirmation

There is a limit of 520K on the size of the picture uploaded and it is recommended that the image be 200x300 pixels, but smaller images will work as well.
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2.15. Task Scheduler

Get there: More > Tools > Additional Tools > Task Scheduler

The task scheduler is a way to schedule reports to run whenever you want.
To schedule a task, visit the Task Scheduler and fill in the form
Current Server Time shows the time on your server (schedule all of your reports to run based on that time - not on your local time)
Time should be entered as hh:mm (2 digit hour, 2 digit minute)
Date should be entered using the calendar pop up
From Report choose the report you want to schedule
Choose whether to receive the text of or a link to the results

In the Email filed enter the email of the person you want to receive your report

Below the task scheduler form, there is a list of scheduled reports

You can also schedule reports directly from the list of saved reports by clicking the ‘Schedule’ link

2.15.1. Troubleshooting

Task scheduler will not work if the user the web server runs as doesn't have the permission to use it. To find out if the right user has the permissions necessary,
check /etc/at.allow to see what users are in it. If you don't have that file, check etc/at.deny. If at.deny exists but is blank, then every user can use it. Talk to your
system admin about adding the user to the right place to make the task scheduler work.

2.16. Notices

Get there: More > Tools > Patrons and Circulation > Notices

All notices sent by Koha can be customized using the Notices Tool. The system comes with several predefined templates that will appear when you first visit the
Notices Tool

Each notice can be edited, but only a few can be deleted, this is to prevent system errors should a message try to send without a template.

2.16.1. Adding Notices

To add a new notice
Click 'New Notice'
Choose the module this notice is related to
The Code is limited to 20 characters
Use the name field to expand on your Code
Message Subject is what will appear in the subject line of the email

In the message body feel free to type whatever message you feel is best, use the fields on the left hand side to enter individualized data from the from
database.

On overdue notices make sure to use <<items.content>> to print out the data related to all items that are overdue. The other option is to use the
<item></item> tags to span the line so that it will print out multiple lines
Only the overdue notices take advantage of the <item></item> tags, all other notices referencing items need to use <<items.content>>

2.16.1.1. Notice Markup

When creating your overdue notices there are two tags in addition to the various database fields that you can use in your notices.
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These new tags only work on the overdue notices, not other circulation related notices at this time.

<item></item> which should enclose all fields from the biblio, biblioitems, and items tables.

<fine></fine> which should be enclosed by the item tag and should enclose a currency identifier per ISO 4217. If this tag is present with a proper identifier, the
fine for that item will be displayed in the proper currency format.

Note: ISO 4217 changes from time to time therefore all currencies may not be supported. If you find one that is not supported, please file a bug with the
Locale::Currency::Format author Tan D Nguyen <tnguyen at cpan doe org>.

An example of using these two tags in a notice template might be like:

The following iten(s) is/are currently overdue:

<itenp"<<biblio.title>>" by <<biblio.author>> <<itens.itentall nunber>> Barcode: <<itens.barcode>> Fine: <fine>GBP</fine></

Which, assuming two items were overdue, would result in a notice like:

The following iten(s) is/are currently overdue:

"A Short History of Western Civilization" by Harrison,

John B, 909. 09821 H2451, Barcode:
"Hi story of Western Civilization" by Hayes,

08030003 Fine: £3.50
Carlton Joseph Huntley, 909.09821 H3261 v. 1,

Bar code: 08030004 Fine: £3.50

2.16.2. Existing Notices

Among the default notices are notices for several common actions within Koha, here are some of what those notices do

ACCTDETAILS

Sent to patrons when their account is set up if the AutoEmailOPACUser preference is set to 'Send'
ACQCLAIM (Acquisition Claim)
Used in the claim acquisition module

Get there: More > Acquisitions > Late issues

HOLD (Hold Available for Pickup)
This notice is used if two criteria are met:

The EnhancedMessagingPreferences is set to 'Allow'

The patron has requested to receive this notice
Get there: OPAC > Login > my messaging

Get there: Staff Client > Patron Record > Messaging

HOLDPLACED (a notice to the library staff that a hold has been placed)

This notice requires the emailLibrarianWhenHoldIsPlaced system preference to be set to 'Enable’

HOLD_PRINT (Printed notice when hold available for pickup)
This notice is used for hold confirmation notices that are sent out in print format. This will not effect what the email notice looks like.
ODUE (Overdue Notice)

This notice is used to send Overdue Notices to Patrons

See a Sample Overdue Notice

Requires that you set Overdue Notice/Status Triggers
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RLIST (Routing List)
Used in the serials module to notify patrons/staff of new issues of a serial

Get there: More > Serials > New Subscription

You have the option to select the 'Routing List' notice when creating a new subscription (Choose from the 'Patron notification' drop down).

Notice also that if you'd like to notify patrons of new serial issues, you can click on 'define a notice' which will take you to the 'Notices' tool

2.17. Overdue Notice/Status Triggers

Get there: More > Tools > Patrons and Circulation > Overdue Notice/Status Triggers

In order to send the overdue notices that you defined using the Notices tool, you need to first set the triggers to have these messages.

In order to have overdue notices sent to your patrons, you need to set that patron category to require overdue notices.

The Overdue Notice/Status Triggers tool gives the librarian the power to send up to three notices to each patron type notifying them of overdue items
Delay is the number of days after an issue is due before an action is triggered.
If you want Koha to trigger an action (send a letter or debar member), a delay value is required.
To send additional notices, click on the tabs for 'Second' and 'Third' notice

If you would like to prevent a patron from checking items out because of their overdue items, check the 'Debar' box, this will put a notice on the patron's record
at checkout informing the librarian that the patron cannot check out due to overdue items.

See a Sample Overdue Notice

2.18. Log Viewer

Get there: More > Tools > Additional Tools > Log Viewer

Actions within the Koha system are tracked in log files. Your system preferences can be changed to prevent the logging of different actions. These logs can be
viewed using the Log Viewer Tool.

Choosing different combinations of menu options will produce the log file for that query.

You will note that real names do not appear on the log, only identifying numbers. You need to use the identifying numbers when searching the logs as well.

2.19. Inventory/Stocktaking

Get there: More > Tools > Catalog > Inventory/Stocktaking

Koha's Inventory Tool can be used in one of two ways, the first is by printing out a shelf list that you can then mark items off on, or by uploading a text files of
barcodes gathered by a portable scanner.

If you do not have the ability to use your barcode scanner on the floor of the library, the first option available to you is to generate a shelf list based on criteria you
enter.

Choose which library, shelving location, call number range, item status and when the item was last seen to generate a shelf list that you can then print to use
while walking around the library checking your collection

Alternatively you can export the list to a CSV file for altering in an application on your desktop. Simply check the box next to 'Export to csv file' to generate this file.

Once you have found the items on your shelves you can return to this list and check off the items you found to have the system update the last seen date to
today.

If you have a portable scanner (or a laptop and USB scanner) you can walk through the library with the scanner in hand and scan barcodes as you come across
them. Once finished you can then upload the text file generated by the scanner to Koha
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Choose the text file and the date you want to mark all times as seen and click 'Submit.’

2.20. Batch item modification

Get there: More > Tools > Catalog > Batch item modification

This tool will allow you to modify a batch of item records in Koha.

From the tool you can choose to upload a file of barcodes or item ids, or you can scan items one by one into the box below the upload tool. Once you have your
file uploaded or the barcodes listed you can click 'Continue.'

You will be presented with a summary of the items you want to modify. From here you can uncheck the items you don't want to modify before making changes in
the form below. You can also hide columns you don't need to see to prevent having to scroll from left to right to see the entire item form.

Once you have made you changes you will be presented with the resulting items.

2.21. Batch item deletion

Get there: More > Tools > Catalog > Batch item deletion

This tool will allow you to delete a batch of item records from Koha.

From the tool you can choose to upload a file of barcodes or item ids, or you can scan items one by one into the box below the upload tool. Once you have your
file uploaded or the barcodes listed you can click 'Continue.’

You will be presented with a confirmation screen. From here you can uncheck the items you don't want to delete before clicking 'Go." If the items are checked out
you will be presented with an error after clicking 'Go' and the items will not be deleted.

If the items can be deleted they will be and you will be presented with a confirmation of your deletion.

Chapter 3. Patrons

Before importing and/or adding patrons be sure to set up your patron categories.

3.1. Add a new patron

Patrons are added by going to the 'Patrons' module.
Click 'New'
First enter the identifying information regarding your patron

Required fields are defined in the BorrowerMandatoryField system preference

Salutation is populated by the BorrowersTitles system preference

Next enter the contact information
If this patron is a child, you will be asked to attach the child patron to an adult patron
Click 'Set to Patron' to search your system for an existing patron
If the Guarantor is not in the system, you can enter the first and last name in the fields available

The relationships are set using the borrowerRelationship system preference

If this patron is a professional, you will be asked to attach the patron to an organizational patron

Click 'Set to Patron to search your system for an existing patron

Each patron can have an alternate contact
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An alternate contact could be a parent or guardian. It can also be used in academic settings to store the patron's home address.

The library management section includes values that are used within the library
The card number field is automatically calculated if you have the autoMemberNum system preference set that way

For a newly installed system this preference will start at 1 and increment by 1 each time after. To have it start with the starting number of your
barcodes, enter the first barcode by hand in the patron record and save the patron. After that the field will increment that number by 1.

If you accidentally chose the wrong patron category at the beginning you can fix that here

Sort 1 and 2 are used for statistical purposes within your library

Next, the Library Setup section includes additional library settings
The registration date will automatically be filled in with today's date

If your patron cards expire (based on your patron category settings) the Expiry date will automatically be calculated

The OPAC Note is a note for the patron - it will appear in the OPAC on the patron's record
The Circulation Note is meant solely for your library staff and will appear when the circulation staff goes to check an item out to the patron

The OPAC Login and Password are used by the patron to log into their account in the OPAC. They are also used for staff accounts to provide them access
to the staff client.

If you have set additional patron attributes up, these will appear next

Finally, if you have EnhancedMessagingPreferences set to ‘allow," you can choose the messaging preferences for this patron.

These preferences will override any you set via the patron categories

These preference can be altered by the patron via the OPAC

Once finished, click 'Save'

If the system suspects this patron is a duplicate of another it will warn you.

3.2. Add a Staff Patron

All staff members must be entered into Koha as patrons of the 'Staff' type. Follow the steps in Add a Patron to add a staff member. To give the staff member
permissions to access the staff client, follow the steps in Patron Permissions

Remember to assign your staff secure usernames and passwords since these will be used to log into the staff client.

3.3. Add a Statistical Patron

To track in house use of items you will need a patron of the Statistical type. First you will need a patron category set up for your Statistical patron.
Next, you will need to create a new patron of the statistical type

Next, follow the steps put forth in the 'Add a new Patron' section of this manual. Since this patron is not a real person, simply fill in the required fields, the correct
library and nothing else.

3.4. Editing Patrons

Patrons in Koha can be edited using one of many edit buttons.
To edit the entire patron record simply click the 'Edit' button at the top of the patron record.
To only change the patron's password, click the '‘Change Password' button

Patron passwords are encrypted and cannot be recovered by the library staff
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This form will automatically generate a random password, this password is not the patron's current password, just a new random password

To edit a specific section of the patron record (for example the Library Use section) click the 'Edit' link below the section
A patron image can be added by browsing for the image on your machine from the 'Manage Patron Image' section
This form will not appear if you have the patronimages system preference to allow patron images

To add patron images in bulk, use the Upload Patron Images Tool

Patrons can also be blocked from checking items out by setting Patron Flags
If you would like your circulation staff to confirm a patron's address before checking items out to the patron, you can see the 'Gone no Address' flag
If you would like to bar a patron from the library you can set the 'Debarred’ flag

This flag can automatically be set with the Overdue/Notice Status Triggers

If the patron reports that they have lost their card you can set the ‘'Lost Card' flag to prevent someone else from using that card to check items out

3.5. Patron Permissions

Patron Permissions are used to allow staff members access to the staff client.

In order for a staff member to log into the staff interface they must have (at the very least) ‘catalogue’ permissions which allow them to view the staff
interface.

3.5.1. Setting Patron Permissions

To set patron permissions, you must first have a patron of the 'Staff' type open

On the patron record click More and choose Set Permissions to alter patron permissions

You will be presented with a list of preferences, some of which can be expanded by clicking the plus sign to the left of the section title.

3.5.2. Patron Permissions Defined

superlibrarian

Access to all functions within the staff client

circulate
Ability to check (issue) books out and in and access the 'Circulation’ page in the staff client

This section can be expanded (Learn more)

catalogue
Allows staff members to search the catalog via the staff client

Must be given to all staff members to allow them to login to the staff client

parameters

Provides access to all areas of the Administration menu

borrowers

Allows staff members to add or modify patrons (with the exception of setting permissions)
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permissions

Ability to set patron permissions

reserveforothers
Ability to place holds on books for patrons via the staff interface

This section can be expanded (Learn more)

borrow

Grants staff members the rights to borrow books from the library

editcatalogue
Ability to catalog items (add and edit bibliographic and holdings data)

This section can be expanded (Learn more)

updatecharges

Manage patron accounts (including paying fines, adding credits, and creating invoices)

acquisition
Provides access to the acquisitions and patron purchase suggestion modules

This section can be expanded (Learn more)

management

No longer in use

tools
Access to all items in the Tools section of the staff client

This section can be expanded (Learn more)

editauthorities

Provides access to edit the authority record

serials
Allows access to the serials module

This section can be expanded (Learn more)

reports
Allow access to the Reports module (ability to create, edit and run all reports)
Reports found on the Circulation page are not controlled by this permission

This section can be expanded (Learn more)

staffaccess

Provides the ability to modify login / permissions for staff users
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3.5.2.1. Granular Circulate Permissions

If the staff member has ‘circulate’ permissions they have the ability to perform all of these actions. If you would like to control circulation permissions on a more
granular level choose from these options:

circulate_remaining_permissions

All circulation rights except override permissions

override_renewals

Override blocked renewals

3.5.2.2. Granular Holds Permissions

If the staff member has 'reserveforothers' permissions they have the ability to perform all of these actions. If you would like to control holds permissions on a more
granular level choose from these options:

modify_holds_priority

Allow staff members to alter the holds priority (moving patrons up and down the queue)

place_holds

All staff members to place holds for patrons via the staff interface

3.5.2.3. Granular Cataloging Permissions

If the staff member has 'editcatalogue’ permissions they have the ability to perform all of these actions. If you would like to control cataloging permissions on a
more granular level choose from these options:

edit_catalogue

Ability to access all cataloging functions via the Cataloging page

edit_items

Ability to make edits to item records, but not bib records

fast_cataloging

The ability to catalog using only the Fast Add Framework found on the Circulation page

3.5.2.4. Granular Acquisitions Permissions

If the staff member has ‘acquisition' permissions they have the ability to perform all of these actions. If you would like to control acquisitions permissions on a
more granular level choose from these options:

budget_add_del

Ability to add and delete budgets (not modify()

budget_manage

Manage budgets

budget_modify

Ability to edit existing budgets (not to add or delete)

contracts_manage
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Manage contracts

group_manage

Manage orders and basket groups

order_manage

Manage orders and baskets

order_receive

Manage orders and baskets

period_manage

Manage periods

planning_manage

Manage budget planning

vendors_manage

Manage vendors

3.5.2.5. Granular Serials Permissions

If the staff member has 'serials' permissions they have the ability to perform all of these actions. If you would like to control serials permissions on a more granular
level choose from these options:

check_expiration

Check the expiration of a serial

claim_serials

Claim missing serials

create_subscription

Create a new subscription

delete_subscription

Delete an existing subscription

edit_subscription

Edit (but not delete or create) an existing subscription

receive_serials

Receive serials on existing subscriptions

renew_subscription

Renew an existing subscription

routing
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Manage routing lists

3.5.2.6. Granular Tools Permissions

If the staff member has 'tools' permissions they have the ability to access and use all items under the Tools menu. If you would like to control which tools staff
members have access to on a more granular level choose from these options:

batch_upload_patron_images

Upload patron images in batch or one at a time (Access to the Image Upload Tool)

delete_anonymize_patrons

Delete old borrowers and anonymize circulation/reading history (Access to the Anonymize Patron Tool)

edit_calendar

Define days when the library is closed (Access to the Calendar/Holidays Tool)

edit_news

Write news for the OPAC and staff interfaces (Access to the News Tool)

edit_notice_status_triggers

Set notice/status triggers for overdue items (Access to the Overdue Notice Status/Triggers Tool)

edit_notices

Define notices (Access to the Notices Tool)

export_catalog

Export bibliographic and holdings data (Access to the Export Bibliographic & Holdings Data Tool)

import_patrons

Import patron data (Access to the Import Patrons Tool)

inventory

Perform inventory (stocktaking) of your catalog (Access to the Inventory Tool)

items_batchdel

Perform batch deletion of items (Access to the Delete a queryset of items Tool)

items_batchmod

Perform batch modification of items (Access to the Modify a queryset of items Tool)

label_creator

Create printable labels and barcodes from catalog and patron data (Access to the Label Creator and Quick Label Creator Tools)

manage_csv_profiles

Create and edit CSV profiles (Access to the CSV Profiles Tool)

manage_staged_marc
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Managed staged MARC records, including completing and reversing imports (Access to the Manage Staged MARC Records Tool)

moderate_comments

Moderate patron comments (Access to the Comments and Tags Tools)

schedule_tasks

Schedule tasks to run (Access to the Task Scheduler Tool)

stage_marc_import

Stage MARC records into the reservoir (Access to the Stage MARC Records Tool)

view_system_logs

Browse the system logs (Access to the Log Viewer Tool)

3.5.2.7. Granular Reports Permissions

If the staff member has ‘reports' permissions they have the ability to perform all of these actions. If you would like to control reports permissions on a more
granular level choose from these options:

create_reports

The ability to create and edit but not run SQL reports

execute_reports

The ability to run but not create or edit SQL reports

3.6. Patron Information

When viewing a patron record you have the option to view information from one of many tabs found on the left hand side of the record.

3.6.1. Check Out

For instruction on checking items out, view the Checking Out section of this manual.

3.6.2. Details
All patron information will appear on the Details tab. This includes all the contact information, notes, messaging preferences, etc entered when adding the patron.
In the case of patrons who are marked as 'Child' or 'Professional’ and their Guarantors additional information will appear on their record.

A child patron will list their Guarantor

On the Guarantor's record, all children and/or professionals will be listed

3.6.3. Fines

The patron's complete accounting history will appear on the Fines tab. Contrary to its name, the Fines tab does not just show fine data, it also shows membership
fees, rental fees, reserve fees and any other charge you may have for patrons.

3.6.3.1. Charging Fines/Fees

Most fees and fines will be charged automatically if the fines cron job is running:

Fines will be charged based on your Circulation & Fines Rules
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Hold fees will be charged based on the rules you set in the Patron Types & Categories administration area

Rental fees will be charged based on the settings in your Item Types administration area

Marking an item 'Lost' via the cataloging module will automatically charge the patron the replacement cost for that item

3.6.3.2. Pay/Reverse Fines

Each line item can be paid in full (or written off) using the 'Pay Fines' tab.
Choose the payment type (Unpaid, Paid, Writeoff) from the pull down menu
Click 'Make Payment'
A line item will be added to the account information showing the fee paid in full (or written off)
If you accidentally mark and item as paid, you can reverse that line item by clicking 'Reverse' to the right of the line

Once clicked a new line item will be added to the account, showing the payment as reversed

3.6.3.3. Creating Manual Invoices

For fees that are not automatically charged, librarians can create a manual invoice
First choose the type of invoice you would like to create

To add additional values to the manual invoice type pull down menu, add them to the MANUAL INV Authorized Value

If the fee is associated with an item you can enter its barcode so that the line item shows a link to that item
The description field is where you will enter the description of the charge

In the amount field, do not enter currency symbols, only numbers and decimals

3.6.3.4. Creating Manual Credits

Manual credits can be used to pay off parts of fines, or to forgive a fine amount.
First choose the type of credit you'd like to apply
If this credit is associated with an item you can enter that item's barcode so that the line item links to the right item
The description field is where you will enter the description of the credit

In the amount field, do not enter currency symbols, only numbers and decimals

3.6.3.5. Printing Invoices

To the right of each account line there is a print link. Clicking that link will print an invoice for the line item that includes the date and description of the line item
along with the total outstanding on the account.

3.6.4. Circulation History

The circulation history tab will appear if you have set the intranetreadinghistory preference to allow it to appear. If you have the OPACPrivacy system preference
set to 'Allow' and the patron has decided that the library cannot keep this information this tab will only show currently checked out items.

3.6.5. Modification Log

If you have set your BorrowersLog to track changes to patron records, then this tab will appear. The Modification Log will show all changes made to the patron
record.

The Librarian field shows the patron number for the librarian who made the changes
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The Object field lists the patron that is being modified (in the example above, it was my changing my own record)

3.6.6. Messaging

The patron's messaging preferences are set when adding or editing the patron. This tab will show the messages that have been sent and those that are queued
to be sent:

3.6.7. Notices

The patron's messaging preferences are set when adding or editing the patron. This tab will show the messages that have been sent and those that are queued
to be sent with their entire body content:

3.7. Patron Search

Clicking on the link to the Patron module will bring you to a search/browse screen for patrons. From here you can search for a patron by entering any part of their
name or barcode in the search box at the top.

If you want to search for more than just a part of a patron name or number, you can click the plus sign [+] to the right of the search box.

You can also browse through the patron records by clicking on the linked letters across the top.

Chapter 4. Circulation

Circulation functions can be accessed in several different ways. On the main page of the staff client there are some quick links in the center of the page to check
items out, in or transfer them. For a complete listing of Circulation functions you can visit the Circulation page which is linked from the top left of every page or
from the center of the main page.

Before circulating your collection you will want to set your Global System Preferences, Basic Parameters and Patrons & Circulation Rules.

While in Circulation you can jump between the tabs on the quick search box at the top of the screen by using the following hot keys:
jump to the catalog search with Alt+Q
jump to the checkout with Alt+U

this will not work for Mac user

jump to the checkin with Alt+R

Mac users use the OPTION button in place of ALT

4.1. Check Out (Issuing)

To begin the checkout process you must enter the patron barcode or part of their name. The checkout option appears in three main places:
Check out option on main staff client
Check out option on the patron record

Check out option on the quick search bar

4.1.1. Checking Items Out

To check an item out to a patron, first search for that patron using one of the many options listed above.
At the top of the Check Out screen is a box for you to type or scan the item's barcode into.
Many modern barcode scanners will send a 'return’ to the browser, making it so that the '‘Check Out' button is automatically clicked

Below the box for the barcode there may be options for you to override the default due date for the item.
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This option will only appear if you have set the SpecifyDueDate system preference to allow staff to override the due date

At the bottom of the page there is a summary of the patron's current checked out items along with the due date, items checked out today will appear at the top.
This screen will show whether an item is renewable and if not, why not.

To override the renewal limits you can set the AllowRenewalLimitOverride system preference to allow overrides and a checkbox will appear below the list of
checkouts that reads 'Override Renewal Limit'

Checking that box will add checkboxes in the renew column above where before the item was not renewable.

Also at the bottom of the page is the list of items the patron has on hold

Once you have checked out all of the items for the patron you can print them a receipt by clicking the Print button at the top of the screen and choosing 'Print Slip'
or 'Quick Slip'.

If you choose 'Print Slip" it will print all of the items the patron has checked out, including those they checked out at an earlier date. Choosing 'Quick Slip* will print
only the items that were checked out today.

If there are notes on the patron record these will appear to the right of the checkout box

If the patron has a hold waiting at the library that too will appear to the right of the check out box making it easy for the circulation librarian to see that there is
another item to give the patron

4.1.2. Check Out Messages

There are times when Koha will prevent the librarian from being able to check out items to a patron. When this happens a warning will appear notifying the
librarian of why the patron cannot check items out.

Patron owes too much in fines

You can set the amount at which patron checkouts are blocked with the noissuescharge system preference

Patron has been barred from the library

This can be set by the librarian editing a patron record and adding a flag or by the Overdue/Notice Status Triggers

Patron needs to confirm their address

This can be set by the librarian editing a patron record and adding a flag

Patrons has lost their library card

This can be set by the librarian editing a patron record and adding a flag

4.1.3. Check Out Warnings

Sometimes checkouts will trigger warning messages that will appear in a yellow box above the check out field. These warnings need to be acknowledged before
you will be able to continue checking items out.

Patron has outstanding fines

Item on hold for someone else

Item should be on the hold shelf waiting for someone else
Item already checked out to this patron

Item checked out to another patron

Item not for loan

Patron has too many things checked out
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Item cannot be renewed

This can be overridden with the AllowRenewalLimitOverride system preference

Barcode not found

4.2. Check In (Returning)

Checking in items can be performed from various different locations
The check in link on main staff client
The check in option on the quick search bar on the Circulation page

The check in link on the patron's checkout summary (and on the checkout summary page)

4.2.1. Checking ltems In

To check an item in scan the barcode for the item into the box provided. A summary of all items checked in will appear below the checkin box

If you are checking items in that were put in the dropbox while the library was closed you can check the 'Dropbox mode' box before scanning items. This will
effectively roll back the returned date to the last date the library was open.

This requires that you have your closings added to the Holidays & Calendar Tool

You can also choose to forgive all overdue charges for items you are checking in by checking the 'Forgive overdue charges' box before scanning items.

4.2.2. Check In Messages

There are several messages that can appear when checking items in:
If you are checking an item in at a library other than the home branch, a message will appear asking you to transfer the book to the home library
After this item is checked in the status of the item will be changed in the catalog to 'in transit'
To mark an item as back at the home branch, check the item in at the home branch

A message will appear tell you that the item is not checked out, but the status will now say available in the catalog. This step is necessary to mark items
as received by the home branch.

If you're checking an item in that has a hold on it, you will be prompted to confirm the hold
Clicking the Confirm hold button will mark the item as waiting for pickup from the library

Clicking the Print Slip and Confirm button will mark the item as waiting for pickup at the library and present the library with a receipt to print and place on
the book with the patron's information

Ignoring the hold will leave the item on hold, but leave its status as Available (it will not cancel the hold)

If you're checking in an item that has a hold on it at another branch you will be prompted to confirm and transfer the item
Clicking the Confirm hold and Transfer button will mark the item as in transit to the library where the hold was placed

Clicking the Print Slip, Transfer and Confirm button will mark the item as in transit to the library where the hold was placed and present the library with a
receipt to print and place on the book with the patron's information

Ignoring the hold will leave the item on hold, but leave its status as Available (it will not cancel the hold)

4.3. Circulation Messages

Circulation messages are short messages that librarians can leave for their patrons or their colleagues that will appear at the time of circulation.
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4.3.1. Setting up Messages

Circulation messages are set up as Authorized Values. To add or edit Circulation Messages you want to work with the BOR_NOTES value.

4.3.2. Adding a Message

When on the patron's check out tab you will see a link to 'Add a new message' to the right of the check out box.

When you click 'Add a new message' you will be asked to choose if the message is for the librarians or the patron and the message you would like to leave.

4.3.3. Viewing Messages

Circulation messages meant for the staff will appear on the patron's checkout screen.

Circulation messages meant for the patron will appear when they log into the OPAC.

4.4. Holds

4.4.1. Placing Holds in Staff Client

There are several ways to place holds from the staff client. The most obvious is using the 'Place Hold' button at the top of any bibliographic record.
You can also click the smaller 'Place Hold' link found at the top of your catalog search results, or the 'Holds' link found below each result.
You will be asked to search for a patron by barcode or any part of their name to start the hold process.

Depending on how many items you choose to place a hold on at once you will be see a different place hold form. If you are placing a hold on one bibliographic
record you will see a list of all of the items you can place a hold on.

Enter any notes that might apply to this hold
Choose the library where the patron will pick up the item
If the patron wants the hold to start on a date other than today, enter that in the 'Hold starts on date' field

This option will only appear if the AllowHoldDatelnFuture system preference is set to 'Allow'

If the patron has specified that they don't want the item after a certain date, or if you have limits on hold lengths, you can enter an expiration date for the hold
in the 'Hold expires on date'

To have expired holds canceled automatically you will need to have the Expired Holds cron job set to run on a regular basis.

Next choose if you want to place a hold on the next available item or a specific item by clicking the radio button next to an individual item.

If you're placing a hold on multiple items you will be presented with the next available option for all titles. If no items are available for hold it will say so on the
confirmation screen.

4.4.2. Managing Holds

Holds can be altered and canceled from the Holds tab found on the left of the bibliographic record.
From the list of holds you can change the order of the holds, the pickup location and/or cancel the hold.

Depending on how you have your HidePatronName system preference set the list may show patron names instead of card numbers in the Patron column
like in the image above.

To rearrange or delete holds, simply make a selection from the 'Priority' pull down or click the arrows to the right of the priority pull down.
To delete or cancel a hold, choose 'del’ from the menu or click the red 'X' to the right of the hold line.

Clicking the down arrow to the right of the hold will stick the hold at the bottom of the list even if more requests are made.
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For example, your library has home-bound patrons that are allowed to keep books out for months at a time. It would not be fair to other patrons if a home-bound
patron were able to check out a brand new book and keep it for months. For this reason, the home-bound patron's hold request would stay at the bottom of the
queue until everyone else who wanted to read that book has already done so.

Once you have made your changes, click the 'Update hold(s)' button and your changes will be saved.

4.4.3. Receiving Holds

When items that are on hold are checked in or out the system will remind the circulation librarian that the item is on hold and offer them options for managing the
hold.

When you check in an item that has a hold on it the system will ask you to either confirm and transfer the item
or just confirm the hold

Clicking the Confirm button will mark the item as on hold for the patron. If the item needs to be transferred the item will also be marked as in transit to the proper
branch. Clicking 'Ignore’ will retain the hold, but allow you to check the item out to another patron. Choosing to confirm and print will present you with a printable
page that you can slip inside the book with the necessary hold and/or transfer information.

Once confirmed the hold will show on the patron record and on the checkout screen under the 'Hold' tab.
The item record will also show that the item is on hold.

In some cases a patron may come in to pick up a hold for their partner (or someone else in their household). In this case you want to make sure that the hold is
cancelled when you check the item out to someone else. When trying to check out an item that is already waiting for someone else you will be presented with a
warning message.

From here you can check the item out to the patron at the desk and cancel the hold for the partner.

4.5. Transfers

If you work in a multi-branch system you can transfer items from one library to another by using the Transfer tool. To transfer an item
Click 'Transfer' on the Circulation page
Enter the library you would like to transfer the item to

Scan or type the barcode on the item you would like to transfer

Click 'Submit'

The item will now say that it is in transit

When the item arrives at the other branch the librarian must check the item in to acknowledge that it is no longer in transit
The item will not be permanently moved to the new library

The item shows the same 'Home Library' but has updated the 'Current Location' to note where it resides at this time

4.6. Set Library

By default you will enter the staff client as if you are at your home library. This library will appear in the top right of the Staff Client.

This is the library that all circulation transactions will take place at. If you are at another library (or on a bookmobile) you will want to set your library before you
start circulating items. To do this you can click 'Set" at the top right or on the Circulation page.

Once you have saved your changes you new library will appear in the top right.

4.7. Fast Add Cataloging

Sometimes circulation librarians need to quickly add a record to the system for an item they are about to check out. This is called 'Fast Add.' To allow circulation
librarians access to the Fast Add Cataloging tool, simply make sure they have the fast cataloging permissions. To add a title with the fast add framework, click
the Fast Cataloging option on the Circulation page
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The cataloging interface will open up with the short cataloging record:

After adding your cataloging data you will be asked to enter item data. Enter the items barcode, collection code, etc and save the item before checking it out.

4.8. Circulation Reports

4.8.1. Holds Queue

This report will show you all of the holds at your library. To generate this report, you must have the Build Holds Queue cron job running.

4.8.2. Holds to pull
This report will show you all of the items that have holds on them that are available at the library for pulling.
This report will be generated based on a few system preferences:

StaticHoldsQueueWeight

Allows the library to specify a list of library location codes -- if used alone, it will rank the list statically, selecting the top-ranking available location to be
added to the picklist.

RandomizeHoldsQueueWeight

If 'RandomizeHoldsQueueWeight' and 'StaticHoldsQueueWeight' are set, the list of library codes in the 'StaticHoldsQueueWeight' system preference are
randomized rather than statically ranked. If RandomizeHoldsQueueWeight alone is set, the list of all available library codes is used to randomize the
weight.

If neither 'RandomizeHoldsQueueWeight' or 'StaticHoldsQueueWeight' is set, the holds queue is statically ranked according to how they are pulled out of the
system database.

You can limit the results you see by using the Refine box on the left side of the page:

4.8.3. Holds awaiting pickup

This report will show all of the holds that are waiting for patrons to pick them up.

4.8.4. Hold ratios

Hold ratios help with collection development. Using this report you will be able to see how many of your patrons have holds on items and whether you should buy
more. By default it will be set to the library needing 3 items per hold that has been placed. The report will tell you how many additional items need to be
purchased to meet this quota.

4.8.5. Transfers to receive

This report will list all of the items that Koha thinks are in transit to your library.
If your transfers are late in arriving at your library you will see a message stating how late your items are.

An item is considered late based on the number of days you have entered in the TransfersMaxDaysWarning system preference.

4.8.6. Overdues

For libraries with a large patron base, this report may take a significant amount of time to run.
Large libraries can choose to filter the report before it runs by setting the FilterBeforeOverdueReport system preference to 'Require’.

This report will list all items that are overdue at your library.

The report can be filtered using the menu options found on the left of the report.

4.8.7. Overdues with fines
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4.9. Tracking Inhouse Use

Many libraries track the use of items within the library. This is possible within Koha with the use of one or more Statistical Patrons. When collecting items that
have been used within the library, you will want to check them out to your statistical patron:

Instead of marking the item as 'checked out' the system will record that the item was used in house:

Repeat these steps for all items that have been used within the library to keep accurate statistics for item use.

4.10. In Processing / Book Cart Locations

Koha allows for handling temporary locations like the processing center and/or book carts throughout the library. For this feature to work you must first make sure
you have authorized values set in the LOC category for PROC (Processing Center) and CART (Book Cart).

Next you need to set the NewltemsDefaultLocation system preference to PROC. This will set the new items to the Processing Center as their default location.

Create items with their desired final shelving location.

These newly cataloged items will be temporarily set to the PROC location and will display with whatever description PROC has. The original location code
entered at item creation is stored in the new items column 'permanent_location’, for future use. Items will stay in the PROC location until they are checked in.
To have those items then move to the shelving cart:

Turn on the InProcessingToShelvingCart system preference

Check in those newly-created items and they will be moved to the location code of CART and display with whatever description CART has.

A cron job runs at specified intervals to age items from CART to the permanent shelving location. (For example, an hourly cron entry of cart_to_shelf.pl
--hours 3 where --hours is the amount of time an item should spend on the cart before aging to its permanent location.)

If the ReturnToShelvingCart system preference is turned on, any newly-checked-in item is also automatically put into the shelving cart, to be
covered by the same script run.
Checkins with confirmed holds will not go into the shelving cart. If items on the shelving cart are checked out, the cart location will be cleared.

4.11. Self Checkout

Koha comes with a very basic self checkout module. To enable this module you need to set the WebBasedSelfCheck preference to 'Enable." To use this module
you have to log in as a staff member with circulation permissions.

Create a staff patron specifically for this action so that you don't leave a real staff client logged into a computer all day
There is no link to the Self Checkout module, but a simple addition to the intranetuserjs system preference can add one.

$(docunent).ready(function(){ $("#l ogin
#submit"). parent (). after("<p><a
href=\"http:// YOUR_KOHA OPAC_URL/ cgi - bi n/ koha/ sco/ sco-mai n. pl \"
target =\"_bl ank\ " >Sel f - Checkout </ a></p>"); });

The link will then appear at the bottom of the log in page:

You can also access this module by going to : http://YOUR_KOHA_OPAC_URL/cgi-bin/koha/sco/sco-main.pl

When on the self checkout page you will be asked to enter your patron card number:

Once your card number is entered you will be asked to scan the items you are checking out

As you scan items they will appear below the barcode box

When you are finished scanning items it is important to click the 'Click here if done' button to log the patron out and prepare for the next patron.

When attempting to check items out there are some instances where error messages will appear and the patron will be directed to the librarian. This will happen

even if you are allowing overrides on circulation functions. Only a librarian can override a circulation block and so patrons must go to the librarian for help in these
situations.

4.12. Offline Circulation Utility
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4.12.1. Firefox Plugin

There is a plugin for Firefox that can be used for Offline Circulation: https://addons.mozilla.org/en-US/firefox/addon/14399

Once installed there will be an icon for the Offline Circulation Tool in the status bar at the bottom of you Firefox Window.

Additional instructions for using this Plugin can be found on the Koha Wiki: http://wiki.koha-community.org/wiki/Offline _circulation firefox plugin

4.12.2. Offline Circ Tool for Windows

The Offline Circulation Utility can be downloaded at: http://millruntech.com/koha/koha-tools/koha-offline-circulation

4.12.3. Upload Offline Circ File

The offline circulation tool for Windows will generate a KOC file that you can upload into Koha once your system comes back up.

On the Circulation menu click 'Offline Circulation File (.koc) Uploader'
Browse your computer for the *.koc file
Once the file is uploaded, click the process the file

When this is complete you'll see the summary of actions from when you were offline (including any errors).

Chapter 5. Cataloging

Before you start cataloging in Koha you're going to want to do some basic setup. Refer to the Implementation Checklist for a full list of these things. Most

importantly you're going to want to make sure that your Frameworks are all defined the way you want. Once in the cataloging module you will not be able to add
or remove fields and subfields so your frameworks must be ready before you start cataloging.

5.1. Bibliographic Records

5.1.1. Adding Records

Records can be added to Koha via original or copy cataloging. If you would like to catalog a record using a blank template
Click 'New Record'

Choose the framework you would like to base your record off of

If you want to catalog a record based on an existing record at another library
Click 'z39.50 Search’
Search for the item you would like to catalog
If no results are found, try searching for fewer fields, not all Z39.50 targets can search all of the fields above.
Search targets can be altered by using the Z39.50 Admin area.
From the results you can view the MARC or Card view for the records or choose to Import them into Koha

In addition to the Import link to the right of each title, you can click on the title you're interested in and a menu will pop up with links to preview the
record and import it

Once you've opened a blank framework or imported a record via Z39.50 you will be presented with the form to continue cataloging
To expand a collapsed tag click on the tag number

To get help from the Library of Congress on a Marc tag click the question mark (?) to the right of each field number
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If you think this is an unwanted feature, you could add the following JavaScript to your intranetuserjs system preference:

$(docunent) . ready(function(){
$(".tagnum a"). hide();
1)

Sometimes fields may not be editable due to the value in your BiblioAddsAuthorities system preference. If you have this preference set to not allow catalogers
to type in fields controlled by authorities you may see a lock symbol to the left of the field.

If this icon appears you must click the ellipse to the right of the field to search for an existing authority.

From the results list click '‘Choose authority' to bring that into your catalog record

To duplicate a field click on the + (plus sign) to the right of the tag
To move subfields in to the right order, click the up arrow to the left of the field
To duplicate a subfield click on the clone icon (to remove a copied field, click the delete clone icon) to the right of the field

To remove a subfield (if there is more than one of the same type), click the - (minus sign) to the right of the field

To use a plugin click on the ... (ellipse) to the right of the filed

Once you've finished, click the 'Save' button at the top and choose whether you want to save and view the bib record you have created or continue on to
add/edit items attached to the record

If you are about to add a duplicate record to the system you will be warned before saving

5.1.2. Editing Records

To edit a record you can click 'Edit Biblio' from the search results on the cataloging page
or by clicking the Edit button on the Bibliographic Record
The record will open in the MARC editor

Once you have made your edits you can click 'Save' at the top of the editor.

5.1.3. Duplicating Records

Sometimes a copy of the record you need to catalog can't be found via Z39.50. In these cases you can create a duplicate of similar record and edit the necessary
pieces to create a new record. To duplicate an existing record click 'Edit as New (Duplicate)' from the Edit menu on the Bibliographic Record

This will open a new MARC record with the fields filled in with the values from the original Bibliographic Record.

5.1.4. Merging Records

If you would like to merge together multiple records you can do that via the Lists tool. Learn more here.

5.2. Item Records

5.2.1. Adding Items

After saving a new bibliographic record, you will be redirected to a blank item record so that you can attach an item to the bibliographic record. You can also click
'Add Holdings' from the cataloging search results

or you can add new item at any time by clicking 'New' on the bibliographic record and choosing ‘New Item'
The item edit form will appear:

At the very least, the following fields should be entered for new items:
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8 - Collection code

a - Permanent location

b - Shelving location

0 - Full call number

p - Barcode

v - Cost, replacement price

This value will be charged to patrons when you mark and item they have checked out as 'Lost’

y - Koha item type

Below the add form there are 3 buttons for adding the item
Add Item will add just the one item
Add & Duplicate will add the item and fill in a new form with the same values for your to alter

Add Multiple Copies will ask how many copies and will then add that number of copies adding +1 to the barcode so each barcode is unique

Your added items will appear above the add form once submitted
Your items will also appear below the bibliographic details on the bib record display.

If you have SpineLabelShowPrintOnBibDetails set to 'Display’ then there will also be a link to print a quick spine label next to each item.

5.2.2. Editing Items

Items can be edited in several ways.
Clicking 'Edit' and 'Edit Items' from the bibliographic record

Clicking 'Edit Iltems' beside the item on the 'ltems' tab

The edit menu is also where items can be deleted from:

5.2.3. Moving ltems

Items can be moved from one bibliographic record to another using the Attach Item option
Visit the bibliographic record you want to attach the item to and choose 'Attach Item' from the ‘'Edit' menu.
Simply enter the barcode for the item you want to move and click 'Select'

If you want to move all items to a new record creating only one bibliographic record you can use the Merge Records tool instead.

5.2.4. ltem Specific Circulation History

Each bibliographic record keeps a circulation history (with or without the patron information depending on your settings), but each item also has its own circulation
history page. To see this, click on the 'ltems' tab to the left of the record you are viewing.

Below the 'History' heading is a link to 'View item's checkout history," clicking that will open up the item's history which will look slightly different from the
bibliographic record's history page.

5.3. Authorities

Authority records are a way of controlling fields in your MARC records. Using authority records will provide you with control over subject headings, personal
names and places.
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5.3.1. Adding Authorities

To add a new authority record, choose the authority type from the ‘New Authority' button.

The form that appears will allow you to enter all of the necessary details regarding your authority record.

To expand collapsed values simply click on the title and the subfields will appear.

5.3.2. Searching Authorities

From the authorities page you can search for existing terms and the bibliographic records they are attached to.

From the results you will see the authority record, how many bibliographic records it is attached to, and a delete link (if there are not bibliographic records

attached).

Clicking on the authority record summary will open the full record and the option to edit the record.

5.3.3. Editing Authorities

Authorities can be edited by clicking on the authority summary from the search results and then clicking the 'Edit' button above the record.

Once you've made the necessary edits, simply click 'Save' and all of the records that use this authority record will be updated.

To delete an authority record you first must make sure it's not linked to any bibliographic records. If it is not used by any bibliographic records a 'Delete’ link will
appear to the right of the record on the search results and as a button that appears after clicking on the summary of the authority record.

5.4. Cataloging Guides

5.4.1. Bibliographic Record Cataloging Cheat Sheet

Jared Camins-EsakovAmerican Numismatic SocietyNicole C. Engard2010

Table 5-1. Cataloging Guide

Tag Tabel

Description

Instructions

000 | EADER

Describes the record(i.e. surrogate) -- is
t a record for a monograph? A serial?

Tick in this field to T it in. Then set |
'Bibliographic level" to 'a’ for articles or
s' for serials. Otherwise, leave
everything as is.

P01 ICONTROL NUMBER

IAccession number.

Nter the accession number writen
nside the item here. For articles and
tems which do not have accession
humbers, leave blank.

003 [CONTROL NUMBER IDENTIFIER

lYour MARC Organizational Code

Tick in this Tield to Tl it in (wi auto 11

you have your MARCOrgCode
preference set).

05 & I'LATEST TRANSACTION

urrent date and time.

Tick I this Tield to Tl it m.

008 FIXED-LENGTH DATA ELEMENTS

FField containing computer-readable
epresentations of a number of things.

enerally you will only Use 's' (single) or |
m' (multiple) options for position 06- use]
the former when the item was published
n a single year, the latter when it was
published over the course of several. If
there is a single date, only enter a date
n the first date field (positions 07-10).
Enter the three-digit country code in
bositions 15-17, being sure to add
kpaces if the country code is fewer than
[hree characters long. If there is an
ndex, note that fact in position 31. Enter
the three-letter language code in
positions 35-37.
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010

| CCN

A number assigned by the Library of
Congress to uniquely identify the work.

heck on the copyright page of the
book (if it was published in the US) or
the LC catalog for this number. If you
can't find it, don't worry about it.

020

SBN

NIqUe number used by publiShers to
dentify books.

TThIS number 1SNt listed on the booK,
there probably isn't one.

022

SSN

NIque nUMDET Used Dy puUbNSNETS 0
dentify serials.

TIhIS number 1SNt Isted on the DOooK,
there probably isn't one.

033

DATE/TIME OF EVENT

lUsed for auction dates. Required for
uction catalogs.

Or auctions that tooK place on only one
day, enter the date of the auction in the
format YYYYMMDD in the subfield 'a’'
nd a '0' in the first indicator. For
uctions that took place over two
consecutive days or any number of
hon-consecutive days, create a subfield
a' for each day with the date in the
format YYYYMMDD, and put a '1' in the
First indicator. For auctions that took
place over more than two consecutive
days, create a subfield 'a’ (in format
YYYYMMDD) for the first day and a
kubfield 'a' (also in format YYYYMMDD)
for the last day, and put a 2" in the first
ndicator.

040

ICATALOGING SOURCE

dentifies which libraries created and
Imodified the record.

Or Imported records, add a subtield d
ith your OCLC code as the value. For
hew records, make sure that the
kubfield ‘c' with your OCLC code as the
value.

41

| ANGUAGE CODE

dentifies all the languages used in an
tem, when two or more languages are
present.

Or significant portions of a text In a
biven language, there should be a
Bubfield 'a’ with that language code. If
there are only summaries or abstracts in|
h specific language, create a subfield 'b’
ith that language code.

100

MAIN ENTRY--PERSONAL

JAuthorized form of the main author's
hame

ee Authorized headings sheet and |
IAACR2. The first indicator should
benerally be a '1', to indicate that the
entry is surname first. If the name
consists only of a forename, however,
the first indicator should be '0'.

110

IMAIN ENTRY--CORPORATE

corporate author. Required for auction
catalogs.

IAuthorized form of the name of the main|

Auction cafalogs should use a 110 field
ather than a 100 field. See Authorized
headings sheet and AACR2. Set the
first indicator to '2'".

111

MAIN ENTRY--MEETING

Authorized form of the name of a
Imeeting which acted as a main offer
e.g. conference proceedings)

See Authorized headings sheet and
JAACR?2. Set the first indicator to '2".

P45

TITLE STATEMENT

[Transcription of the title statement from
the title page (or chief source of
nformation)

nter the ttle 1n subtield a, the subtile
n subfield 'b’, and the statement of
esponsibility in subfield 'c'. If you are
creating a record for a single volume or
part of a multi-part item, you should put
the part number in subfield 'n" and the
part title in subfield 'p.' For auction
catalogs, the date (in 'MM/DD/YYYY'
format) should be listed in square
prackets in subfield 'f'. See ISBD
punctuation sheet. Set the first indicator
fo '0" if there is no author, otherwise set
tto '1'. Set the second indicator to the
humber of non-filing characters (i.e.
characters in an initial articles plus the
Ispace... for "The " set the second

ndicator to '4").
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lternate form of title for searching and

Tihe patron might TOOK Tor the Work
under a different title, enter it here. Do
hot include initial articles. The first

catalogs.

P46 ARYING FORM OF TITLE . ) .
filing purposes ndicator should be '3', unless the title is
Imerely a variant spelling, in which case
the first indicator should be '1'".
e " ranscribe the ediion statement exactly
[Transcription of the edition statement ) )
) . s it appears on the title-page. You may
P50 EDITION STATEMENT from the title page (or chief source of . . N .
. pbbreviate if the edition statement is
nformation)
very long.
Ut the Tocation of publication in subfield
o ) a', the publisher in subfield 'b', and the
P60 PUBLICATION (IMPRINT) Publication information. . o
year (or probable year) in subfield 'c'.
ISee ISBD punctuation sheet.
nter the pagination statement in
pubfield 'a’, a brief description of
) L 'special” contents such as illustrations
300 PHYSICAL DESCRIPTION Physical description ) )
or maps in subfield 'b’ (see AACR2),
and the size of the item in subfield 'c'.
See ISBD punctuation sheet.
Tanscribe the Series statement INtO
subfield 'a’ with the volume number in
IShows the series statement exactly as itpubfield 'v'. See ISBD punctuation
490 ISERIES STATEMENT . N .
ppears on the item. Eheet. Set the first indicator to '1" if you
re using an 830. As a general rule, you
should do so.
) nier notes as full sentences, with a
00 IGENERAL NOTE otes that don't fit anywhere else. ) L .
separate 500 field for each distinct topic,|
ofes whether the work Is bound with Ut description of relationship In subfield
b01 WITH NOTE )
the works described by other records. |a'.
Tthe WOTK INnCludes a pibliography and
ndex, put the text "Includes
bibliographical references (p. XXX-XXX)
. ) nd index." in subfield 'a". If the work
ndicates whether the work includes a ) )
b04 BIBLIOGRAPHY, ETC. NOTE bibli h does not include an index, remove that
ibliography.
grapny part of the sentence. If the references
bre scattered throughout the work and
hot gathered into a distinct sentence,
Femove the parenthetical statement.
€€ [SBD punctuation sheet. Set the
List of contents in a standard format. first indicator to '0'". If you are separately
b05 FORMATTED CONTENTS lUnformatted contents can be listed in a coding authors and titles, set the second
b00 (General Note) field. ndicator to '0". Otherwise, leave the
second indicator blank.
Or auction catalogs, enter the date of
18 DATE/TIME OF EVENT NOTE Used for auction dates. the auction in the format 'January 2,
[1984' in the subfield 'a’
N general you do not need to Write a
summary. A summary might be called
A brief summary or abstract of the book for, however, with items that cannot be
520 SUMMARY, ETC. } . )
or article. asily reviewed by a patron, such as
pbooks with highly acidic paper or
[CD-ROMs.
. ) nly needed for works in muriple
Note describing the languages used in ]
b46 L ANGUAGE NOTE anguages. See ISBD punctuation
the work
Bheet.
E€SCriDes the previous ownersnip of ihe
b61 PROVENANCE INFORMATION ) Used only for rare books.
em.
63 INDING INFORMATION escribes the blndTng of the item. sed only for rare DOOKS.
) ) Sed for auction catalogs to Indicate
|ocal notes. Required for auction . .
590 | OCAL NOTE hat types of coins are sold in the

huction- Roman, Greek, etc.
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600

ISUBJECT ADDED--PERSONAL

IAuthorized form of personal names for
people discussed in the work

€€ Authorized headings sheet and
CR2. The first indicator should
enerally be a '1', to indicate that the
ntry is surname first. If the name
onsists only of a forename, however,
he first indicator should be '0'. If you
ound the name in the LC authority file,
et the second indicator to '0". Otherwise]
ket the second indicator to '4'.

610

[SUBJECT ADDED--CORPORATE

[Authorized form of corporate names for
brganizations discussed in the work

ee Authorized headings sheet and
INACR2. Set the first indicator to '2'. If
you found the name in the LC authority
file, set the second indicator to '0'.
Otherwise set the second indicator to '4')

611

ISUBJECT ADDED--MEETING

JAuthorized form of meeting names for
Imeetings discussed in the work

€€ Authorized headings sheet and |
IAACR2. Set the first indicator to '2'. If
ou found the name in the LC authority
file, set the second indicator to '0'".
Otherwise set the second indicator to '4')

630

ISUBJECT ADDED--UNIFORM TITLE

IAuthorized form of titles for other works
discussed in the work

Bpace... for "The " set the first indicator

ee Authorized headings sheet and |
IAACR?2. Set the first indicator to the
humber of non-filing characters (i.e.
characters in an initial articles plus the

fo '4"). If you found the name in the LC

uthority file, set the second indicator to
0'. Otherwise set the second indicator tg
4,

650

ISUBJECT ADDED--TOPICAL

Library of Congress Subject Heading
ferms describing the subject of the work

ee Authorized headings sheet and |
IAACR2. If you found the name in the LC|
uthority file, set the second indicator to
0'. Otherwise set the second indicator to
4,

651

ISUBJECT ADDED--GEOGRAPHICAL

|ibrary of Congress Subject Heading
peographical terms describing the
subject of the work

ee Authorized headings sheet and

IAACR2. If you found the name in the LC|
uthority file, set the second indicator to
0'. Otherwise set the second indicator to
4.

655

NDEX TERM--GENRE/FORM

hat the item is about.

Describes what an item is as opposed tofound the name in the LC authority file,

enerally used only for auction
catalogs, which should have the genre
heading "Auction catalogs.” (make sure
fo find the authorized heading!) If you

ket the second indicator to '0". If you are
Lising a term from a specific thesaurus,
ket the second indicator to '7' and put
the code for the thesaurus in subfield '2',
Otherwise set the second indicator to '4')

690

| OCAL SUBJECT ADDED--TOPICAL

JUsed for headings from any custom
subject authority file.

TIhere IS no appropriate LCSH term,
you can use a 690 with subject
headings you find on other items in the
catalog.

691

| OCAL SUBJECT
IADDED--GEOGRAPHICAL

Used for headings from any custom
subject authority file.

TIhere Is no appropriate LCSH term,
you can use a 691 with subject
headings you find on other items in the
catalog.

700

IADDED ENTRY--PERSONAL

Used for second authors and other
persons related to the production of the
ork.

€€ Authorized headings sheet and |
IAACR2. The first indicator should
penerally be a '1', to indicate that the
entry is surname first. If the name
consists only of a forename, however,
the first indicator should be '0'.

710

IADDED ENTRY--CORPORATE

Sed for corporate bodies related to the
production of the work (e.g. publishers).

€€ Authorized headings sheet and
IAACR2. Set the first indicator to '2'.
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711

IADDED ENTRY--MEETING

Sed for meetings refated 1o the
production of the work (e.g. symposia
that contributed to the work).

See Authorized headings sheet and
JAACR?2. Set the first indicator to '2".

730

IADDED ENTRY--UNIFORM TITLE

lUsed for uniform titles related to the
production of the work (e.g. a work that
nspired the present work)

ee Authorized headings sheet and |
IAACR?2. Set the first indicator to the
humber of non-filing characters (i.e.
characters in an initial articles plus the
Epace... for "The " set the first indicator
fo '4").

773

HOST ITEM ENTRY

Describes the larger bibliographic unit
that contains the work (e.g. book or
ournal containing the article being
described in the current record)

T the host publication Is author main
entry, enter the authorized form of the
puthor's name in subfield 'a’. Put the title|
n subfield 't'. If the host publication is an
ndependent work, put publication
nformation in subfield 'd". When
vailable, ISSN and ISBN should alway9
be used in, in subfields 'x' and 'z
espectively. Relationship information
e.g. volume number, page number,
etc.) goes in subfield 'g'. Subfield 'g'
contains an encoded representation of
the location of the item: volume, issue,
nd section numbers are separated by
colons, and the first page is entered
following a '<' at the end of the subfield.
See ISBD punctuation sheet. Set the
first indicator to '0". If you want the label
'In:" to be generated, leave the second
ndicator blank. If you want something
else displayed before the 773 text, set
the second indicator to '8' and add a
pubfield 'i" with the label you want at the
beginning of the field (e.g. "$iOffprint
from:").

B30

SERIES ENTRY--UNIFORM TITLE

IAuthorized form of the series name
franscribed in the 490 field. Often this
ill just be the same as the 490.

€e Authorized headings sheet and
IMACR?2. Set the second indicator to the
humber of non-filing characters (i.e.
characters in an initial articles plus the
kpace... for "The " set the second
ndicator to '4").

852

| OCATION/CALL NUMBER

Provides the section name for
pre-barcode books, pamphlets, and
ksome articles and serials.

0 N0t put anything I this Tiefd i you
re cataloging a volume which gets only
one record and a barcode. If the item
Hoes not get a barcode, or you are
currently creating a record for an article
n a volume, put the section in subfield
a' (see ANS cataloging documentation),
and the call number in subfield i'. Set
the first indicator to '8'.

B56

ELECTRONIC ACCESS

Links to material available online.

ut the URL of any electronic copies or
summaries, etc. in subfield 'u’ and a link
fitle in subfield 'y". Set the first indicator

fo '4".

P42

IADDED ENTRY ELEMENTS (KOHA) |sed for Koha-specific data.

€t the subfield C 10 the appropriate
tem type.

5.4.2. ltem/Holdings Record Cataloging Guide

This table represents the default embedded holdings data in Koha 3.4. This information can be used for migration or importing data purposes

Table 5-2. Koha Embedded Holdings Data

MARCZI Tag/subtield

Data Element

Description

Notes
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efault values:

[Coded value, matching Authorized

052$0 Withdrawn status 0 = Not withdrawn alue category (WITHDRAWN' in
default installation)
1 = Withdrawn
efault values:
0 = Available ) )
t's possible to configure OPAC so that
1 = Lost ost items don't display with the
hidelostitems system preference.
D52%$1 |_ost status 2 = Long Overdue (Lost)
Coded value, matching Authorized
3 = Lost and Paid For alue category (LOST' in default
L nstallation)
4 = Missing in Inventory
5 = Missing in Hold Queue
T no classification scheme IS entered,
L Classification scheme that defines filing the system will use the value entered in
052$2 Classification ) o
ules used for sorting call numbers. the DefaultClassificationSource
preference.
Opy/volUme data Is stored in 952%n
. - Specific issues of serials or multi-part  jand $t for display in Normal views. $3
P52%3 Materials specified P P . play
tems. sn't displayed anywhere except the
IMARC view.
efault values:
[Coded value, matching Authorized
052%4 Damaged status 0 = Not damaged alue category (DAMAGE' in default
nstallation)
1 = Damaged
efault values:
[Coded value, matching Authorized
052$5 lUse restrictions 0 = No use restrictions alue category (RESTRICT' in default
nstallation)
1 = Restricted Access
efault values:
-1 = Ordered
[Coded value, matching Authorized
052%7 ot for loan 0 = Available for loans alue category (NOT_LOAN' in default
nstallation)
1 = Not for Loan
2 = Staff Collection
0ded value, matching Authorized
052%8 Collection code Coded value alue category ('CCODE!' in default
nstallation)
5259 tem numbper ystem-generated item number. 0ES Not display I the item recora.
. . equired. Code must be defined In
P52%a Owning Library ** Branch code . .
Libraries, Branches and Groups
olding Tibrary = (usually the same as equired. Code must be defined n
D52$b g y= y Branch code ) ; )
052%a ) Libraries, Branches and Groups
0ded value, matching Authorized
B52%¢C Shelving location code alue category ('LOC' in default
nstallation)
ate formats In the 952 subiields are
. equired to be in the system internal
052%d Date acquired YYYY-MM-DD )
format for data loading and subsequent
tem editing: YYYY-MM-DD
52%e ource of acquisition [Coded value or vendor string
52%9 urchase price ecimal number, no currency symbol
52%h erial enumeration caption
52%0 oha tull call number
52%p arcode * ax 20 characters
52%v eplacement price ecimal number, no currency symbol
ate formats In the 952 subtields are
. ) Fequired to be in the system internal
0525w Price effective from YYY-MM-DD

format for data loading and subsequent
tem editing: YYYY-MM-DD
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) 0ded value, required Tierd for equired. Coded value, must be
D523y Koha item type ** . ) ) .
Circulation defined in Item types
52%z ublic note

* - required for circulation

** - required by Koha

5.4.3. Handling On Order Items and Holds

VOKALNicole C.Engard2010http://docs.google.com/View?id=dcccx9zm_3htvhwzgc#Handling On_Order_items_and_ho

If you tend to import your MARC records when you have ordered the book (as opposed to when you receive the books), and allow patrons to place holds on
those books, you may need to add item records to the *.mrc file before importing.

The easiest way to import your latest order is to first run your records through MARCEdit. Download your MARC records, saving them to your desktop or some
other location you use/will remember. If you have MARCEdit already installed you should simply have to double click on your MARC records, and they will

automatically open in MARCE(dit.

This tutorial was written with MARCE(dit version 5.2.3769.41641 on Windows XP, instructions may be different if your version or operating system is
different.

Your original file will automatically be in the input; ensure MarcBreaker is chosen, and then click "Execute”
You will be presented with a summary of the records processed at the bottom of the screen
Click 'Edit Records' to continue on to adding item records
Your screen will be replaced with a larger screen containing the MARC records
Click on Tools > Add/Edit Field
Enter in the Koha specific item info
In the Field box, type 942
In the Field Data box, type \\$c and the item type code (\$cBOOK in this example)
Check the 'Insert last' option

Click 'Add Field'

Enter in the item record data
In the Field box, type 952
In the Field Data box, type $7ORDERED_STATUS$aPERM_LOC$bCURR_LOC$cSHELVING_LOCATION$eSOURCE_OF_ACQS$yITEM_TYPE
ex. $7-1$aCPL$bCPL$cNEWSeBrodartyBOOK

In a default install of Koha -1 is the value for the Ordered status

You may want to look at other subfields you would like data in -- for example, changing the collection code to put all the items in the same collection (8),
automatically fill in the acquisition date (d), or put in a public note (z).

Be sure you use the $ to separate subfields; adding each subfield on a separate line will cause that many items to be imported with your MARC record
(in the example above, four items, each with one of those subfields corrected)

Make sure you look at the Administration > Authorized Values in Koha to put the correct code into the field

Check the 'Insert last' option

Click 'Add Field'

Close the field editor window

Click on File > Compile into MARC
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Choose where to save your file

Now you want to go into your Koha system and follow the instructions for importing MARC records.

Once the item has come in, you will need to go to the item record and individually change the item to have the correct barcode, and manually change the status
from Ordered to the blank line in the Not for Loan field.

If you purchase your cataloged item records, you may want to request your vendor put in the information you need into the MARC records for you; that
way, you could import the edited-by-the-vendor file, overwriting the current record, automatically replacing the data with what you need.

Chapter 6. Serials

6.1. Add a subscription

Subscriptions can be added by clicking the 'New' button on any bibliographic record
Or by visiting the Serials module and clicking 'New Subscription’

If you are entering a new subscription from the Serials module you will be presented with a blank form (if creating new from a bibliographic record the form will
include the bib info).

‘Librarian’ field will show the logged in librarian's username
'Vendor' can be found by either searching vendors entered via the Acquisitions module or entering the vendor ID number
Vendor information is not required

In order to claim missing and late issues you need to enter vendor information

'Biblio’ is the MARC record you'd like to link this subscription to

This can be done by searching for an existing record by clicking on the 'Search for Biblio' link below the boxes or by entering the bib number for a record in
the first box. Only if you search with the field between the parenthesis.

Next you can choose whether a new item is created when receiving an issue
'Location’ is for the shelving location
'Call Number' is for your item's call number prefix
‘Library' is the branch that owns this subscription.
If more than one library subscribes to this serial you will need to create a subscription for each library

This can be done easily by using the 'Edit as New (Duplicate)' option found on the subscription information page and changing only the 'Library' field

The 'Grace Period' is the number of days before an issue is automatically moved from 'expected' status to ‘waiting' and how many days before an issue is
automatically moved from 'waiting' status to 'late’

Use the 'Public Note' for any notes you would like to appear in the OPAC for the patrons
'Nonpublic Note' should be used for notes that are only visible to the librarians via the staff client
To set up a routing list for serials, choose 'Routing List' from the 'Patron notification’ field.
For this option to appear you need to make sure that you have a Routing List notice set up in the Notices Tool

Learn more about Routing Lists later in this manual

The Staff and OPAC Display options allow you to control how many issues appear by default on bibliographic records in the Staff Client and the OPAC

If no values are entered in these fields, they will use the OPACSeriallssueDisplayCount and StaffSeriallssueDisplayCount system preference values
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In 'First issue publication' you want to enter the date of the issue you have in your hand, the date from which the prediction pattern will start
There are several pre-defined options for the 'Frequency' of publication

Without periodicy: some very specific (usually high level science journals) don't have a true periodicity. When you subscribe to the title, you subscribe for 6
issues, which can arrive in 1 year... or 2... There is no regularity or known schedule.

Unknown select this if none of the other choices are relevant

Irregular: The journal is not "regular" but has a periodicity. You know that it comes out on January, then in October and December, it is irregular, but you
know when it's going to arrive.

2/day: Twice daily

1/day: Daily

3/week: Three times a week

1/week: Weekly

1/ 2 weeks: Twice monthly (fortnightly)
1/ 3 weeks: Tri-weekly

1/month: Monthly

1/ 2 months (6/year): Bi-monthly

1/ 3 months (1/quarter): Quarterly
1/quarter (seasonal) : Quarterly related to seasons (ie. Summer, Autumn, Winter, Spring)
2/year: Half yearly

1/year: Annual

1/ 2 years: Bi-annual

Checking the 'Manual history' box will allow you to enter serials outside the prediction pattern.
'Numbering pattern’ will help you determine how the numbers are printed for each issue
Start with the numbering on the issue you have in hand, the numbering that matches the date you entered in the 'First issue publication' field
If you have chosen any 'Numbering Format' other than ‘Number' in the 'Rollover at' field, enter the last issue number before the volume number changes

If you chose the 'Number' Numbering Format you will see 'issues expected' in which you will enter the total number of issues you expect to receive.

You can choose to create your own numbering pattern by choosing 'None of the above' and clicking the 'Show/Hide Advanced Pattern' button at the
bottom of the form

'Subscription start date' is the date at which the subscription begins. This is used for setting up renewal alerts
'Subscription length' is the number of issues or months in the subscription. This is also used for setting up renewal alerts
'Subscription end date' should only be entered for subscriptions that have ended (if you're entering in a backlog of serials)

The 'Numbering formula' is editable to match the way you'd like your numbering to print on the item record and subscription information pages

Click 'Save Subscription' to save the information you have entered. Find sample serial examples in the appendix.

6.2. Receive Issues

Issues can be marked as received from several locations. To find a subscription, use the search box at the top of the Serials page to search for the serial you'd
like to receive issues for:
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From the search results you can click the 'Serial Receive' link or you can click on the subscription title and then click the 'Receive' button.
The final way to receive serials is from the 'Serial Collection' page. To the left of the Subscription summary page there is a menu with a link to 'Serial Collection'
From the page that opens up you can click 'Edit Serial' with the issue you want to receive checked.
All three of these options will open up the issue receive form:
Choose 'Arrived' from the status pull down to mark a serial as received.
If you have decided to have an item record created for each issue an item add form will appear
If your issue has a supplemental issue with it, fill in the Supplemental Issue information.
If you have decided to have an item record created for each issue an item add form will appear for your supplement and for the issue itself

Once you have entered your info you can click 'Save'

6.3. Create a Routing List

A routing list is a list of people who receive the serial before it goes to the shelf. When setting up your serial subscription you want to be sure to pick 'Routing List'
from the 'Patron Notification' pull down.

When on the subscription page you will see a link to the left that reads 'Create Routing List.'
Clicking that link will bring you to the menu to add a new routing list.

From here you want to click 'Add recipients' in order to add people to the routing list. In the menu that appears you can filter patrons by part of their name, their
library and/or patron category.

Clicking 'Add' to the right of each name will add them to the routing list. When you have chosen all of the people for the list, click the 'Close' link to be redirected to
the routing list.

If the list looks the way you expect it to, then click 'Save'. Next you will be brought to a preview of the routing list. To print the list click 'Save and preview routing
slip.' This will open a printable version of the list.

If RoutingListAddReserves is set to on then patrons listed in the routing list will automatically be added to the holds list for the issue.

6.4. Subscriptions in Staff Client

Subscription information will appear on bibliographic records under the 'Subscriptions' tab

Clicking the 'Subscription Details' link will take you to the Subscription summary page in the staff client.

6.5. Subscriptions in OPAC

When viewing the subscription in the OPAC there will be several options.
Like in the staff client, there will be a Subscriptions tab on the bibliographic record.

Under this tab will appear the number of issues you chose when setting up the subscription or in your OPACSeriallssueDisplayCount system preference. Clicking
the 'More details' link will provide you with additional information about the serial history. You can set the default view of a serial in the OPAC with the
SubscriptionHistory system preference.

There are two views, compact and full. The compact serial subscription will show basic information regarding the subscription

Whereas the full view shows extensive details, broken out by year, regarding the subscription

Chapter 7. Acquisitions

7.1. Setup
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Before using the Acquisitions Module you will want to make sure that you have completed all of the set up.

First, set your Acquisitions System Preferences and Acquisitions Administration to match your library's workflow.

7.2. Vendors

Before any orders can be places you must first enter at least one vendor.

7.2.1. Add a Vendor

To add a vendor click the 'New Vendor' button on the Acquisitions page
The vendor add form is broken into three pieces
The first section is for basic information about the Vendor

Of these fields, only the Vendor name is required, the rest of the information should be added to help with generating claim letters and invoices

The second section is for information regarding your contact at the Vendor's office

None of these fields are required, they should only be entered if you want to keep track of your contact's information within Koha

The final section is for billing information
To be able to order from a vendor you must make them 'Active’
For List Prices and Invoice Prices choose the currency

Currencies are assigned in the Currencies & Exchange Rates admin area

If the vendor offers a consistent blank discount, enter that in the 'Discount’ field

You can enter item specific discounts when placing an order

GST rate is for any tax the vendor may charge

Notes are for internal use

7.2.2. View/Edit a Vendor

To view a vendor's information page you must search for the vendor from the Acquisitions home page. Your search can be for any part of the Vendor's name:
From the results, click on the name of the vendor you want to view or edit

To make changes to the vendor, simply click the 'Edit' button.

7.2.3. Vendor Contracts

You can define contracts (with a start and end date) and attach it to a vendor. This is used so that at the end of the year you can see how much you spent on a
specific contract with a vendor. In some places, contracts are set up with a minimum and maximum yearly amount.

7.2.3.1. Add a Contract

At the top of a vendor search results page with only result or at the top of a vendor information page you will see a 'New Contract' button.

The contract form will ask for some very basic information about the contract

You will not be able to enter a contract retrospectively, the end date must not be before today's date.
Once the contract is saved it will appear below the vendor information.

It will also be an option when creating a basket
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7.3. Managing Suggestions

Depending on your settings in the suggestion system preference, patrons may be able to make purchase suggestions via the OPAC. When a suggestion is
waiting for library review, it will appear on the Acquisitions home page in the list of links on the left of the page.

Clicking '"Manage suggestions' will take you to the suggestion management tool. If there are no pending suggestions you can access the suggestion management
tool by clicking the 'Manage suggestions' link on the menu on the left of the Acquisitions page.

Your suggestions will be sorted into three categories: Accepted, Pending, and Rejected. Each accepted or rejected suggestion will show the name of the librarian
who managed the suggestion and the reason they gave for accepting or rejecting it (found under 'Status’).

For libraries with lots of suggestions, there are filters on the left hand side of the Manage Suggestions page to assist in limiting the number of titles displayed on
the screen.

Clicking on the blue headings will expand the filtering options and clicking ‘[clear]’ will clear all filters and show all suggestions.

When reviewing 'Pending' suggestions you can choose to check the box next to the item(s) you want to approve/reject and then choose the status and reason for
your selection. You can also choose to completely delete the suggestion by checking the 'Delete selected' box.

Reasons for accepting and rejecting suggestions are defined by the SUGGEST authorized value.

If you choose 'Others..." as your reason you will be prompted to enter your reason in a text box. Clicking 'Cancel' to the right of the box will bring back the pull
down menu with authorized reasons.

Once you have clicked 'Submit' the suggestion will be moved to the matching tab. The status will also be updated on the patron's account in the OPAC and an
email notice will be sent to the patron using the template that matches the status you have chosen.

7.4. Placing Orders

To place an order you must first search for the vendor or bookseller you want to send the order to.

7.4.1. Create a basket

To create a basket you have several options from the vendor search results page:
From here you can choose to create a new basket by clicking ‘New basket' under 'Manage orders' or by clicking 'Add basket'
When adding a basket you want to give it a name that will help you identify it later. The notes fields are optional and can contain any type of information.
If you have added contracts to the vendor you're ordering from, you will also have an option to choose which contract you're ordering these items under.
When finished, click 'Save'
Once your basket is created you are presented with several options for adding items to the order.

If you are ordering another copy of an existing item, you can simply search for the record in your system

From the results, simply click 'Order' to be brought to the order form

All of the details associated with the item will already be listed under 'Catalog details'

If you allow patrons to make purchase suggestions (learn more in the Managing Suggestions section of this manual) then you can place orders from those
suggestions

From the results, click 'Order' next to the item you want to order and you will be presented with the order form

From this form you can make changes to the Catalog Details if necessary

To order from a record that can't be found anywhere else, choose the 'From a new (empty) record'

You will be presented with an empty form to fill in all of the necessary details about the item you are ordering

If you want to search other libraries for an item to purchase you can use the 'From an external source' option which will allow you to order from a MARC record
found via a 239.50 search
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From the results click the Order link next to the item you want to purchase
If the item you're ordering from an external source looks like it might be a duplicate, Koha will warn you and give you options on how to procede

From the warning you can choose to just order another copy on the existing bib record, create a new bib record, or cancel your order of this item.

In the order form that pops up you will not be able to edit the catalog details

The final option for ordering is to order from a staged record (learn more about staging records)

From the list of files you are presented with, choose the 'Add orders' link
From the list of records, click '‘Add order' next to the item you want to add to your order

From the order form you will not be able to edit the catalog details.

Once you have entered the info about the item you need to enter the Accounting information.
Quantity is populated by the number of items you've added to the order above

The list of budgets is populated by the budgets you have assigned in the Acquisitions Administration area.

The vendor price will be used to calculate the rest of the amount fields below
If the price is uncertain, check the uncertain price box.

A basket with at least one uncertain price can't be closed

If you added Planning Values when creating the Fund those values will appear in the two planning value fields

Once an item is added to the basket you will be presented with a basket summary
From here you can edit or remove the items you have added.

Also on the summary page you have the option to edit the information you entered about the basket by clicking the 'Edit basket header information' button,
deleting the basket altogether by clicking the 'Delete this basket' button, or exporting your basket as a CSV file by clicking the 'Export this basket as CSV" button.

Once you're sure your basket is complete you can click 'Close this basket' button to indicate that this basket is complete and has been sent to the vendor.
A basket with at least one items marked as 'uncertain price' will not be able to be closed
Clicking the 'Uncertain Prices' button will up a list of items with uncertain prices to quick editing

The Uncertain Prices page is independent of the basket, it is linked to the vendor, so you will see all items on order for this vendor with uncertain prices.

7.4.2. Create a basket group

A basket group is simply a group of baskets. In some libraries, you have several staff members that create baskets, and, at the end of a period of time, someone
then groups them together to send to the vendor in bulk. That said, it is possible to have one basket in a basket group if that's the workflow used in your library.

7.4.3. Printing baskets

When you are finished adding items to your basket you want to click ‘Close this Basket'
You will be asked if you want to create a purchase order at this time.
Your completed order will be listed on the Basket Grouping page for the printing or further modification.

Clicking 'Print' below your order will generate a PDF for printing. The PDF will have all of your library information followed by the items in your order.

7.5. Receiving Orders

Orders can be received from the vendor information page
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or the vendor search results page

After clicking 'Receive shipment' you will be asked to enter a vendor invoice number and a shipment received date.
The receive page will list all items still on order with the vendor regardless of the basket the item is from.

To receive a specific item, click the 'Receive' link to the right of the item.

From this form you can alter the cost information. You can also choose to only receive 1 of multiple items if only 1 arrived. Once you have made any changes
necessary, click 'Save' to mark the item as received.

You will also see that the item is received if you view the basket

7.6. Claims & Late Orders

If you have entered in an email address for the vendors in your system you can send them claim emails when an order is late. Before you can send claims you
will need to set up an acquisitions claim notice.

Upon clicking on the link to 'Late Orders' from the Acquisitions page you will be presented with a series of filter options on the left hand side.
Once you filter your orders to show you the things you consider to be late you will be presented with a list of these items.

To the right of each late title you will be see a checkbox. Check off the ones you want a claim letter sent to and click 'Claim Order.' This will automatically send an
email to the vendor at the email address you have on file.

If you would rather use a different acquisition claim letter (other than the default) you can create that in the notices module and choose it from the menu above the
list of late items.

7.7. Acquisition Searches

At the top of the various Acquisition pages there is a quick search box where you can perform either a Vendor Search or an Order Search.
In the Vendor Search you can enter any part of the vendor name to get results.
Using the Order Search you can search for items that have been ordered with or without the vendor.

You can enter info in one or both fields and you can enter any part of the title and/or vendor name.

Chapter 8. Lists & Cart

Lists are a way to save a collection of content on a specific topic or for a specific purpose. The Cart is a session specific storage space.

8.1. Lists

8.1.1. Create a List
A list can be created by visiting the Lists page and clicking 'New List'
The new list form offers several options for creating your list:
The name is what will appear on the list of Lists
You can also choose how to sort the list
Finally there are three types of lists you can choose from
A Private List is managed by you and can be seen only by you

A Public List can be seen by everybody, but managed only by you

A Open List can be seen and managed by everybody

A list can also be created from the catalog search results
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Check the box to the left of the titles you want to add to the new list
Choose [New List] from the 'Add to:' pull down menu
Name the list and choose what type of list this is
A Private List is managed by you and can be seen only by you
A Public List can be seen by everybody, but managed only by you

A Open List can be seen and managed by everybody

Once the list is saved it will accessible from the Lists page and from the 'Add to' menu at the top of the search results.

8.1.2. Add to a List
To add titles to an existing list click on the list name from the page of lists
From the List page you can add titles by scanning barcodes into the box at the bottom of the page

A title can also be added to a list by selecting titles on the search results page and choosing the list from the 'Add to' menu

8.1.3. Viewing Lists

To see the contents of a list, visit the Lists page on the staff client

Clicking on the 'List Name' will show the contents of the list

8.1.4. Merging Bibliographic Records Via Lists

Merging will only work with two items that use the same bibliographic framework.
The easiest way to merge together duplicate bibliographic records is to add them to a list and use the Merge Tool from there.
From the list, check the two items you want to merge. If you choose more than or fewer than 2, you will be presented with an error:

Once you have selected the records you want to merge, click the 'Merge selected items' button. You will be asked which of the two records you would like to keep
as your primary record and which will be deleted after the merge.

You will be presented with the MARC for both of the records (each accessible by tabs labeled with the bib numbers for those records). By default the entire first
record will be selected, uncheck the fields you don't want in the final (destination) record and then move on to the second tab to choose which fields should be in
the final (destination) record.

Should you try to add a field that is not repeatable two times (like choosing the 245 field from both record #1 and #2) you will be presented with an error

Most importantly you want to make sure that all of the items from the two records are attached to the new record. To do this you want to make sure that all 952
files are selected before completing the merge.

Once you have completed your selections click the ‘'merge' button. The primary record will now show the data you chose for it, and the second record will be
deleted.

It is important to rebuild your zebra index immediately after merging records. If a search is performed for a record which has been deleted Koha will
present the patrons with an error in the OPAC.

8.2. Cart

The cart is a temporary holding place for items in the OPAC and/or staff client. The cart will be emptied once the session is ended (by closing the browser or
logging out). The cart is best used for performing batch operations (holds, printing, emailing) or for getting a list of items to be printed or emailed to yourself or a
patron.

If you would like to enable the cart in the staff client, you need to set the intranetbookbag system preference to 'Show.' To add things to the cart, search the
catalog and select the items you would like added to your cart and choose 'Cart' from the 'Add to' menu

A confirmation will appear below the cart button at the top of the staff client
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Clicking on the Cart icon will provide you with the contents of the cart
From this list of items you can perform several actions
'Send' will send the list to the email address you enter
'‘Download" will allow you to download the cart using one of 3 default formats or your CSV Profiles
'Print’ will present you with a printable version of the cart
'Empty and Close' will empty the list and close the window

'Hide Window" will close the window

Chapter 9. Reports

9.1. Custom Reports

Koha's data is stored in a MySQL database which means that librarians can generate nearly any report they would like by either using the Guided Reports Wizard
or writing their own SQL query.

9.1.1. Add Custom Report

9.1.1.1. Guided Report Wizard

The guided report wizard will walk you through a six step process to generate a report.
Step 1: Choose the module you want to report on. This will determine what tables and fields are available for you to query.
Step 2: Choose a report type. For now, Tabular is the only option available.

Step 3: Choose the fields you want in your report. You can select multiple fields and add them all at once by using CTRL+Click on each item you want to add
before clicking the Add button.

Step 4: Choose any limits you might want to apply to your report (such as item types or branches). If you don't want to apply any limits, simply click Next instead
of making an option.

Step 5: Perform math functions. If you don't want to do any calculations, simply click Next instead of making an option.
Step 6: Choose data order. If you want the data to print out in the order it's found in the database, simply click Finish.

When you are finished you will be presented with the SQL generated by the report wizard. From here you can choose to save the report by clicking 'Save' or copy
the SQL and make edits to it by hand.

If you choose to save the report you will be asked to name your report and enter any notes regarding it.
Once your report is saved it will appear on the 'Use Saved' page with all other saved reports.

From here you can make edits, run the report, or schedule a time to have the report run.

9.1.1.2. Report from SOQL

In addition to the report wizard, you have the option to write your own queries using SQL. To find reports written by other Koha users, visit the Koha Wiki:
http://wiki.koha-community.org/wiki/SQL Reports Library. You can also find your database structure in /installer/data/mysgl/kohastructure.sgl or online at:
http://git.koha-community.org/cgi-bin/gitweb.cgi?p=koha.git;a=blob plain;f=installer/data/mysgl/kohastructure.sql;hb=HEAD.

To add your query, simply fill in the form presented

9.1.2. Edit Custom Reports

Every report can be edited from the reports lists. To see the list of reports already stored in Koha, click 'Use Saved.'

From this list you can edit any custom report by clicking 'Edit SQL'
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9.2. Statistics Reports

Statistic reports will show you counts and sums. These reports are all about numbers and statistics, for reports that return more detailed data, use the Guided
Report Wizard.

9.2.1. Acquisitions Statistics

Using the form provided, choose which value you would like to appear in the Column and which will appear in the Row.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

When generating your report, note that you get to choose between counting or summing the values.

Choosing amount will change your results to appear as the sum of the amounts spent.

9.2.2. Patron Statistics

Using the form provided, choose which value you would like to appear in the Column and which will appear in the Row.
If you choose to output to the browser your results will print to the screen.

Based on your selections, you may see some query information above your results table. You can also choose to export to a file that you can manipulate to your
needs.

9.2.3. Catalog Statistics

Using the form provided, choose which value you would like to appear in the Column and which will appear in the Row.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.2.4. Circulation Statistics

Using the form provided, choose which value you would like to appear in the Column and which will appear in the Row.
If you choose to output to the browser your results will print to the screen.
You can also choose to export to a file that you can manipulate to your needs.

To get a complete picture of your monthly or daily circulation, you can run the report twice, once for 'Type' of 'Checkout' and again for '‘Renewal.’

This report uses 'Period,' or date, filtering that allows you to limit to a month by simply selecting the first day of the first month through the first day of the
next month. For example, 10/1 to 11/1 to find statistics for the month of October.

To find daily statistics, set your date range.</br> Example: "l want circulation data starting with date XXX up to, but not including, date XXX."
For a whole month, an example range would be: 11/01/2009 to 12/01/2009
For a whole year, an example range would be: 01/01/2009 to 01/01/2010

For a single day, an example would be: 11/15/2009 to 11/16/2009 to find what circulated on the 15th

9.2.4.1. Tracking in house use

Using the Circulation statistics reporting wizard you can run reports on in house usage of items simply by choosing 'Local Use' from the "Type' pull down:

9.2.5. Serials Statistics

Using the form provided, choose how you would like to list the serials in your system.

If you choose to output to the browser your results will print to the screen.
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You can also choose to export to a file that you can manipulate to your needs.

9.2.6. Patrons with the most checkouts

This report will simply list the patrons who have the most checkouts.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.2.7. Most Circulated ltems

This report will simply list the items that have the been checked out the most.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.2.8. Patrons with no checkouts

9.2.9. ltems with no checkouts

This report will list items in your collection that have never been checked out.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.2.10. Catalog by Item Type

This report will list the total number of items of each item type per branch.
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.2.11. Lost Items

This report will allow you to generate a list of items that have been marked as Lost within the system

9.2.12. Average Loan Time

This report will list the average time items are out on loan based on the criteria you enter:
If you choose to output to the browser your results will print to the screen.

You can also choose to export to a file that you can manipulate to your needs.

9.3. Report Dictionary

The report dictionary is a way to pre-define common filters you'd like to apply to your reports. This is a good way to add in filters that the report wizard doesn't
include by default. To add a new definition, or filter, click 'New Definition' on the Reports Dictionary page and follow the 4 step process.

Step 1: Name the definition and provide a description if necessary

Step 2: Choose the module that the will be queried.

Step 3: Choose columns to query from the tables presented.

Step 4: Choose the value(s) from the field(s). These will be automatically populated with options available in your database.

Confirm your selections to save the definition.
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Your definitions will all appear on the Reports Dictionary page

Then when generating reports on the module you created the value for you will see an option to limit by the definition at the bottom of the usual filters.

Chapter 10. OPAC

This chapter assumes that you have the following preferences set as follows:

OPACXSLTResultsDisplay = using XSLT stylesheets

OPACXSLTDetailsDisplay = using XSLT stylesheets

DisplayOPACiconsXSLT = show

If your system preferences are set differently your displays may differ.

10.1. Search Results

To search the OPAC you can either choose to enter your search words in the box at the top of the OPAC or click on the 'Advanced Search' link to perform a more
detailed search.

For more on searching check the 'Searching' chapter in this manual.

10.1.1. Results Overview

After performing a search the number of results found for your search will appear above the results

By default your search results will be sorted based on your OPACdefaultSortField and OPACdefaultSortOrder system preference values. To change this you can
choose another sorting method from the pull down on the right.

Under each title on your results list a series of values from your leader will appear. It is important to note that this has nothing to do with the item types or
collection codes you have applied to your records, this data is all pulled from your leader.

Below each title you will see the availability for the items attached to the record. Note that even if you filtered on one library location all locations that hold the item
will appear on the search results.

If you have turned on Enhanced Content preferences you may have book jackets on your search results.

10.1.2. Filters

To filter your results click on the links below the 'Refine Your Search' menu on the left of your screen

10.1.3. Search RSS Feeds

You will be able to subscribe to your search results as an RSS feed by clicking the RSS icon in your address bar or next to the number of results. To learn more
about what RSS feeds are check out this tutorial video.

Subscribing to search results as RSS feeds will allow you to see when a new item is added to the catalog in your area of interest.

10.2. Bibliographic Record

10.3. Lists & Cart

A cart is a temporary holding place for records you're interested in finding during this session. That means that once you log out of the OPAC or close the browser
you lose the items in your cart. A list is @ more permanent location for saving items. To learn more about lists, check the Lists in the Staff Client chapter of this
manual.

10.3.1. Lists
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10.3.1.1. Adding titles to Lists

Titles can be added to lists from the search results and/or from the bibliographic record. On the search results options to add items to the list appear below each
result and across the top of the results page

To add a single title to a list, click the 'Save to Lists' option and then choose the list you'd like to add the title to. To add multiple titles to a list check the boxes on
the left of the titles you want to add and then choose the list you want to add the titles to from the 'Add too' pull down at the top of the screen.

10.3.1.2. Managing Lists

10.3.2. Cart

10.3.2.1. Adding titles to the Cart

Titles can be added to the cart from the search results and/or from the bibliographic record. On the search results options to add items to the cart appear below
each result and across the top of the results page

Clicking the 'Add to Cart' button will add the one title to your cart. To add multiple titles at once, check the box to the left of each result and the choose 'Cart’ from
the 'Add to' pull down at the top of the screen. Once titles are added to the cart you will be presented with a confirmation

10.3.2.2. Managing the Cart

Once you have titles in your cart you can manage the contents by clicking on the 'Cart' button usually found at the top of the screen to the right of the search box.
Your cart will open in a new window.

From this window you are presented with several options. Across the top of the cart are several buttons.
First is the 'More details' button. Clicking this will show you additional information about the titles in your card (ISBNs, Subjects, Publisher Info, Notes and more).

Next is the option to send the contents of your cart to an email address. This is handy if you want to send the resources you found at the library to your home
email account to refer to later or to send to a patron researching a specific topic. Clicking this link will open up a new window that asks for the email address and
message to send.

In addition to sending your cart you can download the contents of your cart in several pre-defined formats or using a CSV Profile that you defined in the Tools
module.

Finally you can print out the contents of your cart by choosing the 'Print' link.

In addition to the various different ways to save the contents of your cart, there are ways to add value to the data in your cart. By selecting one or more titles from
the cart you can add them to a list (click 'Add to a List"), place hold(s) (click 'Place hold"), or tag them (click 'Tag'). All of these operations follow the same
procedure as they do when performing them in the OPAC.

10.4. Enhanced Content

10.4.1. Tagging

Depending on your settings for the TagsEnabled, TagsInputOnList and TagsinputOnDetail preferences you may be able to add tags to bibliographic records from

the search results and/or bibliographic records. If you are allowing patrons to add tags from the search results screen you will see an input box below each result
and a 'Tag' option at the top of the screen.

To add a tag to one item, type the tabs (separated by commas) in the 'New tag' box and click 'Add'. You will be presented with a confirmation of your tags being
added.

From the results you can also tag items in bulk by clicking the checkboxes on the left and then clicking the 'Tag' button at the top. After clicking the button it will
change into an input box for you to add tags to all of the items you have selected.

10.4.2. Comments

Patrons can leave comments in the OPAC if you have the reviewson preference set to allow this. Each bibliographic record has a comments tab below the
bibliographic information.

If the patron is logged in they will see a link to add a comment to the item. Clicking this link will open a pop up window with a box for their comments.
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Once the comment has been typed and the 'Submit' button clicked, the patron will see their comment as pending and other patrons will simply see that there are
no comments on the item.

Once the comment is approved the patron will see the comment highlighted in yellow as their comment.

Other patrons will see the comment with the name of the patron who left the comment.

10.4.3. Zotero
Zotero is a Firefox add on that allows for the saving and generating of a bibliography. Learn more about and download Zotero at http://zotero.org.

When on the search results in the Koha OPAC, if you have Zotero installed, you will see a folder icon in the address bar to the right of the URL. Clicking that
folder will open up a list of titles on the page for you to pick from to add to Zotero.

Select the titles you want to add to Zotero and then click the 'OK' button. This will add the title to Zotero. You can see the title by opening your Zotero library.

10.4.4. Custom RSS Feeds

Using misc/cronjobs/rss/rss.pl you can generate an RSS feed for any SQL query (for example a new acquisitions RSS feed). rss.pl is run on the command line to
produce an RSS XML document.

The output should be placed in a directory accessible to the OPAC (or staff) web interface so that users can download the RSS feed.
An example of usage can be found at: misc/cronjobs/rss.pl lastAcquired.conf
Normally rss.pl should be run periodically (e.g., daily) to keep the feed up-to-date.
The configuration file (e.g., lastAcquired.conf) lists
name of the template file to use
path of output file

SQL query

rss.pl runs the SQL query, then feeds the output of the query through the template to produce the output file.

To use custom RSS feeds you need to turn on the cron job.

10.5. My Account

From the OPAC patrons can log in and access their account if you have set the opacuserlogin preference to 'Allow'. Once logged in patrons are brought to their
account summary. If you would like to get from any other page your account in the OPAC, click on your name in the top right of the OPAC.

10.5.1. My Summary

From the 'my summary' tab, patrons will see all of the items they have checked out with the overdue items highlighted in red. If you have OpacRenewalAllowed
set to 'Allow' then your patrons will be able to renew their books right from the OPAC. Clicking on the 'Overdue' tab will show only the items that are overdue.

The 'Fines' tab will show just a total of what the patron owes. Clicking on the total will take them to the 'my fines' tab where they will see a complete breakdown of
their fines and bills. If you don't charge fines at your library you can turn the display of these tabs off by setting the OPACFinesTab preference to 'Don't Allow.'

Finally, clicking on the 'Holds' tab will show the patron the status of all of the items they have on hold. ltems that are ready for pickup will be highlighted in yellow.

10.5.2. Patron Flags

If you have flagged your patron's account they may see one of the following error messages at the top of their account.

Card marked as lost
Patron address in question

this error message will not include a link to the update form if you have OPACPatronDetails set to 'Don't allow'
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Patron marked debarred

10.5.3. My Fines

If your library charges fines the next tab on the left is 'my fines.' Opening this tab will show the patron an entire history of their accounting at the library.

10.5.4. My Details

If you have your OPACPatronDetails preference set to 'Allow’, your patrons will see a form filled in with their contacting information by clicking on the 'my personal
details' tab.

Patrons can edit their details in this form and click 'Submit Changes' to have their edits sent to the library for review before their record is updated. If the
OPACPatronDetails preference is set to 'Don't allow' then patrons will simply see their details in plain text.

10.5.5. My Tags

If your library has TagsEnabled set to 'Allowed' then the next tab on the left will be 'my tags.' This tab will show patrons all of the tags in the system as a cloud and
then all of the tags they have applied in a list format. From here patrons have the ability to remove tags that they have added if they want.

10.5.6. Change My Password

Next, if you have OpacPasswordChange set to 'Allow' the next tab will be ‘change my password,' where patrons can change their password for logging into the
OPAC. Patrons will be presented with a standard form asking them to enter their old password and then their new password twice.

10.5.7. My Search History

If you have your EnableOpacSearchHistory preference set to 'Allow' then your patrons can access their search history via the 'my search history' tab.

The search history is a record of all searches run by the patron. Clicking on any of the search phrases will re-run the search for the patron. The search history can
be deleted by the patron at any time by clicking the 'Delete your search history' link found at the top of this tab or by clicking the little red 'x' next to the 'Search
history' link at the top right of the OPAC.

10.5.8. My Reading History

Depending on your library's setting for opacreadinghistory your patrons may see the 'my reading history' tab next. This will show the patron their entire reading
history unless they have asked the library to not keep that information via the 'my privacy' tab which will appear if you have the OPACPrivacy preference set to
'‘Allow.'

10.5.9. My Privacy

The 'my privacy' tab will appear if you have both the opacreadinghistory and the OPACPrivacy preferences set to 'Allow." This tab will allow the patrons to decide
how the library keeps their circulation history data.

The patron can choose from three options:
Forever: keep my reading history without limit. This is the option for users who want to keep track of what they are reading.

Default: keep my reading history according to local laws. This is the default option : the library will keep your reading history for the duration permitted by local
laws.

Never: Delete my reading history immediately. This will delete all record of the item that was checked-out upon check-in.

Depending on the patron's suggestions the contents of the 'my reading history' tab and the 'Circulation History' tab in the staff client may change.
Regardless of the patron's choice they can delete their reading history in bulk at any time by clicking the 'Immediate deletion' button.

Clicking this button will not delete items that are currently checked out, but will clear the patron's past reading history.

10.5.10. My Purchase Suggestions
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If your library allows patrons to make purchase suggestions the next tab will show all suggestions that the patron made to the library and their statuses. To
disable this tab and the suggestion functionality set the suggestion preference to 'Don't allow.'

10.5.11. My Messaging

If your library as the EnhancedMessagingPreferences preference set to 'Allow' then your patrons will be able to choose which messages they receive from the
library (with the exception of overdue notices which the library controls).

10.5.12. My Lists

Finally, if your library has the virtualshelves set to 'Allow' then the last tab will by 'my lists." From here your patrons can review public lists and create or edit their
own private lists.

10.6. Purchase Suggestions

If your library has the suggestion preference set to 'Allow' then patrons will have the option to make purchase suggestions in several areas in the OPAC.
There will be a link at the top of your OPAC under the search box.
There will be a link when the patron finds nothing for their search.

And there will be a link on the patron's My Purchase Suggestions tab.

Clicking any one of these links will open the purchase suggestion form.

From the form on the 'Title' is required by the library. If you would like the 'Reason for suggestion' menu shown in the screenshot above to appear on your
suggestions list you need to add an authorized value category titled 'OPAC_SUG' and include reasons as values in that list.

Once the form is submitted the data will be saved to the Acquisitions module for the librarians to manage.

Chapter 11. Searching

11.1. Advanced Search Prefixes

The following prefixes can be added to search terms in the keyword search box to limit items returned
ti: title search

ex. ti:hamlet

su: subject search

ex. su:cookery

pb: publisher search

ex. pb:penguin

au: author search

ex. au:rowling

su-geo: geographic subjects

ex. su-geo:wales and kw:description and kw:travel

bc: barcode

ex. bc:502326000912
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lex: lexile

levels lex:510

11.2. Guide to Searching

Becky BellOctober 2008Nicole C. Engard

This brief guide will explain a chart that shows a sample of how a MARC21 database can be configured, as well as a brief introductory searching guide. The
indexing fields described in this document relate to the bibliographic data and does not address authority database indexing.

11.2.1. Indexing and Searching Description

Koha's databases are indexed by the Zebra open-source software. The overview to the documentation describes Zebra as:

"...Zebra is a high-performance, general-purpose structured text indexing and retrieval engine. It reads records in a variety of input formats (eg. email,
XML, MARC) and provides access to them through a powerful combination of Boolean search expressions and relevance-ranked free-text queries.

Zebra supports large databases (tens of millions of records, tens of gigabytes of data). It allows safe, incremental database updates on live systems.
Because Zebra supports the industry-standard information retrieval protocol, Z39.50, you can search Zebra databases using an enormous variety of
programs and toolkits, both commercial and free, which understands this protocol..." Zebra - User's Guide and Reference, p. 1,
http://www.indexdata.dk/zebra/doc/zebra.pdf

This brief guide will explain a chart that shows a sample of how a MARC21 database can be configured, as well as a brief introductory searching guide. The
indexing fields described in this document relate to the bibliographic data and does not address authority database indexing.

The indexing described in this document is the set used by SouthEastern University. Your local indexing may vary.

11.2.2. Indexing Configuration

There are three configuration files that Koha uses while indexing.

The first configuration file (etc/zebradb/biblios/etc/bibl.att) contains the Z39.50 bib-1 attribute list, plus the Koha local use attributes for Biblio Indexes, Items
Index, and Fixed Fields and other special indexes. The Z39.50 Bib-1 profile is made up of several different types of attributes: Use, Relation, Position, Structure,
Truncation, and Completeness. The bib-1 'Use’ attribute is represented on the chart; the other attributes are used primarily when doing searches. While there are
over 150+ use attributes that could be used to define your indexing set, it's unlikely that you will choose to use them all. The attributes you elect to use are those
that become the indexing rules for your database. The other five attribute sets define the various ways that a search can be further defined, and will not
specifically be addressed in this document. For a complete list of the standard Bib-1 attributes, go to http://www.loc.gov/z3950/agency/bibl.html.

The second file (etc/zebradb/marc_defs/[marc21|unimarc]/biblios/record.abs) contains the abstract syntax which maps the MARC21 tags to the set of Use
Attributes you choose to use. The rules established in this file provides a passable Bath level 0 and 1 service, which includes author, title, subject, keyword and
exact services such as standard identifiers (LCCN, ISBN, ISSN, etc.)

The third file (etc/zebradb/ccl.properties) is the Common Command Language (CCL) field mappings. This file combines the bib-1 attribute set file and the abstract
file and adds the qualifiers, usually known as index names. The qualifiers, or indexes, for this database are: pn, cpn, cfn, ti, se, ut, nb, ns, sn, lcn, callnum, su,
su-to, su-geo, su-ut, yr,pubdate, acqdate, In, pl, ab, nt, rtype, mc-rtype, mus, au, su-na, kw, pb, ctype, and an.

The Koha Indexing Chart summarizes the contents of all three of these files in a more readable format. The first two columns labeled 239.50 attribute and 239.50
name matches the Z39.50 bib-1 attributes file. The third column labeled MARC tags indexed is where you find which MARC tags are mapped to an attribute. The
fourth column labeled Qualifiers identifies the search abbreviations used in the internal CCL query. The following description provides a definition for the word
‘qualifiers’.

Qualifiers are used to direct the search to a particular searchable index, such as title (ti) and author indexes (au). The CCL standard itself doesn't specify a
particular set of qualifiers, but it does suggest a few shorthand notations. You can customize the CCL parser to support a particular set of qualifiers to reflect the
current target profile. Traditionally, a qualifier would map to a particular use-attribute within the BIB-1attribute set. It is also possible to set other attributes, such as
the structure attribute.

In the MARC tags indexed column, there are some conventions used that have specific meanings. They are:

A three digit tag (100) means that all subfields in the tag can be used in a search query. So, if you enter a search for 'Jackson' as an author, you will retrieve
records where Jackson could be the last name or the first name.

A three digit tag that has a '$' followed by a letter (600$a) means that a search query will only search the 'a' subfield.
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A three digit tag that is followed by a ":" and a letter (240:w) means that a search query can be further qualified. The letter following the "' identifies how to
conduct the search. The most common values you'll see are 'w' (word), 'p’ (phrase), 's' (sort), and 'n' (numeric).

The contents of the MARC tags, subfields, and/or fixed field elements that are listed in this chart are all indexed. You'll see that every attribute line is not mapped
to a specific qualifier (index)-LC card number, line 9 is one example. However, every indexed word (a string of characters preceded and succeeded by a space)
can be searched using a keyword (kw) search. So, although an LC card number specific index doesn't exist, you can still search by the LCCN since tag 010 is
assigned to the LC-card-number attribute. To verify this, enter 72180055 in the persistent search box. You should retrieve The gods themselves, by Isaac
Asimov.

Examples of fixed field elements indexing can be seen on the chart between Attribute 8822 and Attribute 8703. These attributes are most commonly used for
limiting. The fixed field attributes currently represent the BK codes. Other format codes, if needed, could be defined.

11.2.3. Basic Searching

The search box that library staff and library patrons will see most often is the persistent search box at the top of the page. Koha interprets the searches as
keyword searches.

To start a search, you enter a word or multiple words in the search box. When a single word is entered, a keyword search is performed. You can check this out by
typing one word into the form and note the number of results located. Then, repeat the search with a minor change. In front of the search word, type 'kw="
followed by the same search term. The results will be identical.

When you have more than one word in the search box, Koha will still do a keyword search, but a bit differently. Each word will be searched on its own, then the
Boolean connector 'and' will narrow your search to those items with all words contained in matching records.

Suppose you want to find material about how libraries are using mashups. You'll select the major words and enter them into the persistent search box.
The response to this search is:
The order of the words does not affect the retrieval results, so you could also enter the search as "mashups library". The response to this search is results

Too many words in the search box will find very few matches, as the following example illustrates:

11.2.4. Advanced Searching

When you can't find the most appropriate material with a general search, you can move to the Advanced Search page by clicking on the Search option on the
persistent toolbar.

The Advanced Search page offers many ways to limit the results of your search. You can search using the Boolean operators AND, OR, and NOT,; limit by item
type; limit by year and language; limit by subtypes audience, content, format, or additional content types; by location and by availability.

The first limiting section on the Advanced Search page provides a quick and simple way to use the Boolean operators in your search. Note that this display
depends on a system preference setting. This option can be found on the Administration > System Preferences > Searching page. The option called
expandedSearchOption must be set to 'show' to see the following display.

In this section you can choose among the many indexes by clicking on the arrow in the first box. The blank box that follows is where you enter your first search
term or terms. On the second line, you can choose the Boolean operator you want to use in your search. The options are 'and', 'or', and 'not'. Then, you would
again choose the index to search, followed by the second term or terms. If you have more concepts you want to include in your search, you can click the [+] to
add another line for your search.

A sample search is shown next, followed by its results:

When you use the Boolean operators to broaden or narrow a search, remember the action of each operator. The 'and' operator narrows the results you'll retrieve
because the search will retrieve the records that include all your search terms. The 'or' operator expands the results because the search will look for occurrences
of all of your search terms. The 'not' operator excludes records with the term that follows the operator.

Note: If you leave this expandedSearchOption set to ‘don't show, this is the display you will see:

The Advanced Search page then shows the multiple kinds of limits that can be applied to your search results. Either check a box or select from the drop down
menus to narrow your search. You will type the year, year range, or a 'greater than (>)' or 'less than (<)’ year.

Finally, you can choose how the results will be sorted. The pre-defined sort options are in the final area of the Advanced Search screen.

The default sort is by relevance, although you can choose to sort by author, by title, by call number, by dates, or by popularity. If you would prefer a different
default sort, you can set defaultSortField to one of the other choices in Administration > System Preferences > Searching.
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11.2.5. Common Command Language Searching

Koha uses the Common Command Language (CCL) (ISO 8777) as its internal search protocol. Searches initiated in the graphical interface use this protocol as
well, although the searcher doesn't know which indexes, operators and limiters are available and being used to conduct their search. The searcher can use the
Advanced Search when more precise results set are desired and where the search indexes are somewhat known. However, some library users and many library
staff prefer using a command based structure. This part of the document will present and explain the use of the Koha command based structure. The indexes,

operators, and limiters used are identical to those used in the graphical interface.

11.2.5.1. Indexes

The CCL standard itself doesn't specify a particular set of qualifiers (indexes), but it does suggest a few short-hand notations such as 'ti', ‘au’, and 'su'. Koha has a
default set of indexes; it's possible to customize that set by adding needed indexes based on local requirements. A qualifier (index) maps to a particular
use-attribute within the Z39.50 BIB-1 attribute set. The complete Z39.50 Bib-1 Attribute can be viewed at http://www.loc.gov/z3950/agency/bibl1.html.

The standard Koha set of indexes is a fairly common example of MARC21 indexing rules. The indexes that are defined in Koha are indexes typically used by
other integrated library systems. The defined Z39.50 Bib-1 Attribute mapped to the indexes are:

Table 11-1. Attributes

BIb-1 Attribute

Qualiier (Index)

ersonal-name pn
[Corporate-name Cpn
onference-name cn
e T
TTile-series 13
Itle-uniform ut
SBN b
SSN ns
ocal number 5N
[ocal-classHication cn and callnum
Ubject BU, su-to, su-geo, su-ut
ubdate T,pubdate
Date-of-Acquisiiion cqdate
anguage n
Tace-of-publication T
Rbstract |219)
otes it
ecord-type Ffype, mc-rtype, mus
Author AU, aut
UbJeCt-person-name Bu-na
ANy (keyword) W
ublisher b
ontent-type Ctype
oha-Auth-Number n
AUThor-personal-bibliography ub
[AUthor-in-order to

Refer to the Koha Indexing Chart for the MARC21 tags mapped to each Bib-1 Attribute and index combination.

11.2.5.1.1. Audience Examples

aud:a Easy
aud:cc Juvenile
aud:d Young adult

aud:e Adult

11.2.5.1.2. Contents Examples

fic:1 Fiction

fic:0 Non Fiction
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bio:b Biography
mus:j Musical recording

mus:l Non musical record

11.2.5.2. Search Syntax

In the persistent search box, single words generally retrieve large sets. To narrow a search, you can use multiple words. Koha automatically uses the 'and’
Boolean operator to create a set of records matching your input. When you want to narrow the search to an author or a title or a subject or some other specific
field or use a Boolean operator, there isn't an obvious way to accomplish that specificity. The library user can, of course, go to the Advanced Search page;
however, if you know how to construct a CCL search, you can achieve more specificity while using the persistent search box on any page.

There is a specific order to the CCL search syntax. Although it can be used for simple searches, it is an especially effective way to perform complex searches, as
it affords you a great deal of control over your search results. To construct a CCL search, first enter a desired index code, then an equal sign, followed by your
search word(s). Following are examples of simple CCL searches.

ti=principles of accounting
au=brown joseph
su=poetry
su-na=Shakespeare

kw=marlin

You can refine your search by combining search terms with Boolean operators 'and', 'or', or 'not'. Following are examples of searches using Boolean operators.
ti=principles of accounting and au=brown joseph
su=poetry not su-na=Shakespeare

kw=communication and su=debate

You can also choose to search for things that start with a character or series of characters

ti,first-in-subfield=C (will show you all titles that start with the letter 'C")

Using specific indexes and Boolean operators are not the only way a search can be refined. You can also refine your search as a phrase when looking for a title,
author, or subject. The syntax for this search is index,phr=search words.

To illustrate the results of various search types, a search was done for the words 'supreme court'. The results illustrate that the search index and the word order
make a difference in search results. Only the results count and the search itself is in these examples. The search executed will always be between the single
quotes.

You can also choose to use limiters in your search query. Some common limiters include dates, languages, record types, and item types. In the Advance Search,
you can either click a box or key in data to limit your search. You can also apply the same limits with CCL by using the syntax in the following examples. In all

By Date: su=supreme court and yr,st-numeric=>2000
When you limit by date, you can use the '>' (greater than), '<' (less than), '=' (equal), or 'yyyy-yyyy' (range) symbols.
By Item Type: su=nursing and itype:BK

Each library will have a different set of item types defined in their circulation configuration. When you set up item types, you define a code and a hame for each
one. The name will appear on the Advance Search page. The code you assigned is used as a CCL search limit, formatted as ‘itype:x', where 'x' is the assigned
code. The initial set of item types in Koha will usually be edited to reflect your collections, so your item type limiters may be different than the initial ones. The
initial item type limiters follow.

itype:BKS Books, Booklets, Workbooks
itype:SR Audio Cassettes, CDs

itype:IR Binders
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itype:CF CD-ROMs, DVD-ROMs, General Online Resources
itype:VR DVDs, VHS

itype:KT Kit

itype:AR Models

itype:SER Serials

By format: su=supreme court not I-format:sr

The format limiters are derived from a combination of LDR, 006 and 007 positions. The formats that are currently defined are the following.

I-format:ta Regular print
|-format:tb Large print
I-format:fk Braille

|-format:sd CD audio
|-format:ss Cassette recording
|-format:vf VHS tape
I-format:vd DVD video
|-format:co CD software

I-format:cr Website

By content type: su=supreme court not ctype:l

The content types are taken from the 008 MARC tag, positions 24-27.

There are two other limiter types that are not described in this document. They are: Audience and Content. The only difference in the syntax of the CCL is the
actual limiter. They are reproduced here just in case you would like to use these limiters.

11.3. Koha Search Indexes

By default, not all fields are indexed in the Zebra search engine, but most are. Below are the fields that are indexed in Zebra.

Table 11-2. Indexes

Freld Descripiion
0T ontrol-numper
05 atefime-Tast-modried
o7 icroform-generation:.n.range(daia, 11,1), Material-type,if7-00.w:range(daia,o, 1),
ff7-01:w:range(data,1,1), ff7-02:w:range(data,2,1), ff7-01-02:w:range(data,0,2)
[Jate-entered-on-Tile:n.range(data,0,b), date-entered-on-fe:s.range(data,0,5), |
pubdate:w:range(data,7,4), pubdate:n:range(data,7,4),
bos pbubdate:y:range(data,7,4), pubdate:s:range(data,7,4), pl:w:range(data,15,3),
fa:w:range(data,22,1), ff8-23:w:range(data,23,1), ff8-29:w:range(data,29,1),
f:.w:range(data,33,1), bio:w:range(data,34,1), In:n:range(data,35,3),
ctype:w:range(data,24,4), Record-source:w:range(data,39,0)
10 C-card-number, Tdentifier-standard
T C-card-number, Tdentifier-standard
s NB-card-number, BGF-number, Number-db, Number-natl-iblio,
dentifier-standard
7 umber-Tegal-deposlt, ldentiier-standard
18 dentiier-standard
20%a SBN:w, Tdentiiier-standard:-w
20 dentrier-standard
22%a SSN:w, Identifier-standard:w
27 dentifier-standard
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23 dentitier-standard
24%a dentifier-other
7 dentifier-standard
25 dentifier-standard
27 eport-number, dentifier-standard
28 umber-music-publiSher, 1dentifier-standard
S0 ODEN, ldentifier-standard
34 ap-scale
37 dentitier-standard, StoCK-numper
20 [Code-institution, Record-source
41 n
13 ode-geograpnic
50%b C-call-number:w, LC-call-number-p, LC-call-number:s
50 C-call-number:w, LC-call-number.p, LC-call-number.s
52 eographic-class
[510) LM-call-number
70 AL-call-number
80 DC-classification
82 ewey-classification:w, Dewey-classitication:s
36 umber-govi-pub
00%9 Toss-Reterence.w, Koha-Auth-Number
[ 00sa [Author,Author.p, Author.s, Editor, Author-personal-nbibliograpny,
JAuthor-personal-bibliography:p, Author-personal-bibliography:s
[ 00 JAuthor, Author-title, Author-name-personal, Name, Name-and-tile,
Personal-name
10%9 oha-Auth-Number
10 Author, Author-title, Author-name-corporate, Name, Name-and-tile,
[Corporate-name
TT$9 Koha-Auth-Number
m RUthor, Author-title, Author-name-corporate, Name, Name-and-tiie,
[Conference-name
30%n hematic-number
3057 USIC-KeY
3039 oha-Auth-Number
30 itle, Title-uniform
10 itle, Title-abbreviated
11 itle, Title-abbreviated
P17 Itle, Tile-other-variant
14 itle, Title-expanded
22 itle, Title-key
PA0%T USIC-KeY
403N hematic-number
40 itle:w, Title:p, Title-unirorm
233N hemafic-number
2351 USIC-Key
Pa3 te:w, Tie.p, T1iie-colective
PA5%a Itle-COVer.w, T1tle-cover.p, Tile-Cover.s, Te.w, Tie.p, T1ie.s
PA5%C Author, Author-in-order.w, Author-in-order.p, Author-in-order.s
PA5%9 ross-Reference.w, Konha-Auth-Number
75 ite:w, T1ie.p
46 itle, Title:p, Title-abbreviated, Title-expanded, Title-former
7 Itle, Tie:p, Tie-former, Tile-other-variant, Related-periodical
60%a W, pr.p
PE60SD ublisher:w, Publisher.p
P60SC copydate, copydaie:s
DGO o1
300 XteNt.w, EXtent.p
00%a ame-and-title
003t IAuthor-title, Name-and-title, Title, Title-series
0039 oha-Auth-Number
00 Ruthor, Author-name-personal, Name, Personal-name
10 [Author, Corporaie-name
T0%a ame-and-tte
105t JAuthor-title, Title, Title-series
1059 oha-Auth-Number
Flo Author-name-corporate, Name
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Author, Conference-name

TI%a ame-and-tille

115t JAuthor-title, Title-series

TT AUTthor-name-corporate, Name

20%a ifle-series:w, 1ile-series.p
17039 Koha-Auth-Number
70 Tfle-seres.w, T1le-seres.p, 11e, Tie-seres
I00%a Tle-seres.w, 11le-seres.p
EQU Tile, Tie-seres

9059 oha-Auth-Number

00 ote:w, Notep

07 aterial-type

053r Aathor

055t itle

05 ote.w, Note.p

TO ndexed-by

20 Abstract.w, Abstract.p

71%a exn

26%5C Erl, arln

265d TP, arp:n

00 ote:w, Note:p

00%a ame-and-tiile, Name, Personal-name, subject-name-personal, Subject

003t ame-and-tile, Tile, subject

0039 oha-Auth-Number

00 ame, Personal-name, Subjeci-name-personal, Subject

T0%a ame-and-tille

105t ame-and-title, Title

1039 oha-Auth-Number

T0 ame, Subject, Corporate-name

TT onference-name

TI%a ame-and-tie

115t ame-and-title, Title

1159 oha-Auth-Number

T ame, Subject

30%n hematic-number

3037 USIc-Key

3059 Koha-Auth-Number

30 Ubject

o059 oha-Auth-Number

50 UDJECT, Subject.p

o159 oha-Auth-Number

5T ame-geographic, Subject,Subject:p

5239 oha-Auth-Number

03%Y oha-Auth-Number

53 ubject, Subject.p

5259 Koha-Auth-Number

o Ubject

009Y oha-Auth-Number

55 Ubject

06359 oha-Auth-Number

56 TUbject

YA oha-Auth-Number

57 TUbject

90%9 Koha-Auth-Number

90 UDJECT, Subject.p

70059 Toss-Reterence, Koha-Auth-Number
/00%a JAuthor, Author:p

700%n hematic-number

70031 Usic-key

/005t Author-title, Name-and-title, Title, Title-uniform

Ruthor, Author-name-corporate, Author-name-personal, Name, Editor, |

00 Personal-name

T0 AUthor, Corporate-name

TOSt AUthor-title, Name-and-tile, Tie, 1ile-uniform
710%a ame-and-tie

10%9 oha-Auth-Number
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/10 JAuthor, Name

TI%a ame-and-tiile

115t [Author-title, Title, Title-uniform

1139 oha-Auth-Number

TT Ruthor-name-corporate, Name, conference-name
730%n hematic-number
730%r USIC-Key
/3039 oha-Auth-Number
/30 ltle, Title-uniform

20 itle, Tie-other-variant
agehsi ost-item
/80Dt itle

80 ile, Title-former, Related-periodical

85 elated-periodical

00%a ame-and-tie

003t AUthor-title, Name-and-tile, Tie, Tie-series

0039 oha-Auth-Number

00 [Author, Author-name-personal, Name, Personal-name
10%a ame-and-title

105t IAuthor-title, Name-and-title, Title, Title-series

T0%9 Koha-Auth-Number

T0 AUThor, Corporate-name, Author-name-corporate, Name
TI%a ame-and-tie

1159 oha-Auth-Number

TISE AUthor-title, Name-and-tile, Tie, Tie-series

TT Author, Author-name-corporate, Name, conference-name
3039 oha-Auth-Number

30 itle, Title-series

20 ile, Title-seres

99%C ocal-Number:n, Local-Number:w, Local-Number:s
99%d Tblioitemnumber:n, bibllotemnumDET:w, DIblloteMNUMDET:S
22350 otallsSUES: N, totallssues:s

1252 Cn-DIb-source

12356 CN-DIb-Sort:Nn, cn-bib-SOIt.s

[YAS femtype:w

123N UPPress:w, suppress:n

230 Cn-class

1730 Cn-item

2K Cn-prefix

22%m CR-SUTTIX

5250 thdrawn.n, wWitharawn.w

0251 ost, lost:n

5252 Classiication-source

52%3 aterials-speciied

52%4 damaged:.n, damaged:w

52%5 Festricted:n, restricted:w

5256 Cn-sort:n, cn-sort.s

5257 otforloan:n, notforloan:w

0236 ccode

5239 temnumber:n, itemnumber:s

572%a omebranch

525D oldingbranch

52%C ocation

52%d ate-of-acquisiion, Date-of-acquisiion:d, Date-of-acquisition:s
52%e cqsource

525t Coded-Tocation-qualiier

5250 price

5723 Bfackn, stackw

YA SSUEs:N, ISSUES:W, ISSUEs:S

52%m enewals:n, renewals:w

52%n €SEIVes.n, Ieserves:w

52%0 ocal-classiication:w, Local-classiiication:p, Local-classHication:s
52%p arcode, barcode.n

52%q bnloan:n, onloam:w

52%r fatelastseen

52%s Jatelastborrowed
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57231 Copynumber

523U uri:u

523V eplacementprice
525W eplacementpricedaie
523y type:w

52%z ote.w, Note:p

Chapter 12. About Koha

The 'About Koha' area will give you important server information as well as general information about Koha.

12.1. Server Information

Under the 'Server Information' tab you will find information about the Koha version and the machine you have installed Koha on. This information is very important
for debugging problems. When reporting issues to your support provider or to the various other support avenues (mailing lists, chat room, etc), it's always good to
give the information from this screen.

12.2. Perl Modules

In order to take advantage of all of the functionalities of Koha, you will need to keep your Perl modules up to date. The 'Perl Modules' tab will show you all of the
modules required by Koha, the version you have installed and whether you need to upgrade certain modules.

Items listed in bold are required by Koha, items highlighed in red are missing completely and items highlighted in yellow simply need to be upgraded.

Chapter 13. Implementation Checklist

The following guide will walk you through the areas of Koha you need to look at in order to prepare to start using the system.

13.1. Data Migration

Before you can start using Koha you'll need to have some data. This can be done by entering it all by hand, but most people already have their data in electronic
format of some sort and just need to reformat it a bit for importing into Koha.

Create a list of libraries and enter their info and codes into Libraries & Groups

Define your list of Item Types

Define you patron categories and enter the categories and their codes into Patron Categories
Enter any additional patron information fields you use in your library in the Patron Attributes

Requires that you first set the ExtendedPatronAttributes system preference if you have custom fields

Define all of your Authorized Values
Collection codes

Shelving locations

Item statuses (lost, not for loan, use restrictions)

Plus any others that are needed in your library

Optionally define City/Postal Code combos and Road Types for patron entry

Map your bibliographic data from your legacy system to Koha fields and migrate (remembering to use the collection, shelving, item type and library codes you
entered in the above setting areas)

Map your patron data from your legacy system to the Koha fields and migrate (remembering to use the patron and library codes you defined above)
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13.2. Admin Configuration

Most of these preferences won't need to be changed to use your Koha system, but there are a few that you might want to customize.

If your library uses CAS Authentication, you'll want to set the various CAS system preferences

Administration System Preferences

KohaAdminEmailAddress : This is the email address that will be used by the system in 'from’ lines and to send errors to if there is no email set for the

branch

noltemTypelmages : Decide if you want to show item type icons in the staff client and opac

delimiter : This value will be put in between fields when exporting data from Koha

virtualshelves : Decide if you want the staff and/or patrons to use lists in Koha

insecure : If your system is behind a local firewall, you can set it to no require log in for the staff client
AutoLocation : Require staff to log in to the staff client from a specific IP range

IndependantBranches : Prevent librarians from editing content that belongs to other branches

Go through the Log System Preferences and decide which actions you want to keep track of in the logs

13.3. Localization Configuration

Koha is used worldwide and so you need to make sure you set your localization preferences so that options throughout Koha appear properly for your
location/language.

Localization/Internationalization System Preferences
dateformat : Decide how dates are displayed throughout Koha

opaclanguagesdisplay : Decide if patrons can choose what language the OPAC appears in

opaclanguages : Decide which languages the patrons can choose from

language : Decide which languages appear in the staff client

13.4. Circulation Configuration

Before you start circulating your collection you'll need to set up your rules and preferences for circulation.
Define you Circulation/Fine rules

Enter the days vyour library is closed for fines and due date calculations

Circulation System Preferences
CircControl : Define whether circ rules are based on item's location, patron's location or transaction location
useDaysMode : Define how due dates are calculated
finesCalendar : Define how fines are calculated (for every late date or only for days the library is open)
SpecifyDueDate : Decide if staff are allowed to override due dates on checkout
AutomaticltemReturn : Decide if items are sent back to the owning branch when checked in

todayslssuesDefaultSortOrder : Decide how items checked out today display on the patron record

previousissuesDefaultSortOrder : Decide how items checked out prior to today display on the patron record

noissuescharge : Define the maximum amount a patron can owe before checkouts are blocked
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ReturnBeforeExpiry : Decide if patrons need to return items before their accounts expire
AllowOnShelfHolds : Decide if patrons can place holds on items that are marked as being available

AllowHoldPolicyOverride : Decide if you want the staff to be able to override the setting for the above at checkout

AllowHoldsOnDamagedItems : Decide if patrons can place holds on items that are marked as damaged

AllowHoldPolicyOverride : Decide if you want the staff to be able to override the setting for the above at checkout

maxreserves : Decide how many items a patron can have on hold at once

AllowHoldPolicyOverride : Decide if you want the staff to be able to override the setting for the above at checkout

maxoutstanding : Define the maximum amount a patron can owe before holds are blocked

AllowHoldPolicyOverride : Decide if you want the staff to be able to override the setting for the above at checkout

ReservesMaxPickUpDelay : Define the number of days before a hold expires

WebBasedSelfCheck : Decide if you want to use the built in web-based self-checkout system

AutoSelfCheckAllowed : Decide if the self-checkout system requires login

ShowPatronimagelnWebBasedSelfCheck : Decide if you want patron images to show on the self checkout screen

AllowNotForLoanOverride : Decide if you want the staff to be able to checkout items marked as ‘not for loan'

AllowRenewalLimitOverride : Decide if you want staff to override the limit put on renewals

RenewalPeriodBase : Decide what date renewals are based on
finesMode : Switch to ‘Calculate and Charge' before go live if you charge fines
OverdueNoticeBcc : If you want to receive a copy of every overdue notice sent out, enter your email address here

emailLibrarianWhenHoldIsPlaced : Decide if you want an email every time a hold is placed

ReservesControlBranch : Decide which branch's hold rules are considered first

soundon : Decide if you want to have sounds on for circulation actions
globalDueDate : If you want all your books due on the same date, enter that here
ceilingDueDate : If you want all books due no later than a specific date (like the end of a semester) enter a date here

FilterBeforeOverdueReport : If you have a large amount of overdues, you might want to turn this preference on so as to allow you to filter before results
appear

DisplayClearScreenButton : If you have a lot of staff members sharing one circ computer you might want to enable this so that staff can clear the screen in
between checkouts to protect patron's privacy

Customize your Notices

Define your Overdue Notice Triggers

Set up your cron jobs
Populate your holds queue (every 1-4 hours)
Decide when holds expire (daily)
Calculate fines due (daily)

Mark long overdue items as lost (daily)
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Decide when the system sends out messages (1-4 hours)

Decide when the system gueues overdue notices (daily)

Set up hold notices that didn't send for printing (daily after overdues and message queue)

Decide when the system gueues the advanced notice of items due (daily)

13.5. Patron Configuration

You have already imported patron data from your old system, but there are plenty of options available to you regarding patrons and their accounts.

Enter your staff members as patrons

Define staff members access permissions

Patron System Preferences
AddPatronLists : Decide how patron categories appear when creating a new patron
autoMemberNum : Decide if the patrons barcodes are auto-generated or if you enter them yourself
MaxFine : Determine the maximum amount that people can owe in fines

NotifyBorrowerDeparture : Decide when to warn staff that the patron account is about to expire

intranetreadinghistory : Decide if the staff can see the patron's reading/checkout history

BorrowerMandatoryField : List fields that you want to appear as mandatory on the patron add/edit form

BorrowersTitles : Add or change the titles for your patrons
borrowerRelationship : Add or change borrower relationships (child to adult and professional to organization)

AutoEmailPrimaryAddress : Determine if the patrons get an email confirming the creation of their account

EnhancedMessagingPreferences : Decide if patrons can choose from a series of notices (other than overdues)

patronimages : Decide if you want to save patron images in your system

ExtendedPatronAttributes : Decide if you want to enable custom patron fields

minPasswordLength : Enter the minimum number of characters you want passwords to have

13.6. Cataloging Configuration

Before you start cataloging in Koha you'll want to set up your preferences and other rules.

Define your cataloging templates aka MARC Bibliographic Frameworks

Run the MARC Bibliographic Framework Test to be sure your changes are valid

Define any authorized values you might want to use in cataloging

Set up custom classification sources (if you use something other than the defaults)

Set up MARC matching rules for importing records from mrc files or z39.50

Set up Koha to Keyword mapping for deciding how to display marc fields to the screen (still in beta - only one field)

Set up the z39.50 targets you want to search for cataloging (and acquisitions)
Cataloging System Preferences

URLLinkText : Enter text to display when 856 fields do not have pre-defined labels
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hide _marc : If you are unfamiliar with MARC you can have the MARC fields number hidden
LabelMARCView : Choose how you want duplicate fields to appear on the editor

DefaultClassificationSource : Choose which classification source is the default in your library

advancedMARCeditor : Decide if you need labels to appear on your MARC editor

marcflavour : Choose your MARC format

itemcallnumber : Enter which field and subfields to look into for the call number
MARCOrgCode : Enter your MARC Organizational Code (not the same as your OCLC number)
autoBarcode : Decide if Koha generates item barcodes for you

OpacSuppression : Decide if you want to hide items marked as suppressed from the OPAC search results

Set up your cron jobs

Decide when the system checks URLs in catalog records to see if they are still valid

13.7. Authorities Configuration

Koha has the ability to keep track of your authority records and how they're linked to your bibliographic records. Before using authorities you should configure
several preferences.

Set Authority Frameworks aka templates

Authority System Preferences
BiblioAddsAuthorities : Decide if Koha creates authorities when cataloging

dontmerge : Decide if updates to authorities trigger updates to the bibliographic records that link to them

Set up your cron jobs

Choose when the system looks for authorities updates to merge changes into bibliographic records

13.8. Searching Configuration

There are several system preferences related to searching, it is not always recommended to make too many changes to these preferences since they are set to
get you the most relevant results. If you would like to change the default way that Koha handles searching, view the Searching system preferences tab.

Set up your cron jobs

Decide how often your system rebuilds the search index (4-10 min)

13.9. OPAC Configuration

There are a lot of ways you can customize your OPAC in Koha.
Decide how you want your OPAC to look & what content you want on the main page

Create a library branded stylesheet using CSS

Do not edit the default CSS files, instead create a new one, that way the system can always fall back on the original CSS.
Create a custom XSLT stylesheet to change the way search results and bib records appear in the OPAC
OPAC System preferences

opacuserlogin : Decide if you want to allow patrons to login to the OPAC to access customized functionality (searching will be allowed without logging in)
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RequestOnOpac : Decide if patrons can place holds via the OPAC
OPACItemHolds : Decide if patrons can place holds on specific items (instead of just the next available item)

OpacPasswordChange : Decide if patrons can change their password (don't allow this if you're using LDAP)

OpacRenewalAllowed : Decide if patrons can renew their checked out items via the OPAC

opacreadinghistory : Decide if patrons can view their reading/checkout history via the OPAC
reviewson : Decide if you want to allow patrons to comment on bib records via the OPAC
virtualshelves : Decide if you want patrons to be able to create Lists

suggestion : Decide if you want patrons to be able to submit purchase suggestions

OPACViewOthersSuggestions : Decide if you want patrons to be able to see purchase suggestions made by other patrons

opacbookbag : Decide if patrons can save items into their cart
AnonSuggestions : Decide if you want non logged in users to be able to make purchase suggestions

OPACXSLTResultsDisplay : Decide if you want to use the XSLT stylesheets on the OPAC search results

OPACXSLTDetailsDisplay : Decide if you want to use the XSLT stylesheets on the bib records in the OPAC

LibraryName : Enter your library name for display in the <title> tag and on the top of the OPAC
opacsmallimage : Choose a logo to replace the Koha logo
opaccredits : Enter HTML to appear at the bottom of every page in the OPAC
OpacMainUserBlock : Enter HTML that will appear in the center of the main OPAC page
OpacNav : Enter HTML that will apper to the left on the main OPAC page
opacheader : Enter the HTML that will appear above the search box on the OPAC
Customize your stylesheets:
OPACUserCSS : Enter any additional fields you want to define styles for
opaclayoutstylesheet : Point to a CSS file on your Koha server
opacstylesheet : If you have a custom CSS enter the link to that file

opaccolorstylesheet : Point to a CSS file on your Koha server

OpacHighlightedWords : Decide if you want search terms to be highlighted on the search results

hidelostitems : Decide if you want to show patrons items you have marked as lost
BiblioDefaultView : Decide what view is the default for bib records on the OPAC
OPACShelfBrowser : Decide if you want to enable the shelf browse functionality

OPACURLOpeninNewWindow : Decide if URLs clicked in the OPAC are opened in a new window

SearchMyLibraryFirst : If you have a multi-branch system decide if you want patrons to search their library first
OpacAuthorities : Decide if you want patrons to be able to search your authority file
OpacBrowser : Decide if you want patrons to browse your authority file

OPACSearchForTitleln : Choose which libraries you want patrons to be able to re-run their search in

OpacAddMastheadLibraryPulldown : If you're a multi-branch system you can add a pull down to the search bar for patrons to search which library to

search
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EnableOpacSearchHistory : Decide if you want the system to keep a search history

Set up your cron jobs

If you have the OpacBrowser preference set decide when you want the contents to rebuild

If you have custom RSS feeds, decide when you want the feed to be populated

13.9.1. Editable OPAC Regions

Using the OPAC system preferences you can customize various regions, the following graphics will define what preferences update each regions.

An example of a way to customize the page is included as well:

13.10. Enhanced Content Configuration

Koha allows you to pull in content from outside sources to enhance your bib records. All of this content can be toggled on and off using the enhanced content
system preferences.

FRBR/Editions

If you would like to have your OPAC and/or staff client show an 'Editions' tab on the bib record, you want to enable one or the other FRBR preferences and
then either one or both of the ISBN services (XISBN and ThingISBN).

Amazon : This service is free and just requires that you visit http://aws.amazon.com to sign up

Using the Amazon preferences you can choose to show different types of content from Amazon. Before choosing which types of content you would like to
display you will need to enable Amazon content for the staff client and/or the OPAC.

Babeltheque

This is a pay service. Contact Babelthéque to learn how to enable this content in the OPAC.

Baker and Taylor

This is a pay service from Baker & Taylor. Contact Baker & Taylor for the information to enter into these preferences.

Google

This service is free and does not require registration, simply enable GoogleJackets and you're set to go.

LibraryThing

With the exception of ThingISBN, you will need to contact LibraryThing for the information to enter into these preferences

Enabling ThingISBN will help to populate the editions tab on the bib record display if you have enabled FRBR.

OCLC

XISBN is used to populate the editions tab on the bib record display if you have enabled FRBR. This service is free for up to 999 queries a day.

Syndetics

This is a pay service from Syndetics to add content for your bib records. Contact Syndetics for the information to enter into these preferences.

Tagging

Choose whether or not you want to allow patrons to add tags to records in Koha.
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13.11. Acquisitions Configuration

When using acquisitions in Koha you first need to define some defaults.
Set up your funds & budgets
Choose your default currency and enter others if you order from multiple countries
Enter in your vendor information

Create an Framework with the code ACQ (if you're going to enter item records at the time of ordering or receiving)

Acquisitions System preferences
AcqCreateltem : Decide if an item record is created during acquisition
CurrencyFormat : Decide how you want monetary amounts to display
gist : Enter your sales tax (if you are billed for tax)

OrderPdfFormat : Decide what format you want your print orders to use

13.12. Serials Configuration

When you use serials there are a few options you can set before hand.
Serials System Preferences

RenewSerialAddsSuggestion : Decide if you want renewing serials to add a suggestion for easy purchasing

RoutingSerials : Decide if you want to route serials around your library

RoutingListAddReserves : Decide if holds are placed on serials when there is a routing list in place

Cataloging System Preferences

StaffSeriallssueDisplayCount : Decide how many of the most recent issues to display in the staff client

OPACSeriallssueDisplayCount : Decide how many of the most recent issues to display in the OPAC

SubscriptionHistory : Decide how you want the subscription information to display in the OPAC

13.13. Planning for Go-Live

Once you have all of your settings ready, you need to prepare for making your system live:
Decide if you need training by an outside service or if your staff can do the training themselves.
Make sure that there is time for your staff to play with your test system and get comfortable with it
If this is a migration, work with your previous company to extract data right before you go live
Come up with URLSs for your new Koha OPAC & Staff Client

Make sure that if you're hosting your own system you have a backup plan

Chapter 14. SOPAC2 Installation

14.1. SOPAC2 Introduction

Jean-André SantoniAugust 2009Nicole C. Engard
The following documentation was translated using Google Translate from French to English and may have some language errors.
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14.2. Introduction

This is an installation guide and the connector SOPAC2 Koha. It has been tested on Debian Lenny and Ubuntu Jaunty, with 6.12 and Koha Drupal 3.0.x It does
not cover the installation of Koha and Drupal, but SOPAC, its dependencies and the connector.

14.3. Installation of Locum and Insurge

Locum and Insurge are the two libraries used primarily by SOPAC. They serve as a layer of abstraction to the data. Insurge manages the social aspect (tags,
reviews, ratings), while Locum manages the connection to the ILS via the connector. Both libraries use a different database from that of Drupal.

14.3.1. Dependencies

There are no packages for Debian MDB2 yet, you can install it via pear:

# apt-get install php-pear
# pear install MDB2
# pear install MDB2#nysql

14.3.2. Download

Download the Locum and Insurge libraries from SVN:

# cd /usr/local/lib
# svn co http://dobby.darienlibrary.org/svn/locum trunk/ |ocum
# svn co http://dobby. darienlibrary.org/svn/insurge/trunk/ insurge

14.3.3. Creation of the Database

$ nmysqgl -u root

nmysql > create database scas;

nysqgl > grant all privileges on scas.* to scas_user @I ocal host' identified by 'scas_pass';
nysql > flush privileges;

nysql > exit

14.3.4. Sync DSN

This file will provide the connection information to a DB libraries:
# nano /usr/local/etc/locum.insurge_dsn. php

It should contain:

<?php
$dsn = 'nysql ://scas_user:scas_pass@ ocal host/scas';

14.3.5. Installation of Insurge

If you customize the name of the database, consider editing the sq file:

# nano /usr/local/lib/insurgel/sqgl/scas_insurge.sql

Import Insurge:

$ nysql -u root -p < /usr/local/lib/insurgel/sql/scas_insurge.sql
Configure Insurge:

# nano /usr/local/lib/insurgel/config/insurge.ini

The variables in insurge.ini are empty. The default values are too long and cause MySQL errors.

Here is a sample of insurge.ini
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; This is the Locumconfiguration file

; General configuration options for your installation of Insurge.
[insurge_config]

dsn_file = "/usr/local/etc/l ocum.insurge_dsn. php"

; This is where you configure your repository menbership infornation.

; parent_server is the server nanme of the repository parent server you have been
: told to use.

; group_id = The group I D you have been given by your repository adm n.

; These configuration points are OPTIONAL and are only necessary if you are

; participating in a repository relationship.

[repository_info]

parent _server = ""

group_id =
group_key =

14.3.6. Installation of Locum

The same procedure applies to Locum

# nano /usr/local/lib/locunisqgl/scas_|l ocum sql

# nysqgl < /usr/local/lib/locunsqgl/scas_|locum sql
# nano /usr/local/lib/locunisqgl/locum.init.sql

# nmysqgl < /usr/local/lib/locunmsqgl/locum.init.sql
# nano /usr/local/lib/locum config/locumi ni

# nkdir /usr/local/var

# nkdir /usr/local/var/log

Configure the DSN:

[l ocum confi g]
dsn_file = "/usr/local/etc/l ocum.insurge_dsn. php"

And the coordinates of your Koha installation:

[ils_config]

ils = "koha";
ils_version = "30x"
ils_server = "l ocal host"
ils_harvest_port = "80"

The rest depends on your configuration of Koha.

14.4. Installation of Koha Connector

Enter the connector Koha from SVN:

# cd /usr/local/lib/locunm connectors/
# svn co http://dobby.darienlibrary.org/svn/connectors/koha/ |ocum koha_30x

14.5. Harvest Records

Now that the connector is in place, we will be able to launch harvest.php, a tool that will reap Locum DB Koha and fill the locum.
Start by configuring harvest.php:

# nano /usr/local/lib/locun tools/harvest.php

Here are the variables you must change:

$first_record = 1;
$l ast _record = 30;

These are the minimum and maximum biblionumbers from your Koha install.
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Then start the harvest:

# chnod +x /usr/local/lib/locuntool s/ harvest. php
$ /usr/local/lib/locuntool s/ harvest. php

14.6. Installation of Sphinx

Sphinx is the indexer for the database used by Locum and Insurge.

14.6.1. Dependencies

There is no Debian package for Sphinx so you'll have to compile the source directly:

# apt-get install g++ make |ibnysqgl ++-dev

14.6.2. Download and Compile

wget http://sphinxsearch. coni downl oads/ sphinx-0.9.8.tar. gz
tar zxvf sphinx-0.9.8.tar.gz

cd sphinx-0.9.8

./configure --prefix=/usr/local/sphinx

nake

nmake install

nkdir /usr/local/sphinx

nkdir /usr/local/sphinx/lib

cp api/ sphinxapi.php /usr/local/sphinx/lib/

rm-R sphinx-0.9. 8*

O H H H H AL BB

14.6.3. Creation of User and Group

Creating a Sphinx user and change the owner:

# adduser sphi nx

# addgr oup sphi nx

# usernmod -G sphi nx sphi nx

# nkdir /usr/local/sphinx/var/run

# chown -R sphinx. sphinx /usr/| ocal/sphinx/var

14.6.4. The demon Sphinx

Download:

# cd /etc/init.d
# wget http://ww. thesocial opac. net/sites/thesocial opac. net/fil es/sphinx
# chnod +x /etc/init.d/sphinx

Add Sphinx in the service at boot:

# update-rc.d sphinx defaults

14.6.5. Configuration

Copy the configuration file supplied with the source of Sphinx before the change:

# cp /usr/local/lib/locun sphinx/sphinx.conf /usr/local/sphinx/etc/

# sed 's/locum db_user/scas_user/g' /usr/local/sphinx/etc/sphinx.conf > tnpfile;
mv tnpfile /usr/local/sphinx/etc/sphinx.conf

# sed 's/locum db_pass/scas_pass/g' /usr/local/sphinx/etc/sphinx.conf > tnpfile;

And if you personalize the name of the BDD:

mv tnpfile /usr/local/sphinx/etc/sphinx.conf

# sed 's/scas/Ma_BDD/ g' /usr/local/sphinx/etc/sphinx.conf > tnpfile; nmv tnpfile /usr/local/sphinx/etc/sphinx.conf
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14.6.6. Indexing documents

Indexing is necessary if you want to use the search features of SOPAC.
You must first complete the Insurge table index

# chnmod +x /usr/local/lib/insurge/tool s/update-index. php
$ /usr/local/lib/insurge/tool s/ update-index.php

Then start indexing Sphinx

$ /usr/local /sphinx/bin/indexer --all

Finally, we must start the demon:

# /etc/init.d/ sphinx start

When the demon is already en route, you can update the index with:

$ /usr/local /sphinx/bin/indexer --all --rotate

14.7. Installation of SOPAC2

Now to the SOPAC software itself:

14.7.1. Download

Download from SVN:

$ cd /chemin/vers/drupal/sites/all/

$ nkdir nodul es

$ cd nodul es/

$ svn co http://dobby.darienlibrary.org/svn/sopac/trunk/ sopac

14.7.2. Installation

Going in the administration of Drupal to activate the module. Enable also the dependencies:
Profile
PHP Filter

Path

The Drupal menu should now list these entries.

14.7.3. Configuration

Then go into the settings of SOPAC.
Configure the paths to the Locum and Insurge libraries

Choose a URL prefix SOPAC, in my "catalog”. Create a node with content like:

<?php

print sopac_search_forn{'both');

print thene(' pages_catal og');
Check the Input Format "PHP Code"

Check Move to front page

In URL path settings, set the SOPAC URL prefix you have chosen.
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Go to the root of Drupal, a search form will appear.
Thinking to empty the cache of Drupal when something does not work.

Drupal offers a few blocks, not configured by default. Must specify on which page they should appear.

Chapter 15. Cron Jobs

15.1. Cron Jobs

The locations below assume a dev install which puts the crons in misc/, if you have a standard install you may want to look in bin/ for these files if you cannot find
them in misc/

15.1.1. Search

15.1.1.1. Rebuild Index

Script path: misc/migration_tools/rebuild_zebra.pl
Does: Updates Zebra indexes with recently changed data.
Required by: Zebra

Frequency suggestion: every x minutes, (between 5-15 minutes) depending on performance needs

15.1.2. Circulation

15.1.2.1. Holds Queue

Script path: misc/cronjobs/holds/build_holds_queue.pl
Does: Updates holds queue report

Required by: Holds Queue Report

Frequency suggestion: every 1-4 hours

15.1.2.1.1. Perl Documentation

GetBibsWithPendingHoldRequests
my $biblionumber_aref = GetBibsWithPendingHoldRequests();
Return an arrayref of the biblionumbers of all bibs that have one or more unfilled hold requests.
GetPendingHoldRequestsForBib
my $requests = GetPendingHoldRequestsForBib($biblionumber);
Returns an arrayref of hashrefs to pending, unfilled hold requests on
the bib identified by $biblionumber. The following keys are present in each hashref:
biblionumber
borrowernumber
itemnumber
priority
branchcode

reservedate
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reservenotes

borrowerbranch

The arrayref is sorted in order of increasing priority.
GetltemsAvailableToFillHoldRequestsForBib
my $available_items =
GetltemsAvailableToFillHoldRequestsForBib($biblionumber);
Returns an arrayref of items available to fill hold requests for the bib identified by $biblionumber. An item is available to fill a hold
request if and only if:

itis not on loan

it is not withdrawn

it is not marked notforloan

itis not currently in transit

it is not lost

it is not sitting on the hold shelf

MapltemsToHoldRequests
MapltemsToHoldRequests($hold_requests, $available_items);
CreatePickListFromltemMap

AddToHoldTargetMap

_get_branches_to_pull_from

Query system preferences to get ordered list of branches to use to fill hold requests.

15.1.2.2. Expired Holds

Script path: misc/cronjobs/holds/cancel_expired_holds.pl
Does: Cancels holds that have past their expiration.

Frequency suggestion: daily

15.1.2.3. Fines
Script path: misc/cronjobs/fines.pl
Required by: finesMode system preference

Frequency suggestion: nightly

15.1.2.4. Long Overdues

Script path: misc/cronjobs/longoverdue.pl
Does: allows one to specify delays for changing items to different lost statuses, and optionally charge for them.

Required by: Frequency suggestion: nightly

15.1.2.4.1. Perl Documentation
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NAME

longoverdue.pl cron script to set lost statuses on overdue materials. Execute without options for help.

15.1.3. Notices

15.1.3.1. Message Queue

Script path: misc/cronjobs/process_message_queue.pl
Does: processes the message queue to send emails and SMS messages to users. sends outgoing emails to patrons.

Frequency suggestion: 1-4 hours

15.1.3.2. Advanced Notice

Script path: misc/cronjobs/advance_notices.pl

Does: prepares "pre-due” notices and "item due" notices for patrons who request them prepares notices for patrons for items just due or coming due soon.
requires EnhancedMessagingPreferences to be on

Frequency suggestion: nightly

This script does not actually send the notices. It queues them in the message queue for later

15.1.3.2.1. Perl Documentation

NAME

advance_notices.pl - cron script to put item due reminders into message queue
SYNOPSIS

.Jadvance_notices.pl -c

or, in crontab: 0 1 * * * advance_notices.pl -c

DESCRIPTION

This script prepares pre-due and item due reminders to be sent to patrons. It queues them in the message queue, which is processed by the
process_message_queue.pl cronjob. The type and timing of the messages can be configured by the patrons in their "My Alerts" tab in the OPAC.

METHODS

parse_letter

15.1.3.3. Overdue Notice

Script path: misc/cronjobs/overdue_notices.pl
Does: prepares messages to alert patrons of overdue messages (both via email and print)

Frequency suggestion: nightly

This script does not actually send the notices. It queues them in the message queue for later or generates the HTML for later printing

15.1.3.3.1. Perl Documentation

NAME
overdue_notices.pl - prepare messages to be sent to patrons for overdue items
SYNOPSIS

overdue_notices.pl [ -n ] [ -library <branchcode> ] [ -library <branchcode>...] [ -max <number of days> ] [ -csv [ <filename> ]] [-itemscontent <field list> ]
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Options:

-help brief help message

-man full documentation

-n No email will be sent

-max <days> maximum days overdue to deal with

-library <branchname> only deal with overdues from this library (repeatable : several libraries can be given)
-csv <filename> populate CSV file

-html <filename> Output html to file

-itemscontent <list of fields> item information in templates
-borcat <categorycode> category code that must be included
-borcatout <categorycode> category code that must be excluded
OPTIONS

-help Print a brief help message and exits.

-man Prints the manual page and exits.

-v Verbose. Without this flag set, only fatal errors are reported.

-n Do not send any email. Overdue notices that would have been sent to the patrons or to the admin are printed to standard out. CSV data (if the -csv flag is set)
is written to standard out or to any csv filename given.

-max Items older than max days are assumed to be handled somewhere else, probably the longoverdues.pl script. They are therefore ignored by this program.
No notices are sent for them, and they are not added to any CSV files. Defaults to 90 to match longoverdues.pl.

-library

select overdues for one specific library. Use the value in the branches.branchcode table. This option can be repeated in order to select overdues for a group of
libraries.

-csv Produces CSV data. if -n (no mail) flag is set, then this CSV data is sent to standard out or to a filename if provided. Otherwise, only overdues that could not
be emailed are sent in CSV format to the admin.

-itemscontent

comma separated list of fields that get substituted into templates in places of the <<items.content>> placeholder. This defaults to issuedate,title,barcode,author
Other possible values come from fields in the biblios, items, and issues tables.

-borcat Repetable field, that permit to select only few of patrons categories.

-borcatout

Repetable field, permis to exclude some patrons categories.

-t | --triggered

This option causes a notice to be generated if and only if an item is overdue by the number of days defined in a notice trigger.

By default, a notice is sent each time the script runs, which is suitable for less frequent run cron script, but requires syncing notice triggers with the cron schedule
to ensure proper behavior. Add the --triggered option for daily cron, at the risk of no notice being generated if the cron fails to run on time.

-list-all

Default items.content lists only those items that fall in the range of the currently processing notice. Choose list-all to include all overdue items in the list (limited by
-max setting).

DESCRIPTION
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This script is designed to alert patrons and administrators of overdue items.
Configuration

This script pays attention to the overdue notice configuration performed in the "Overdue notice/status triggers" section of the "Tools" area of the staff interface to
Koha. There, you can choose which letter templates are sent out after a configurable number of days to patrons of each library. More information about the use of
this section of Koha is available in the Koha manual.

The templates used to craft the emails are defined in the "Tools: Notices" section of the staff interface to Koha.
Outgoing emails

Typically, messages are prepared for each patron with overdue items. Messages for whom there is no email address on file are collected and sent as
attachments in a single email to each library administrator, or if that is not set, then to the email address in the "KohaAdminEmailAddress" system preference.

These emails are staged in the outgoing message queue, as are messages produced by other features of Koha. This message queue must be processed
regularly by the misc/cronjobs/process_message_queue.pl program.

In the event that the "-n" flag is passed to this program, no emails are sent. Instead, messages are sent on standard output from this program. They may be
redirected to a file if desired.

Templates

Templates can contain variables enclosed in double angle brackets like <<this>>. Those variables will be replaced with values specific to the overdue items or
relevant patron. Available variables are:

<<bib>>

the name of the library

<<items.content>>

one line for each item, each line containing a tab separated list of title, author, barcode, issuedate
<<borrowers.*>>

any field from the borrowers table

<<branches.*>>

any field from the branches table

CSV output

The "-csv" command line option lets you specify a file to which overdues data should be output in CSV format.

With the "-n" flag set, data about all overdues is written to the file. Without that flag, only information about overdues that were unable to be sent directly to the
patrons will be written. In other words, this CSV file replaces the data that is typically sent to the administrator email address.

USAGE EXAMPLES

"overdue_notices.pl" - In this most basic usage, with no command line arguments, all libraries are procesed individually, and notices are prepared for all patrons
with overdue items for whom we have email addresses. Messages for those patrons for whom we have no email address are sent in a single attachment to the
library administrator's email address, or to the address in the KohaAdminEmailAddress system preference.

"overdue_notices.pl -n -csv /tmp/overdues.csv" - sends no email and populates /tmp/overdues.csv with information about all overdue items.
"overdue_notices.pl -library MAIN max 14" - prepare notices of overdues in the last 2 weeks for the MAIN library.
SEE ALSO

The misc/cronjobs/advance_notices.pl program allows you to send messages to patrons in advance of thier items becoming due, or to alert them of items that
have just become due.

INTERNAL METHODS
These methods are internal to the operation of overdue_notices.pl.

parse_letter
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parses the letter template, replacing the placeholders with data specific to this patron, biblio, or item
named parameters:

letter - required hashref

borrowernumber - required integer

substitute - optional hashref of other key/value pairs that should be substituted in the letter content
returns the "letter" hashref, with the content updated to reflect the substituted keys and values.
prepare_letter_for_printing

returns a string of text appropriate for printing in the event that an overdue notice will not be sent to the patron's email address. Depending on the desired output
format, this may be a CSV string, or a human-readable representation of the notice.

required parameters:
letter
borrowernumber
optional parameters:

outputformat

15.1.3.4. Print Hold Notices

Script path: misc/cronjobs/gather_print_notices.pl
Does: looks through the message queue for hold notices that didn't go through because the patron didn't have an email address and generates a print notice

Frequency suggestion: nightly

15.1.4. In Processing/Book Cart

Script path: misc/cronjobs/cart_to_shelf.pl
Does: Updates all items with a location of CART to the item's permanent location.

Required by: NewltemsDefaultLocation, InProcessingToShelvingCart, & ReturnToShelvingCart system preferences

Frequency suggestion: hourly

15.1.4.1. Perl Documentation

NAME

cart_to_shelf.pl cron script to set items with location of CART to original shelving location after X hours. Execute without options for help.

15.1.5. Catalog

15.1.5.1. Check URLs

Script path: misc/cronjobs/check-url.pl
Does: checks URLs in 856%u field. Script output can now be formatted in CSV or HTML. The HTML version links directly to MARC biblio record editor.
Frequency suggestion: monthly

Learn more: http://wiki.koha-community.org/wiki/Check-url enhancements

15.1.5.1.1. Perl Documentation
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NAME

C4::URL::Checker - base object for checking URL stored in Koha DB
SYNOPSIS

use C4::URL:: Checker;

ny $checker = C4::URL:: Checker->new( );

$checker->{ host_default } = "http://nylib. kohalibrary.con;
ny $checked_urls = $checker->check_biblio( 123 );

foreach my $url ( @checked_urls ) {

print "url: ", $url->{ url A}, "\n",
"is_success: ", $url->{ is_success }, "\n",
"status: ", $url->{ status },o"\n";
}
FUNCTIONS

new
Create a URL Checker. The returned object can be used to set default host variable :

ny $checker = C4::URL:: Checker->new( );
$checker->{ host_default } = "http://nylib. kohalibrary.con;

check_biblio

Check all URL from a biblio record. Returns a pointer to an array containing all URLs with checking for each of them.
ny $checked_urls = $checker->check_biblio( 123 );

With 2 URLs, the returned array will look like that:

[

{
‘url' => "http://nylib.tam|.fr/ing/62265_0055B. JPG ,
"is_success' => 1,
'status' =>"'ok'

},

{
‘url' => "http://nylib.tam|.fr//inmy/ 62265_0055C. JPG ,
"is_success' => 0,
"status' => '404 - Page not found'

}

NAME

check-url.pl - Check URLs from 856%u field.

USAGE

check-url.pl [--verbose|--help] [--host=http://default.tld]

Scan all URLs found in 856$u of bib records and display if resources are available or not.
PARAMETERS

--host=http://default.tld

Server host used when URL doesn't have one, ie doesn't begin with 'http:'. For example, if --host=http://www.mylib.com, then when 856%u contains
'img/image.jpg’, the url checked is: http://www.mylib.com/image.jpg'.

--verbose|-v
Outputs both successful and failed URLs.

--html
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Formats output in HTML. The result can be redirected to a file accessible by http. This way, it's possible to link directly to biblio record in edit mode. With this
parameter --host-pro is required.

--host-pro=http://koha-pro.tld
Server host used to link to biblio record editing page.
--help|-h

Print this help page.

15.1.5.2. Merge Authorities

Script path: misc/migration_tools/merge_authorities.pl
Does: Updates biblio data with changes to authorities records
Required by: dontmerge system preference

Frequency suggestion: nightly

15.1.5.3. Serials Update

Script path: misc/cronjobs/serialsUpdate.pl
Does: checks if there is a "late" issue on active subscriptions, and if there is, the script will set it as late, and add the next one as expected.

Frequency suggestion: nightly

15.1.6. OPAC

15.1.6.1. RSS Feeds
Script path: misc/cronjobs/rss/rss.pl
Does: Produces an RSS XML document for any SQL query (not used for search results RSS feed). Learn more.

Frequency suggestion: hourly

15.1.6.2. Authorities Browser

Script path: misc/cronjobs/build_browser_and_cloud.pl
Does: Generate content for authories browse in OPAC

Required by: OpacBrowser system preference

15.1.6.3. Subject/Author Clouds

Script path: misc/cronjobs/cloud-kw.pl
Does: Generates HTML keywords clouds from Koha Zebra indexes. misc/cronjobs/cloud-sample.conf has a sample of how this script operates.

Frequency: This is the type of script you can run once a month or so, the content generated isn't going to change very much over time.

15.1.6.3.1. Perl Documentation

NAME
cloud-kw.pl - Creates HTML keywords clouds from Koha Zebra Indexes
USAGE

cloud-kw.pl [--verbose|--help] --conf=cloud.conf
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Creates multiple HTML files containing kewords cloud with top terms sorted by their logarithmic weight. cloud.conf is a YAML configuration file driving cloud
generation process.

PARAMETERS
--conf=configuration file
Specify configuration file name
--verbose|-v

Enable script verbose mode.
--help|-h

Print this help page.
CONFIGURATION

Configuration file looks like that:

# Koha configuration file for a specific installation

# If not present, defaults to KOHA CONF

KohaConf: /hone/ koha/ nyli bray/ et ¢/ koha- conf . xm

# Zebra index to scan

Zebr al ndex: Aut hor

# Koha index used to link found kewords with an opac search URL
Kohal ndex: au

# Nunber of top keyword to use for the cloud

Count: 50

# Include CSS style directives with the cloud

# This could be used as a nodel and then CSS directives are

# put in the appropriate CSS file directly.

Wthcss: Yes

# HTML file where to output the cloud

Qut put: /home/ koha/ nyl i brary/ kohar oot / koha- t npl / cl oud- aut hor . ht m
KohaConf: /hone/ koha/ yourli bray/ et c/ koha-conf. xm

Zebr al ndex: Subj ect

Kohal ndex: su

Count: 200

Wthcss: no

Qut put: /home/ koha/ yourl i brary/ kohar oot/ koha-t npl / cl oud- subj ect . ht ni

IMPROVEMENTS

Generated top terms have more informations than those outputted from the time being. Some parameters could be easily added to improve this script:
WithCount

In order to output terms with the number of occurences they have been found in Koha Catalogue by Zebra.

CloudLevels

Number of levels in the cloud. Now 24 levels are hardcoded.

Weighting

Weighting method used to distribute terms in the cloud. We could have two values: Logarithmic and Linear. Now it's Logarithmic by default.

Order

Now terms are outputted in the lexical order. They could be sorted by their weight.

15.1.7. System Administration
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15.1.7.1. Clean up Database

Script path: misc/cronjobs/cleanup_database.pl

Does: Truncates the sessions table and cleans out old zebraqueue entries.

15.1.8. Deprecated scripts

These should not be run without modification:
Script path: misc/cronjobs/update_items.pl
Script path:misc/cronjobs/smsoverdues.pl
Script path:misc/cronjobs/notifyMailsOp.pl
Script path:misc/cronjobs/reservefix.pl

Script path:misc/cronjobs/zebraqueue_start.pl

Script path:misc/cronjobs/j2a.pl

Chapter 16. Web Services

16.1. OAI-PMH

16.1.1. Sample OAI Conf File

format:
Vs:
nmet adat aPrefix: vs
nmet adat aNanespace: http://veryspecial.tam|.fr/vs/format-pivot/1.1/vs
schena: http://veryspecial.tanmil.fr/vs/fornat-pivot/1.1/vs.xsd
xsl _file: [usr/local/koha/xslt/vs.xsl
mar cxni :
net adat aPrefix: nmarxm
nmet adat aNanespace: http://ww. | oc. gov/ MARC21/slim
http://ww. | oc. gov/ st andar ds/ mar cxm / schema/ MARC21sl i m
schenma: http://ww. | oc. gov/ MARC21/slim
http://ww. | oc. gov/ st andar ds/ mar cxm / schena/ MARC21sl i m xsd
oai _dc:
met adat aPrefi x: oai _dc
net adat aNarmespace: http://ww. openar chi ves. org/ OAl / 2. 0/ oai _dc/
schenma: http://ww. openarchives. org/ QAl /2. 0/ oai _dc. xsd
xsl _file:
lusr/1ocal / koha/ koha-tnpl/intranet-tnpl/xslt/UN MARCsl i m2QAI DC. xsl

Chapter 17. Using the SRU server

17.1. Using the SRU server

Nicolas MorinDecember 2009

Koha implements the Search/Retrieve via URL (SRU) protocol. More information about the protocol itself can be found at http://www.loc.gov/standards/sru/. The
version implemented is version 1.1.

17.1.1. Explain

If you want to have information about the implementation of SRU on a given server, you should have access to the Explain file using a request to the server
without any parameter. Like <http://myserver.com:9999/biblios/>. The response from the server is an XML file that should look like the following and will give you
information about the default settings of the SRU server.
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<zs: expl ai nResponse>

<zs:version>1. 1</ zs: versi on>

<zs:record>
<zs:recordSchema>http://expl ai n. z3950. org/ dtd/ 2. 0/ </ zs: r ecor dSchenma>
<zs:recordPacki ng>xm </ zs: r ecor dPacki ng>
<zs:recordDat a>
<expl ai n xm : base="zebr adb/ expl ai n-bi bl i os. xm ">
<l--
try stylesheet url: http://./?styl esheet =docpat h/ sru2. xs
-->

<serverlnfo protocol =" SRW SRU Z39. 50" >
<host >bi bl i br e</ host >
<port >9999</ port >
<dat abase>bi bl i os</ dat abase>

</ serverlnfo>

<dat abasel nf 0>
<title lang="en" primry="true">Koha 3 Bibliographi c SRU SRW Z39.50 server</title>
<description lang="en" prinmary="true">Koha 3 Bi bliographic Server</description>

<l'i nks>
<sru>http://biblibre:9999</sru>
</1inks>

</ dat abasel nf 0>
<i ndex| nf o>

<set name="cql" identifier="info:srwcqgl-context-set/1/cql-v1l.1">
<title>CQL Standard Set</title>
</set>

<i ndex search="true" scan="true" sort="fal se">
<title lang="en">CQL Server Choice</title>

<map>
<nane set="cql ">server Choi ce</ name>
</ map>
<map>
<attr type="1" set="bibl">text</attr>
</ map>
</i ndex>

<i ndex search="true" scan="true" sort="fal se">
<title lang="en">CQL All</title>
<map>
<nane set="cql">al | </ name>
</ map>
<map>
<attr type="1" set="bibl">text</attr>
</ map>
</ i ndex>
<l-- Record ID index -->
<i ndex search="true" scan="true" sort="fal se">
<title lang="en">Record ID</title>
<map>
<nanme set="rec">i d</ nane>
</ map>
<map>
<attr type="1" set="bibl">rec:id</attr>
<attr type="4" set="bibl">3</attr>
</ map>
</index>

17.1.2. Search

This url : http://myserver.com:9999/biblios?version=1.1&operation=searchRetrieve&query=reefs is composed of the following elements:

base url of the SRU server : http://myserver.com:9999/biblios?
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search part with the 3 required parameters : version, operation and query. The parameters within the search part should be of the key=value form, and can be
combined with the & character.

One can add optional parameters to the query, for instance maximumRecords indicating the maximum number of records to be returned by the server. So
http://myserver.com:9999/biblios?version=1.1&operation=searchRetrieve&query=reefs&maximumRecords=5 will only get the first 5 results results from the
server.

http://www.loc.gov/standards/sru/srul-larchive/search-retrieve-operation.html gives more details about the search operations and in particular the list of optional
parameters for searching.

17.1.2.1. More details about Search

The "operation” key can take two values: scan or searchRetrieve.
If operation=searchRetrieve, then the search key should be query. As in : operation=searchRetrieve&query=reefs
If operation=scan, then the search key should be scanClause. As in : operation=scan&scanClause=reefs

etc/zebradb/biblios/etc/bibl.att defines Zebra/3950 indexes that exist on your system. For instance you'll see that we have indexes for Subject and for Title: att 21
Subject and att 4 Title respectively.

In the pqgf.properties file located under etc/zebradb/pgf.properties | see that an access point already uses my Subject index (index.dc.subject = 1=21) while
another uses my Title index (index.dc.title = 1=4) | know this is my Subject index because as I've seen just before in my bibl.att file, it's called with =1=21 in
Z3950: so index.dc.subject = 1=21 correctly points to my Subject index. And Title was called with 1=4 so index.dc.title = 1=4 correctly points to my Title index. |
can now construct my query just like | would in a search box, just preceding it with the "query" key: query=Subject=reefs and Title=coral searches "reefs" in the
subject and "coral" in the title. The full url would be http://myserver.com:9999/biblios?version=1.1&operation=searchRetrieve&query=Subject=reefs and
Title=coral If | want to limit the result set to just 5 records, | can do
http://myserver.com:9999/biblios?version=1.1&operation=searchRetrieve&query=Subject=reefs and Title=coral&maximumRecords=5

| can also play with truncate, relations, etc. Those are also defined in my pgf.properties file. | can see for instance the position properties defined as:

position.first = 3=1 6=1
# "first in field"
posi tion. any = 3=3 6=1

# "any position in field"

So as an example if | want "coral" to be at the beginning of the title, | can do this query :
http://myserver.com:9999/biblios?version=1.1&operation=searchRetrieve&query=Title=coral first

17.1.3. Retrieve

My search for http://univ_lyon3.biblibre.com:9999/biblios?version=1.1&operation=searchRetrieve&query=coral reefs&maximumRecords=1 retrieves just on
record. The response looks like this:

<zs:searchRetri eveResponse>
<zs:version>1.1</zs: versi on>
<zs: nunber O Recor ds>1</ zs: nunber O Recor ds>
<zs:records>
<zs:record>
<zs: recordPacki ng>xml </ zs: r ecor dPacki ng>
<zs: recordDat a>
<record xsi:schemaLocation="http://ww.l oc.gov/ MARC21/slim http://ww. | oc. gov/ standards/marcxm /schema/ MARC21sl i m xsd">
<l eader> cam a22 4500</| eader >
<dat afield tag="010" ind1=" " ind2=" ">
<subfield code="a">2-603-01193- 6</ subfi el d>
<subfield code="b">rel.</subfield>
<subfield code="d">159 F</subfield>
</ dat afi el d>
<datafield tag="020" indl=" " ind2=" ">
<subfiel d code="a">FR</subfiel d>
<subfiel d code="b">00065351</ subfi el d>
</ dat afi el d>
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<datafield tag="101" ind1="1" ind2=" ">

<subfield code="c">ita</subfield>

</ dat afi el d>

<dat afield tag="105" ind1=" " ind2=" ">

<subfield code="a">a z 00|y| </subfield>

</ dat afi el d>

<datafield tag="106" indl=" " ind2=" ">

<subfi el d code="a">r</subfiel d>

</ dat afi el d>

<dat afield tag="100" ind1=" " ind2=" ">

<subfield code="a">20091130 frey50 </subfield>

</ dat afi el d>

<dat afield tag="200" ind1="1" ind2=" ">

<subfield code="a">Cuide des récifs coralliens / A GQuide to Coral Reefs</subfield>
<subfield code="b">Texte inprinmé</subfield>
<subfi el d code="e">l a faune sous-nmari ne des coraux</subfiel d>
<subfield code="f">A. et A Ferrari</subfield>

</ dat afi el d>

<dat afield tag="210" ind1=" " ind2=" ">

<subfiel d code="a">Lausanne</subfi el d>

<subfield code="a">Pari s</subfiel d>

<subfield code="c">Del achaux et N estlé</subfield>
<subfield code="d">cop. 2000</subfield>

<subfield code="e">inpr. en Espagne</subfiel d>

</ dat afi el d>

<dat afield tag="215" indl1=" " ind2=" ">
<subfield code="a">287 p.</subfield>
<subfield code="c">ill. en coul., couv. ill. en coul.</subfield>

<subfield code="d">20 cnx/subfiel d>

</ dat afi el d>

<i dzebra>

<si ze>4725</ si ze>

<l ocal nunber >2</ | ocal nunber >

<fil ename>/t np/ nwlOBJv9Pk/ upd_bi bl i o/ exported_records</fil enane>
</idzebra>

</record>

</ zs: recordDat a>
<zs:recordPosition>1</zs: recordPosition>
</ zs:record>

</ zs:records>

</ zs: searchRetri eveResponse>

Appendix A. System Preference Defaults

A.l. ISBD Defaults

A.1.1. MARC Default

#100]|{ 100a }{ 100b ¥ 100c ¥ 100d } 110a }{ 110b }{ 110c ¥ 110d ¥ 110e ¥ 110f }{ 110g }{ 130a }{ 130d }{ 130f ¥ 130g ¥ 130h ¥ 130k }{ 1301 }{ 130m ¥ 130n ¥
1300 }{ 130p ¥ 130r }{ 130s }{ 130t }{<br/><br/>

#245||{ 245a }{ 245b {245f }{ 245g }{ 245k }{ 245n }{ 245p ¥ 245s ¥ 245h }|
#246||{ : 246i }{ 246a H{ 246b X 246f K 246g K 246n X 246p ¥ 246h }|
#242||{ = 242a }{ 242b }{ 242n }{ 242p }{ 242h }|

#245||{ 245¢ }|

#242||{ = 242¢ }|
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#250]

#254),
#255),
#256],
#257),
#258),
#260] -
#300] -
#306) -
#307 -
#310) -
#321] -
#340) -

#342] -

- |{ 250a }{ 250b }|
I{ 254a}|

I{ 255a X 255b }{ 255¢ ¥ 255d ¥ 255e X 255f }{ 2559 }|

[{256a}|

{257a}|

I{ 258a X 258b }|

I{ 260a }{ 260b X 260c }|

I{ 300a ¥ 300b ¥ 300c ¥ 300d ¥ 300e ¥ 300f ¥ 300g }|

[{ 306a }|

[{307a } 307b}|

{3102 }{ 310b }|

[{321a } 321b}|

I{ 3403 }{ 340a ¥ 340b }{ 340c }{ 340d }{ 340e ¥ 340f } 340h ¥ 340i }|

[{ 342a }{ 342b ¥ 342c }{ 342d }{ 342e }{ 342f }{ 3429 ¥ 342h ¥ 342i }{ 342j { 342k ¥ 3421 }{ 342m X 342n }{ 3420 }{ 342p }{ 342q }{ 342r }{ 342s }{ 342t }{

342u }{ 342v ¥ 342w }]

#343)| -
#351] -
#352 -
#362] -
#440) -
#490) -

#800] -

I{ 343a }{ 343b }{ 343c X 343d ¥ 343e { 343f }{ 3439 K 343h } 343i }|
{ 3513 }{ 351a }{ 351b }{ 351c }|

{ 352a }{ 352b ¥ 352¢ X 352d }{ 352e H 352f }{ 3529 ¥ 352i { 3529 }|
I{ 362a }{ 351z }|

I{ 440a }{ 440n ¥ 440p ¥ 440v ¥ 440x }|.

I{ 490a }{ 490v }{ 490x }|.

[{ 800a }{ 800b }{ 800c X 800d }{ 800e H{ 800f }{ 800g }{ 800h }{ 800j }{ 800k ¥ 800! }{ 800m }{ 800n }{ 8000 }{ 800p }{ 800q }{ 800r }{ 800s ¥ 800t }{ 800u

H 800V }|.

#810|
#811]

#830)

- [{ 810a }{ 810b }{ 810c }{ 810d }{ 810e }{ 810f }{ 810g }{ 810h }{ 810k }{ 8101 }{ 810m ¥ 810n }{ 8100 ¥ 810p ¥ 810r }{ 810s }{ 810t ¥ 810u }{ 810v }|.
- [{811a }{ 811c }{ 811d }{ 811e }{ 811f }{ 811g }{ 811h }{ 811k }{ 8111 } 811n }{ 811p X 811q }{ 811s }{ 811t }{ 811u }{ 811v}.

- |{ 830a }{ 830d }{ 830f }{ 830g }{ 830h }{ 830k }{ 8301 }{ 830m }{ 830n } 8300 ¥ 830p }{ 830r ¥ 830s ¥ 830t }{ 830v }|.

#500|<br/><br/>|{ 5003 { 500a }|

#501|<br/><br/>|{ 501a }|

#502|<br/><br/>|{ 502a }|

#504|<br/><br/>|{ 504a }|

#505|<br/><br/>|{ 505a }{ 505t }{ 505r }{ 5059 }{ 505u }|

#506|<br/><br/>|{ 5063 }{ 506a ¥ 506b X 506¢ }{ 506d ¥ 506u }|

#507|<br/><br/>|{ 507a }{ 507b }|

#508|<br/><br/>|{ 508a }{ 508a }|

#510|<br/><br/>|{ 5103 }{ 510a ¥ 510x K 510c ¥ 510b }|

#511|<br/><br/>|{ 511a}|

#513|<br/><br/>|{ 513a }{513b }|
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#514|<br/><br/>|{ 514z { 514a { 514b H{ 514c }{ 514d }{ 514e }{ 514f }{ 5149 }{ 514h }{ 514i }{ 514j }{ 514k }{ 514m }{ 514u }
#515|<br/><br/>|{ 515a }|

#516|<br/><br/>|{ 516a }|

#518|<br/><br/>|{ 5183 }{ 518a }|

#520|<br/><br/>|{ 5203 }{ 520a }{ 520b ¥ 520u }|

#521|<br/><br/>|{ 5213 { 521a { 521b }|

#522|<br/><br/>|{ 522a }|

#524|<br/><br/>|{ 524a }|

#525|<br/><br/>|{ 525a }|

#526|<br/><br/>[{\n510i {\n510a { 510b { 510c }{ 510d H\n510x }|

#530|<br/><br/>|{\n5063 }{\n506a }{ 506b }{ 506¢ }{ 506d }{\n506u }|

#533|<br/><br/>|{\n5333 K\n533a }{\n533b {\n533c {\n533d }{\n533e }{\n533f {\n533m }{\n533n }|
#534|<br/><br/>|{\n533p }{\n533a }{\n533b H\n533c {\n533d }{\n533e K\n533f }{\n533m }\n533n H\n533t {\n533x }{\n533z }|
#535|<br/><br/>|{\n5353 K\n535a }{\n535b }{\n535c }{\n535d }|

#538|<br/><br/>|{\n5383 H\n538a }\n538i }{\n538u }|

#540|<br/><br/>|{\n5403 }{\n540a }{ 540b ¥ 540c ¥ 540d }{\n520u }|

#544|<br/><br/>|{\n5443 K\n544a }{\n544b K\n544c {\n544d }{\n544e K\n544n }|
#545|<br/><br/>|{\n545a ¥ 545b {\n545u }|

#546|<br/><br/>[{\n5463 K{\n546a } 546b }|

#547|<br/><br/>|{\n547a }|

#550|<br/><br/>|{ 550a }|

#552|<br/><br/>|{ 552z { 552a }{ 552b { 552c¢ { 552d }{ 552e N 552f } 5529 }{ 552h }{ 552i }{ 552j { 552k } 552 }{ 552m }{ 552n }{ 5620 H 552p K 552u }|
#555|<br/><br/>|{ 5553 }{ 555a }{ 555b ¥ 555¢ ¥ 555d ¥ 555u }|

#556|<br/><br/>|{ 556a }{ 506z }|

#563|<br/><br/>|{ 5633 }{ 563a }{ 563u }|

#565|<br/><br/>|{ 5653 }{ 565a { 565b }{ 565c }{ 565d H 565e }|

#567|<br/><br/>|{ 567a }|

#580|<br/><br/>|{ 580a }|

#581|<br/><br/>|{ 5633 }{ 581a }{ 581z }|

#584|<br/><br/>|{ 5843 }{ 584a }{ 584b }|

#585|<br/><br/>|{ 5853 }{ 585a }|

#586|<br/><br/>|{ 5863 }{ 586a }|

#020|<br/><br/><label>ISBN: </label>|{ 020a }{ 020c }|

#022|<br/><br/><label>ISSN: </label>|{ 022a }|

#222] = |{ 222a { 222b }|

#210] = [{ 210a ¥ 210b }|
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#024|<br/><br/><label>Standard No.: </label>|{ 024a ¥ 024c }{ 024d }{ 0242 }|
#027|<br/><br/><label>Standard Tech. Report. No.: </label>|{ 027a }|
#028|<br/><br/><label>Publisher. No.: </label>|{ 028a } 028b }|
#013|<br/><br/><label>Patent No.: </label>|{ 013a } 013b X 013c }{ 013d }{ 013e }{ 013f }|
#030|<br/><br/><label>CODEN: </label>|{ 030a }|

#037|<br/><br/><label>Source: </label>|{ 037a }{ 037b }{ 037c K 037f }{ 037g  037n }|
#010|<br/><br/><label>LCCN: </label>|{ 010a }|

#015|<br/><br/><label>Nat. Bib. No.: </label>|{ 015a }{ 0152 }|
#016|<br/><br/><label>Nat. Bib. Agency Control No.: </label>[{ 016a }{ 0162 }|

#600|<br/><br/><label>Subjects--Personal Names: </label>|{\n6003 {\n600a}{ 600b ¥ 600c } 600d } 600e } 600f { 600g { 600h H--600k}{ 600l  600m H 600n
H 6000 K--600p}{ 600r }{ 600s K 600t }{ 600u H--600x}{--600z}--600y}{--600v}|

#610|<br/><br/><label>Subjects--Corporate Names: </label>|{\n6103 {\n610a}{ 610b { 610c ¥ 610d ¥ 610e X 610f { 610g }{ 610h }{--610k} 6101 { 610m }{
610n }{ 6100 {--610p}{ 610r }{ 610s }{ 610t { 610u H--610x}{--610z}{--610y}{--610v}|

#611|<br/><br/><label>Subjects--Meeting Names: </label>|{\n6113 }{\n611a}{ 611b ¥ 611c }{ 611d }{ 611e }{ 611f }{ 611g }{ 611h }{--611k} 611l }{ 611m ¥ 611n
H 6110 {--611p} 611r }{ 611s }{ 611t }{ 611u H--611x}H--611z}{--611y}{--611v}|

#630|<br/><br/><label>Subjects--Uniform Titles: </label>|{\n630a}{ 630b }{ 630c { 630d { 630e K 630f }{ 630g X 630h }{--630k }{ 6301 }{ 630m ¥ 630n } 6300
H--630pK 630r Y 630s H{ 630t }{--630xH--630z}{--630y}{--630v}|

#648|<br/><br/><label>Subjects--Chronological Terms: </label>|{\n6483 }\n648a }{--648x}{--648z}{--648y}{--648V}|
#650|<br/><br/><label>Subjects--Topical Terms: </label>|{\n6503 }{\n650a}{ 650b }{ 650c }{ 650d }{ 650e H{--650x}{--650z}{--650y--650v}|
#651|<br/><br/><label>Subjects--Geographic Terms: </label>[{\n6513 {\n651a}{ 651b { 651c ¥ 651d ¥ 651e K--651xH--651z}{--651yK--651v}|
#653|<br/><br/><label>Subjects--Index Terms: </label>|{ 653a }|

#654|<br/><br/><label>Subjects--Facted Index Terms: </label>|{\n6543 K\n654a}{--654b}H{--654x}{--654zH--654y}--654V}|
#655|<br/><br/><label>Index Terms--Genre/Form: </label>|{\n6553 {\n655a}{--655b}{--655x H--655z}{--655y}H{--655Vv}|
#656|<br/><br/><label>Index Terms--Occupation: </label>|{\n6563 }{\n656a}--656k}{--656x--656z}{--656y}{--656V}|
#657|<br/><br/><label>Index Terms--Function: </label>|{\n6573 {\n657a}{--657xH--657z}{--657yH--657Vv}|

#658|<br/><br/><label>Index Terms--Curriculum Objective: </label>|{\n658a}--658b}{--658c}H{--658d}H{--658Vv}|

#050|<br/><br/><label>LC Class. No.: </label>|{ 050a }{ / 050b }|

#082|<br/><br/><label>Dewey Class. No.: </label>|{ 082a }{ / 082b }|

#080|<br/><br/><label>Universal Decimal Class. No.: </label>|{ 080a }{ 080x }{ / 080b }|

#070|<br/><br/><label>National Agricultural Library Call No.: </label>[{ 070a }{ / 070b }|

#060|<br/><br/><label>National Library of Medicine Call No.: </label>|{ 060a } / 060b }|

#074|<br/><br/><label>GPO Item No.: </label>|{ 074a }|

#086|<br/><br/><label>Gov. Doc. Class. No.: </label>|{ 086a }|

#088|<br/><br/><label>Report. No.: </label>|{ 088a }|

A.1.2. UNIMARC Default

#200|<h2>Title : [{200a}{. 200c} : 200e}200d}{. 200h}{. 200i}|</h2>
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#461|<label class="ipt">A part of : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search{&gq=461t&idx=ti}">{461t}</a>{Ncw 461h} {v.
461v}{(461d)}<br/>|

#200b|<label class="ipt">Material Designation : </label>| {200b }|<br/>

#101al<label class="ipt">Language(s): </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search{&q=101a&idx=In}">{101a}</a>|<br/>
#200f|<label class="ipt">Authors : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search{&g=200f&idx=au}">{200f ; }</a>|<br/>
#200g|<label class="ipt">Co-authors : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search{&q=200g&idx=au}">{200g ; }</a>|<br/>
#210a|<br/><label class="ipt">Place of pubblication : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=pl&q={210a}">{210a}</a>|<br/>
#210c|<label class="ipt">Publisher : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=pb&q={210c}">{210c ; }</a>|<br/>
#210d|<label class="ipt">Date of pubblication : </label>|{ 210d}|<br/>

#215|<label class="ipt">Description : </label>|{215a}{ : 215c}{ ; 215d}{ + 215e}|<br/>

#225a|<label class="ipt">Series :</label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search{&q=225a&idx=se}">{225a ;}</a> |

#225||{ = 225d}{ : 225e}{. 225h}. 225i} / 225}, 225x}{ ; 225v}|<br/>

#686|<label>Classification : </label>|{ 686a }|<br/>

#608|<label>Form, Genre : </label>|<a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&gq={608a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" title="Search on {608a}">{ 608a}</a>|<br/><br/>

#200||<label class="ipt">Subjects : </label><br/>|<ul>

#600|<label class="ipt">Person(s) </label><br/> |<li><a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&q={600a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" tittle="Search on {600a}">{ 600a}</a></li>|<br/>

#601|<label class="ipt">Organisation(s) </label><br/>|<li><a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&q={601a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" title="Search on {601a}">{ 601a}</a></li>|<br/>

#606|<label class="ipt">Term(s) </label><br/>|<li><a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&q={606a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" tittle="Search on {606a}">{ 606a}</a></li>|<br/>

#607|<label class="ipt">Place(s) </label><br/>|<li><a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&q={607a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" tittle="Search on {607a}">{ 607a}</a></li>|<br/>

#610|<label>Keywords</label><br/>|<li><a href="/cgi-bin/koha/catalogue/search.pl?op=do_search&idx=su&q={610a}"><img border="0"
src="/opac-tmpl/css/en/images/filefind.png" height="15" title="Search on {610a}">{ 610a}</a></li>|

#200||</ul>|
#856|<label class="ipt">Electronic resource : </label>|<a href="{856u}">click here</a> to go to the external resource<br/>
#010|<label class="ipt">ISBN : </label>|{010a ;}|<br/>

#011|<label class="ipt">ISSN : </label>|{011a ;}|<br/>

#200||<label class="ipt">Notes : </label>|<br/><ul>

#300||<li>{300a}</li>|

#307||<li>{307a}</li>|

#310||<li>{310a}</li>|

#326||<li>{326a}</li>|

#327||<li>{327a}</li>|

#333|<li>Public : |{333a}</li>|

#200||</ul>|

#330||<label class="ipt">Abstract : </label>|<br/>
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#330||{330a}|<br/>
#200||<br/><h2>Items</h2>|
#200|<table>|<th>Call number</th><th>Copy note</th><th>Fonds</th><th>Genre detail</th><th>Circulation type</th><th>Barcode</th>|

#995||<tr><td> {995k}</td><td> {995u}</td><td> {995y}</td><td>{995e} </td><td> {9950}</td><td>{995f}</td></tr>|</table>

A.2. NoZebralndexes Default

‘title' => '130a,210a,222a,240a,243a,245a,245b,246a,246b,247a,247b,250a,250b,440a,830a’,

‘author' =>'100a,100b,100¢,100d,110a,111a,111b,111¢,111d,245¢,700a,710a,711a,800a,810a,811a’,
'isbn' =>'020a’,

'issn' => '022a’,

'lccn' =>'010a’,

‘biblionumber' =>'999c",

'itemtype’ => '942c’,

'publisher' => '260b’,

'date’ =>'260c’,

‘note’ =>'500a, 501a,504a,505a,508a,511a,518a,520a,521a,522a,524a,526a,530a,533a,538a,541a,546a,555a,556a,562a,563a,583a,585a,582a’,
'subject’ => '600*,610*,611*,630*,650*,651*,653* 654*,655*,662*,690*,

‘dewey' =>'082',

‘be' =>'952p’,

‘callnum' => '9520",

‘an' =>'6009,6109,6119',

'homebranch' => '952a,952c'

Appendix B. Configuring Receipt Printers

The following instructions are for specific receipt printers, but can probably be used to help with setup of other brands as well.

B.1. For Epson TM-T88Ill (3) & TM-T88IV (4) Printers

NEKLS2008http://www.nexpresslibrary.org/go-live/configure-your-receipt-printers/

B.1.1. In the Print Driver

For these instructions, we are using version 5,0,3,0 of the Epson TM-T88III print driver; the EPSON TM-T88IV version is ReceiptE4. Register at the EpsonExpert
Technical Resource Center website to gain access to the drivers; go to Technical Resources, then choose the printer model from the Printers drop-down list.

Click Start > Printers and Faxes > Right click the receipt printer > Properties:
Advanced Tab, click Printing Defaults button
Layout Tab: Paper size: Roll Paper 80 x 297mm
TM-T88III: Layout Tab: Check Reduce Printing and Fit to Printable Width

TM-T88IV: Check Reduced Size Print; Click OK on the popup window that appears. Fit to Printable Width should be automatically selected.
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OK your way out of there.

B.1.2. In Firefox
Under File > Page Setup:
Shrink to fit page on Format & Options tab
0,0,0,0 for Margins on Margins & Header/Footer Tab. This makes the receipts use all available space on the paper roll.
Set all Headers/Footers to -blank-. This removes all of the gunk you might normally find on a print from firefox, such as the URL, number of pages, etc.

Click OK

Set the default printer settings in Firefox so you don't see a "Print" dialog:
Go to File > Print
Set the Printer to the receipt printer.
Click the Advanced (or Properties) button
Layout Tab: Paper size: Roll Paper 80 x 297mm
TM-T88III: Layout Tab: Check Reduce Printing and Fit to Printable Width
TM-T88IV: Check Reduced Size Print; click OK on the popup window that appears. Fit to Printable Width should be automatically selected.
OK your way out, go ahead and print whatever page you are on.
Type about:config, in the address bar. Click "I'll be careful, | promise!" on the warning message.
Type, print.always in Filter.
Look for print.always_print_silent.

If the preference is there then set the value to true.

If the preference is not there (and it shouldn't be in most browsers) you have to add the preference.
Right click the preference area and select New > Boolean

Type print.always_print_silent in the dialog box and set the value to True. This sets the print settings in Firefox to always use the same settings and print
without showing a dialog box.

Setting the print.always_print_silent setting in about:config DISABLES the ability to choose a printer in Firefox.

B.2. For Epson TM-T88Il (2) Printers

NEKLS2008http://www.nexpresslibrary.org/go-live/configure-your-receipt-printers/

Register at the EpsonExpert Technical Resource Center website to gain access to the drivers; go to Technical Resources, then choose the printer model from the
Printers drop-down list.

B.2.1. In Firefox
Under File > Page Setup:
Shrink to fit page on Format & Options tab
0,0,0,0 for Margins on Margins & Header/Footer Tab. This makes the receipts use all available space on the paper roll.
Set all Headers/Footers to -blank-. This removes all of the gunk you might normally find on a print from firefox, such as the URL, number of pages, etc.

Click OK
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Set the default printer settings in Firefox so you don't see a "Print" dialog:
Go to File > Print
Set the Printer to the receipt printer.
Print whatever page you are on.
Type about:config, in the address bar. Click "I'll be careful, | promise!" on the warning message.
Type, print.always in Filter.
Look for, print.always_print_silent.

If the preference is there then set the value to true.

If the preference is not there (and it shouldn't be in most browsers) you have to add the preference.
Right click the preference area and select New > Boolean

Type, print.always_print_silent in the dialog box and set the value to True. This sets the print settings in Firefox to always use the same settings and print
without showing a dialog box.

Setting the print.always_print_silent setting in about:config DISABLES the ability to choose a printer in Firefox.

B.3. For Star SP542 Printers

RHCLNicole C.Engard2010

B.3.1. Installing the Printer

While the following comments are based on the Star SP542 receipt printer, they probably apply to all printers in the SP5xx series.

The Star SP542 receipt printer works well with Koha and Firefox on Windows XP SP3. This printer, with either the parallel or USB interface, is fairly easy to install
and configure. You will need the following executable file which is available from numerous places on the Internet:

linemode_2k-xp_20030205.exe

This executable actually does all of the installation; you will not need to use the Microsoft Windows "Add Printer" program. We recommend that when installing,
the option for the software monitor not be selected; we have experienced significant pauses and delays in printing with it. Instead, simply choose to install the
receipt printer without the monitor.

Additionally, the install program may not put the printer on the correct port, especially if using the USB interface. This is easily corrected by going to "Start ->
Printers and Faxes -> Properties for the SP542 printer -> Ports", then check the appropriate port.

A reboot may be required, even if not indicated by the installation software or the operating system.

B.4. Configuring Firefox to Print to Receipt Printer

VOKALNicole C.Engard2010https://docs.google.com/View?id=dcccx9zm _3htvhwzgc#Setting_up_your SLIP printer 1 18087191815760117

Open File > Page Setup

Make all the headers and footers blank

Set the margins to 0 (zero)

In the address bar of Firefox, type about:config
Search for print.always_print_silent and double click it
Change it from false to true

This lets you skip the Print pop up box that comes up, as well as skipping the step where you have to click OK, automatically printing the right sized slip.

If print.always_print_silent does not come up
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Right click on a blank area of the preference window

Select new > Boolean

Enter "print.always_print_silent" as the name (without quotes)
Click OK

Select true for the value

You may also want to check what is listed for print.print_printer

You may have to choose Generic/Text Only (or whatever your receipt printer might be named)

Appendix C. Example Notice

Nicole Engard

410 Library Rd.

Philadelphia, PA 19107

Dear Nicole Engard (23529000035726),

According to our records, at the time of this notice, you have items that are overdue. Please return or renew them as soon as possible to avoid increasing late
fines.

If you have registered a password with the library, you may use it with your library card number to renew online.

If you believe you have returned the items below please call at and library staff will be happy to help resolve the issue.
The following item(s) are currently overdue:

07/08/2008 Creating drug-free schools and communities : 502326000054 Fox, C. Lynn.

06/27/2008 Eating fractions / 502326000022 McMillan, Bruce.

Sincerely, Library Staff

Appendix D. Sample Serials

D.1. Reader's Digest (0034-0375)

Published 12 times a year (monthly)

The Volume number changes every 6 months and the the numbers continues on (requires an advanced pattern).

D.2. People Weekly (1076-0091)

Published weekly

The website says "on Saturday except the first week of August, Thanksgiving week, the first and last weeks of the year" but this does not match the pattern
for 2007 or 2008

In the Jul-Dec there are 26 issues

In the Jan-Jun there are 25 issues (no issue for the first week of January)

Since the irregularity on the first # 26 does not skip a week, this would be set up as to roll over on issue 25. The 26th issue in the second half of the year would
have to be received as a supplemental.
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The irregularity check will complain that 52 issues were expected, but 25 entered. The current irregularity check can only check that the first position of the
numbering pattern matches the expected issue count of the periodicity. But we do need to trigger the rollover on the volume, so we need to define the last two
weeks of the year as irregularities. So we receive 50 issues the first 50 weeks, then one supplemental issue in week 51, which we have to define the enumeration
for, then the next predicted issue will be the following year's first week.

Appendix E. Using Koha as a Content Management System (CMS)

E.1. Setup

These are instructions for taking a default install of Koha 3.0 and allowing it to function as a little content management system. This will allow a library to publish
an arbitrary number of pages based on a template. This example uses the template for the main opac page, but you could just as well use any template you wish
with a bit more editing. This may be appropriate if you have a small library, want to allow librarians to easily add pages, and do not want to support a complete
CMS.

Copy /usr/share/koha/opac/cgi-bin/opac/opac-main.pl to /usr/share/koha/opac/cgi-bin/opac/pages.pl (in the same directory)
Edit pages.pl in an editor

At approximately line 32 add:

ny $cgi = new Cd ;

At approximately line 36 change this code:

t enpl at e_name =>
"opac-main. tnpl",

To this code:
tenpl at e_name => "pages.tnpl",
At approximately line 54 change this code:

$t enpl at e- >par an(
koha_news => $al | _koha_news,
koha_news_count => $koha_news_count

)
To this:

ny $page = "page_ $cgi - >paran(”p");
$t enpl at e- >par an{
koha_news => $al | _koha_news,
koha_news_count => $koha_news_count,
| ocal _page => ""
C4: : Cont ext - >pr ef er ence( $page)
)

Copy /usr/share/koha/opac/htdocs/opac-tmpl/prog/en/modules/opac-main.tmpl to /usr/share/koha/opac/htdocs/opac-tmpl/prog/en/modules/pages.tmpl
At approximately line 38, change this:

<l-- TMPL_I F NAME=" OpacMai nUser Bl ock"
--><di v id="opacnui nuserbl ock" class="contai ner"><!--
TMPL_VAR NAME="OpacMai nUser Bl ock" --></div><!-- [TMPL_IF
-->

To this:

<l-- TMPL_I F NAME="| ocal _page" --><div
i d="opacnui nuser bl ock" cl ass="contai ner"><!-- TMPL_VAR
NAME="| ocal _page" --></div><!-- /TMPL_IF
-->

In system preferences in the staff client, click the button for "New Preference" under "Local Use
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Fill it out as so
Explanation: test page for pages tiny cms
Variable: page_test
Value: Lorem ipsum
Click the TextArea link (or enter "TextArea" into the input field below it)

variable options (last field): 80|50

In a browser go to http://youraddress/cgi-bin/koha/pages.pl?p=test The page should come up with the words "Lorem ipsum" in the main content area of the
page. (replace "youraddress" with localhost, 127.0.0.1, or your domain name depending on how you have Apache set up.)

To add more pages simply create a system preference where the title begins with "page_" followed by any arbitrary letters. You can add any markup you want
as the value of the field. Reference the new page by changing the value of the "p" parameter in the URL.

E.1.1. Troubleshooting

If you have problems check file permissions on pages.pl and pages.tmpl. They should have the same user and group as other Koha files like opac-main.pl.

E.1.2. Bonus Points

Instead of using the address http://youraddress/cgi-bin/koha/pages.pl?p=test you can shorten it to http://youraddress/pages.pl?p=test Just open up
letc/koha/koha-httpd.conf and add the follow at about line 13:

ScriptAlias /pages.pl "/usr/sharel/koha/opac/ cgi -bin/opac/pages. pl "

Then restart Apache.

E.2. Usage

After setting up Koha as a CMS you can create new pages following these instructions:

E.2.1. Adding Pages

To add a new page you need to add a system preference under Local Use.
Get there: More > Administration > Global System Preferences > Local Use
Click 'New Preference’

Enter in a description in the Explanation field

Enter a value that starts with 'page_' in the Variable field
Enter starting HTML in the Value field

Set the Variable Type to Textarea

Set the Variable options to something like 20|20 for 20 rows and 20 columns

E.2.2. Viewing your page

You can view your new page at http://YOUR-OPAC/cgi-bin/koha/pages.pl?p=PAGENAME where PAGENAME is the part you entered after 'page_" in the Variable
field.

E.2.3. Example

This process can be used to create recommended reading lists within Koha. So once the code changes have been made per the instructions on 'Koha as a CMS'
you go through the 'Adding a New Page' instructions above to great a page for 'Recommended Reading Lists'
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Next we need to create pages for our various classes (or categories). To do this, return to the 'Adding a New Page' section and create a preference for the first
class.

Next you'll want to link your first page to your new second page, go to the page_recommend preference and click 'Edit.' Now you want to edit the HTML to include
a link to your newest page:

E.2.4. Live Examples

The Crawford Library at Dallas Christian College is using this method for their recommended reading lists: http://opac.dallas.edu/

Appendix F. Resetting the Koha Database

These notes on how to reset the database for Koha 3 were derived from the following email thread:
http://lists.koha-community.org/pipermail/koha-devel/2009-January/008939.html

Resetting the database may be useful if you install Koha with the sample data, and then wish to use real data without reinstalling the software.

F.1. Truncate Tables

Use your preferred MySQL client to truncate the following tables:

bibio
biblioitems
items
auth_header
sessions

zebraqueue

F.2. Reset the Zebra Index

Run the following commands to reset the authorities and biblios Zebra indices.

$ zebraidx -c /etc/kohal/zebradb/zebra-authorities-domcfg -g is02709 -d authorities init
$ zebraidx -c /etc/kohal/zebradb/zebra-biblios.cfg -g is02709 -d biblios init

Appendix G. Important Links

G.1. Koha Related

Report Koha Bugs - http://bugs.koha-community.org

Koha Versioning Control - http://git.koha-community.org/

Database Structure - http://git.koha-community.org/cdi-bin/gitweb.cqi?p=koha.git;a=blob plain:f=installer/data/mysqgl/kohastructure.sgl;hb=HEAD

Koha as a CMS - http://wiki.koha-community.org/wiki/Koha as a CMS

Kyles's Koha Tools - http://millruntech.com/koha/koha-tools

Koha Bibliography - http://www.zotero.org/groups/koha

Koha Shared Links - http://groups.diigo.com/group/everything-koha

Koha Presentations - http://www.slideshare.net/group/koha-ils/slideshows
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G.2. Cataloging Related

Koha MARC Tutorials - http://www.pakban.net/brooke/

Z39.50 Server Search - http://targettest.indexdata.com/

Z39.50 Server List - http://staff.library.mun.ca/staff/toolbox/z3950hosts.htm

Library of Congress Authorities - http://authorities.loc.gov/

MARC Country Codes - http://www.loc.gov/marc/countries/

Search the MARC Code List for Organizations - http://www.loc.gov/marc/organizations/org-search.php

Search for Canadian MARC Codes - http://www.collectionscanada.gc.ca/illcandir-bin/illsear/I=0/c=1

G.3. Enhanced Content Related

Amazon Associates - https://affiliate-program.amazon.com

Amazon Web Services - http://aws.amazon.com

WorldCat Affiliate Tools - http://www.worldcat.org/wcpa/do/AffiliateUserServices?method=initSelfRegister

XISBN - http://www.worldcat.org/affiliate/webservices/xisbn/app.jsp

LibraryThing for Libraries - http://www.librarything.com/forlibraries

G.4. Design Related

JQuery Library - http://wiki.koha-community.org/wiki/JQuery Library

Owen Leonard's Koha Blog - http://www.myacpl.org/koha

G.5. Reports Related

SQL Reports Library - http://wiki.koha-community.org/wiki/SQL Reports Library

Sample reports from NEKLS - http://www.nexpresslibrary.org/training/reports-training/

G.6. Installation Guides

Installing Koha 3 on Ubuntu - http://www.blazingmoon.org/guides/k3-on-u810-1.html

Koha on Debian installation documentation - http://openlib.org/home/krichel/courses/lis508/doc/koha installation overview.html

Koha 3.2 on Debian Squeeze - http://wiki.koha-community.org/wiki/Koha 3.2 on Debian Squeeze

G.7. Misc

Zotero - http://zotero.org

SOPAC - http://thesocialopac.net

Appendix H. Koha XSLT Item Types
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http://www.pakban.net/brooke/
http://targettest.indexdata.com/
http://staff.library.mun.ca/staff/toolbox/z3950hosts.htm
http://authorities.loc.gov/
http://www.loc.gov/marc/countries/
http://www.loc.gov/marc/organizations/org-search.php
http://www.collectionscanada.gc.ca/illcandir-bin/illsear/l=0/c=1
https://affiliate-program.amazon.com/
http://aws.amazon.com
http://www.worldcat.org/wcpa/do/AffiliateUserServices?method=initSelfRegister
http://www.worldcat.org/affiliate/webservices/xisbn/app.jsp
http://www.librarything.com/forlibraries
http://wiki.koha-community.org/wiki/JQuery_Library
http://www.myacpl.org/koha
http://wiki.koha-community.org/wiki/SQL_Reports_Library
http://www.nexpresslibrary.org/training/reports-training/
http://www.blazingmoon.org/guides/k3-on-u810-1.html
http://openlib.org/home/krichel/courses/lis508/doc/koha_installation_overview.html
http://wiki.koha-community.org/wiki/Koha_3.2_on_Debian_Squeeze
http://zotero.org
http://thesocialopac.net/

When you have any of the XSLT system preferences (OPACXSLTDetailsDisplay, OPACXSLTResultsDisplay, XSLTDetailsDisplay, and/or XSLTResultsDisplay)
along with the DisplayOPACiconsXSLT preference turned on you will see item type icons on the related screen.

These images are coming from values found in your leader, if your leader is not cataloged properly it might be best to turn off the DisplayOPACiconsXSLT
preference (which can be done while leaving the other XSLT preferences turned on).

Book [BK]

leader6 = a (and one of the leader7 values below)

leader7 = a
leader7 =c
leader7 =d
leader7 =m
leader6 =t

Computer File [CF]

leader6 = m

Continuing Resource [CR]

leader7 =b
leader7 =i
leader7 = s
Map [MP]
leader6 = e
leader6 = f
Mixed [MX]
leader6 = p
Sound [MU]
leader6 = c
leader6 = d
leader6 =i
leader6 = j

Visual Material [VM]

leader6 =g

leader6 = k

leader6 =r
Kit

leader6 =0
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Appendix I. MarcEdit

I.1. Adding a prefix to call numbers

When bringing data into Koha, you may want to first clean it up. One common action among Koha users is to add a prefix to the call number.
Open MarcEdit
Click 'MarcEditor'
Go to Tools > Edit Subfield Data

To prepend data the special character is: *b To simply prepend data to the beginning of a subfield, add ~b to the Field Data: textbox and the data to be
appended in the Replace

To prepend data to the beginning of the subfield while replacing a text string, add ~b[string to replace] to the Field Data textbox and the data to be
appended in the Replace With textbox.

I.2. Importing Excel data into Koha

Kanika GoyalNicole C.Engard2010http://www.botskool.com/geeks/how-import-excel-data-koha

Suppose you have records of your library in excel data sheet format and want them to import into Koha. But how will you do this? Koha will not let you import
excel records directly. Well here is a very simple solution for you which will let you import your excel records in Koha easily. First, we will convert excel file into
Marc file and then will import it into Koha.

Follow the given steps to import your excel records into Koha

1.2.1. Converting from Excel format into .mrk format

First, we will convert excel format into .mrk format. For this we will use MarcEdit. You can download it from
http://people.oregonstate.edu/~reeset/marcedit/html/downloads.html.

Now open it and select Add-ins-->Delimited Text Translator.

Click Next when the following window appears.

Browse for your excel file.

Locate your excel file by choosing the format Excel File(*.xIs).

Similarly, fill all the other entries such as Output File, Excel Sheet Name and check UTF-8 Encoded (if required) and Click Next.
Now you will be prompted for mapping the fields to recognise the fields by standard marc format.

Suppose for Field 0 that is first column | entered Map to: 022$a( Valid ISSN for the continuing resource) and then click on Apply.

You can customize Indicators and all other things, for more information on marc21 format visit the official library of congress site.

Similarly map all other fields and then Click on Finish.
And then a window will appear indicating that your Marc Text File(*.mrk) has been created.

Click Close and we have created a .mrk file from .xIs file in this step. You can view the file by double clicking on it.

1.2.2. Convert .mrk file to .mrc

We will convert .mrk file that we have created in the above step into raw Marc format that can be directly imported into Koha.
For this again open MarcEdit and Select MARC Tools.
Next Select MarcMaker to convert .mrk file into .mrc format.

Locate your input file and name your output file. Then Click Execute.
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And it will show you the Result.

Click Close and now we have raw Marc records wih us (.mrc file).

1.2.3. Import .mrc into Koha

More information on importing records into Koha can be found in the 'Stage MARC Records for Import' section of this manual.

Finally we will import above created .mrc file into Koha.

Click on Tools in your Koha staff client.

Next Click on Stage MARC Records for Import.

After this, choose your previously created .mrc file and click on Upload.
You can also add comment about file and finally click on Stage For Import.
When the import is done, you will get a result something like this

Next, click on Manage staged records.

Here you can even change matching rules.

Click on Import this batch into catalog when you are done.

Thats it. After all the records get imported, check Status and it should read "imported"”
You can even undo the Import operation.

And within few minutes, we have imported around 10,000 records in Koha

Appendix J. FAQs

J.1. Display

J.1.1. Custom Item Type/Authorized Value Icons

Question: Can | have my own set of item type images (or authorized value icons)?

Answer: Absolutely. To add additional icons to your system you simply add a new directory to koha-tmpl/intranet-tmpl/prog/img/itemtypeimg/ and to
koha-tmpl/opac-tmpl/prog/itemtypeimg and put your icons in the new directory. Your icons will show up in a new tab as soon as they are in the folders.

Remember to put the icons in both places (on the OPAC and the intranet).

J.1.2. Customizing Koha Images

Question: Can | customize the images in the OPAC?

Answer: Absolutely. Koha comes with a series of original images that you can alter to meet your needs. The originals can be found in the
misc/interface_customization/ directory.

J.1.3. Subtitle Display on Bib Records

Question: How do | get the subtitle to display on the detail pages for my bib records?

Answer: Subtitle display now depends on there being a keyword mapping for the MARC field in question. Adding a mapping for "subtitle" -> "245b" for an item's
framework results in display of the subtitle in OPAC and staff client search and detail pages (although not in all instances where subtitles might be displayed, e.g.
the Cart).

J.1.4. Customize Logo on Staff Client
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Owen LeonardJuly 2010
Question: How do | change the Koha logo on the Staff Client login page?

Answer: Opacsmallimage controls the display of the Koha logo in the OPAC, but there is no system preference controlling the logo on the staff client login page.
Luckily the logo is displayed via CSS so it can be easily customized through some custom CSS.

These are the relevant parts of the staff client default CSS:

#l ogin hl {

background:url ("../../inmg/ koha-1o0go.gif") no-repeat scroll center
top transparent;

mar gi n-bottom 0. 5em

nmar gi n-top: 0;

}

#login hl a {
bor der - bot t om medi um none;
di spl ay: bl ock;
hei ght : 74px;
text-indent:-1000px;

}

If you have access to the file system on your Koha server you can add a custom CSS file and specify that file using the intranetcolorstylesheet system preference.

There is no analogue to the OPACUserCSS preference in the staff client, but you can get around this by putting this in the intranetuserjs preference:

/111]>

</script>

<style type="text/css">

/* inline styles */

</styl e>

<script type="text/javascript">
[/ <![ CDATA[

In the above snippet where it says /* inline styles */ we'll redeclare the relevant properties from the styles of the login image:

111]>

</script>

<style type="text/css">
/[* inline styles */

#l ogin hl {
background: url ("../../inmy/ koha-1o0go.gif") no-repeat scroll center
top transparent;

}

#login hl a {
hei ght : 74px;
}
</styl e>
<script type="text/javascript">
/1 <!'[ CDATA]

I've only reproduced the properties necessary to make the change we want. You can see that the "background:" property sets the path to the default logo. You
can change this to point to any image you want, on the Koha server or anywhere else. Then you just need to change the #login h1 a's "height" property to match
the height of the image you choose.

For example:

111]>

</ script>

<style type="text/css">
/* inline styles */

#login hl {
background: url ("http://ww. nyacpl . org/sites/all/themes/npl/| ogo.png")
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no-repeat scroll center top transparent;

}

#login hl a {
hei ght : 71px;
}
</styl e>
<script type="text/javascript">
/1 <!'[ CDATA[

J.2. Circulation

J.2.1. Dropbox Date

Question: How is the dropbox date is determined? Is it the last open date for the checkout branch? Is it today's date minus one? Can the dropbox checkin date
be set?

Answer: If the library is closed for four days for renovations, for example, there would be more than one day needed for the dropbox date. You will only have one
dropbox date and that will be the last day that the library open (determined by the holiday calendar) because there is no real way to know what day the books
were dropped into the box during the 4 closed days. The only way to change the effective checkin date in dropbox mode is to modify the calendar.

J.2.2. Duplicate Overdue Notices

Question: Why are patrons getting two overdue notices?

Answer: This tool takes all branches in the overdue rules and sent notifications to them. So, if you have a default rule & a branch rule, the notification will be
generated twice. A quick fix is to discard "default rule" for instance.

J.2.3. Printing Overdue Notices

Question: Can | print overdue notices for patrons without email addresses on file?

Answer: Yes. The overdue notice cron job has a setting to generate the overdue notices as HTML for printing. An example of this useage would be:

overdue_notices.pl -t -htm /tnp/noticedir -itenscontent issuedate, date_due,title, barcode, author

In this example, we wanted to use only certain item fields in our notices, so we specified itemscontent fields in the cron entry; that's not a requirement for the
feature.

The command line needs to specify a web-accessible directory where the print notices will go -- they get a filename like notices-2009-11-24.html (or
holdnotices-2009-11-24.html). The overdue notice itself can be formatted to fit a Z-mailer. Within the notice file, the text is spaced down or over to where it will
print properly on the form. The script has code that wraps around the notice file to tell the HTML to obey the formatting, and to do a page break between notices.
That's so that when staff print it out, they get one per page. We had to add an extra syspref (PrintNoticesMaxLines) to specify page length because our client
allows a _lot_ of checkouts which meant some notices were running onto multiple pages. That syspref says to truncate the print notice at that page length and put
in a message about go check your OPAC account for the full list.

The print and email overdues use the same notice file. The print notices for holds are different -- there's a separate HOLD_PRINT notice file and the system uses
it if there's no email address. Then a nightly cron job runs to gather those up from the message queue and put them in an HTML file in the notice directory, as
above.

The cron entry is gather_print_notices.pl /tmp/noticedir

J.2.4. Unable to Renew Items

Question: We're trying to renew some items for our patron. One of the items is on hold and ineligible for renewal, but the other two items refuse to renew even
though they should be eligible. When | try to use the override renewal limit, it just returns a little message that says “renewal failed". Any idea what's going on
here?

Answer: At the very least you will need to set an absolute default circulation rule. This rule should be set for the default itemtype, default branchcode and default
patron category. That will catch anyone who doesn't match a specific rule. Patrons who do not match a specific rule will get blocked from placing holds, since
there was no baseline number of holds to utilize.
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J.2.5. Unable to Place Holds

Question: Why can't | place holds when | have all of the preferences turned on.

Answer: You probably need to set a default circulation rule. At the very least you will need to set an default circulation rule. This rule should be set for the default
itemtype, default branchcode and default patron category. That will catch all instances that do not match a specific rule. When checking out if you do not have a
rule for the default branch, default item and default patron category then you may see patrons getting blocked from placing holds.

J.2.6. Keyboard Shortcuts

Question: Do | have to use my mouse to access the checkout, checkin and cataloging tabs at the top of the circulation pages?

Answer: You can jump between the tabs on the quick search box at the top of the screen by using the following hot keys (if the tab is available):
jump to the catalog search with Alt+Q
jump to the checkout with Alt+U

this will not work for Mac user

jump to the checkin with Alt+R

Mac users use the OPTION button in place of ALT

J.3. Cataloging

J.3.1. Authority Fields

Question: Why can't | edit 1xx, 6xx, or 7xx fields in my catalog record?

Answer: These fields are authority controlled and you probably have the BiblioAddsAuthorities set to 'allow'. When it is set to ‘don't allow' these fields will be
locked and require you to search for an existing authority record.

J.3.2. Kohato MARC Mapping

Question: What's the relationship between 'Koha to MARC Mapping' and 'MARC Bibliographic Frameworks'?

Answer: Mapping can be defined through '"MARC Bibliographic Frameworks' OR 'Koha to MARC Mapping'. 'Koha to MARC Mapping' is just a shortcut to speed
up linkage. If you change a mapping in one of these modules, the mapping will change in the other as well. (In other words, the two modules 'overwrite' each
other in order to prevent conflicts from existing in Koha).

J.3.3. Number of Items Per Bib Record

Question: Is there a limit on the number of items | can attach to a bib record?

Answer: There is no explicit limit to the number of items you can attach to a bibliographic record, but if you attach enough of them, your MARC record will exceed
the maximum file size limit for the 1ISO-2709 standard, which breaks indexing for that record. I've found this occurs somewhere between 600 and 1000 items on a
‘normal’ bibliographic record.

J.4. Acquisitions

J.4.1. Planning Categories

Question: What is a planning category?

Answer: When you plan in advance for the way your budget is going to be spent, you initially plan for how it's going to be spent over time, that's the most natural
thing to do.

So you plan for $1000 in Jan. $1000 in Feb., $3000 in March, etc. You can basically do the same thing with a list of values in lieu of the months.

Say you have a list like this one:

page 195



< 1 month
< 6 months
<1year

< 3years
<10 years

> 10 years

The list is meant to represent when the books acquired where published. Then you plan for it, saying: we went to spend at list 40% of our budgets on books
published less than a year ago, 10% on books more than 10 years old, etc.

Upon acquiring new material, you'll be able to select, for a given item, a value from this list in a drop down. Then, after the material has been acquired, at the end
of the year, you'll be able to compare the goals set, with what's been achieved.

J.5. Serials

J.5.1. Advanced Patterns

Question: What is the 'inner counter' on the advanced serials pattern interface?
Answer: | think it is better to give an example to understand this :
Example for a monthly subscription :

First issue publication date : april 2010

Numbering : No {X}, year {Y}

First issue : No 4, year 2010

For the year Y : you will want the year change on january 2011
So, the advanced pattern for Y will be :

Add: 1

once every : 12

When more than 9999999

inner counter : 3

Set back to 0

Begins with 2010

Year is going to change after 12 received issues from april 2010, that is in April 2011 if you don't set inner counter. Set inner counter to 3 will say to Koha :
change year after 12-3 = 9 received issues.

Inner counter says to koha to take into account the first issues of the year, even if they are not received with Koha. If you begin with first issue of the year write
nothing or 0.

J.6. Reports

J.6.1. Define Codes Stored in DB

J.6.1.1. Fines Table

Question: What do the codes in the accounttype field in the accountlines table stand for?
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Answer:
A = acc't management fee
C = credit
F = overdue fine
FOR =forgiven

FU = overdue, still acccruing

L = Lost Item
M = Sundry
N = New Card

PAY = payment

W = writeoff

J.6.1.2. Statistics Table

Question: What are the possible codes for the type field in the statistics table?
Answer:
localuse

Registers if an item that had been checked out to a statistics patron (category type = 'X") is returned

issue
return
renew
writeoff
payment
CreditXXX

stores different types of fee credits, so a query to catch them all would include a clause like "type LIKE 'Credit%™

J.7. Searching

J.7.1. Advanced Search

J.7.1.1. Scan Indexes

Question: What does 'scan indexes' on the advanced search page mean?

Answer: When you choose an index, enter a term, click 'scan indexes' and do the search, Koha displays the searched term and the following terms found in this
index with the number of corresponding records That is search is not made directly in the catalog, but first in the indexes It works only for one index at once, and
only with no limit in Location (All libraries needed)

J.7.1.2. Searching for Terms that Start With a Character

Question: How do | search for all titles that start with the letter 'C'?

Answer: You can choose to search for things that start with a character or series of characters by using the CCL *first-in-subfield'
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example: ti,first-in-subfield=C

J.8. Enhanced Content

J.8.1. FRBRizing Content

Question: At our public library we are running a Koha installation and we've tried to turn on all the nice functionalities in Koha such as the frbrising tool, but do not
get the same result as Nelsonville public library.

Answer: In fact, this feature is quite tricky to make that right. First it looks at xisbn service. And then search in your database for that isbn. So both xisbn and your
internal isbn (in biblio table) have to be normalized. You could therefore use the script misc/batchupdatelSBNs.pl (it removes all the - in your local ISBNs)

J.8.2. Amazon

J.8.2.1. Amazon Private Key

Question: Why do | need the AWSPrivateKey as well as the AWSAccessKeyID to use Amazon Content?

Answer: After 2009-08-15, Amazon Web Services will expect that all requests to the Product Advertising API, which is what Koha uses for retrieving reviews and
other enhanced content from Amazon, include signatures. This patch and subsequenct patches implement this functionality.

What this means in practice (assuming the user has elected to use any enhanced content from Amazon) is that

The user must get a Amazon Secret Access Key. This can be done by logging in to the user's AWS account at (e.g.) http://aws.amazon.com/, going to the
'Access Identifiers' page, and from there retrieving and/or creating a new Secret Access Key.

The contents of the Secret Access Key should then be entered into the new AWSPrivateKey system preference.

Once that is done, grabbing reviews and table of contents from Amazon should work as normal. If the user doesn't do this before 2009-08-15, reviews and TOCs
will no longer be supplied from Amazon, although there should be no crashes - the content will simply not show up.

Note that the requirement to sign requests does *NOT* appear to apply to simply displaying book covers from Amazon.

J.8.2.2. All Amazon Content

Question: | have all of the Amazon preferences turned on and have entered both of my keys, but none of the content appears in my system, why is that?

Answer: Amazon's API checks your server time on all requests and if your server time is not set properly requests will be denied. To resolve this issue be sure to
set your system time appropriately. Once that change in made Amazon content should appear immediately.

On Debian the the command is date -s "2010-06-30 17:21" (with the proper date and time for your timezone).

J.9. System Administration

J.9.1. Errors in Zebra Cron

Question: | am noticing some errors in the koha-zebradaemon-output.log file. When new records are added it takes a bit longer to index than we think they
should. Running rebuild zebra is often faster. Zebra ends up indexing and search works, but | am concerned about the errors. Any ideas?

Answer: Rebuild_zebra.pl -r deletes all of the files in the Zebra db directories (such as reci-0.mf) and then recreates them. Thus, permissions will be lost, and the
files will be owned by the user who ran rebuild_zebra.pl. If one rebuilds the zebra indexes as root, the daemons, which typically run under the user koha, will not
be able to update the indexes. Thus, it's important then that the zebra rebuilds are put in the cronjob file of the user koha, and not root. Also important is that other
users, such as root, don't manually execute rebuilds.

If one desires that another user be able to execute rebuild_zebra.pl, he should be given the permission to execute 'sudo -u Koha .../rebuild_zebra.pl,’ (if you want
to do this, you also have to edit the sudoers file to pass the PERL5LIB variable with the env_keep option as by default sudo strips away almost all environment
variables). Or, as root user, one can use a simple 'su koha' and then the rebuild_zebra.pl command.

I've also tried to set the sticky bit on rebuild_zebra.pl, but for whatever reason it didn't seem to work due to some problem with the PERL5LIB variable that |
wasn't able to figure. That seems to me the easiest thing to do, if anybody has any idea how to make it work. If it worked and were the default, | think it would help
folks to avoid a great deal of the problems that come up with zebra.
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J.9.2. Making Z39.50 Target Public

Question: Could someone tell me the exact steps | need to take to configure Zebra to expose my Koha 3 db as a public Z39.50 service?
Answer: Edit the KOHA_CONF file that your Koha is using. Uncomment the publicserver line like:

<l-- <listen id="publicserver" >tcp:@:9999</listen> -->

to be:

<listen id="publicserver" >tcp:@:9999</listen>

Then restart zebasrv and connect on the port specified (9999).

J.9.3. Shelving Location Authorized Values

Question: When editing an item, the new shelving location | created is not showing up by default in the items where | assigned it to.

Answer: This is because you created the new shelving location with a code value of 0 (zero) Just FYI the system interprets authorized values of 0 as equaling a
null so when you edit a record in cataloging where the authorized value in a field was assigned where the code was 0, the value displays as null in the item editor
(or MARC editor) instead of the value the library meant it to be.

J.9.4. Why do | need Authorized Values?

Question: Why would | want to define authorized values for MARC tags?

Answer: Authorized Values create a 'controlled vocabulary' for your staff. As an example, let us assume that your Koha installation is used by several libraries,
and you use MARC 21. You might want to restrict the 850a MARC subfield to the institution codes for just those libraries. In that case, you could define an
authorized values category (perhaps called "INST") and enter the institution codes as the authorized values for that category.

Koha automatically sets up authorized value categories for your item types and branch codes, and you can link these authorized values to MARC subfields
when you set up your MARC tag structure.

J.9.5. How do | clean up the sessions table?

Question: Is there a periodic job that can be run to cull old sessions from the table? We don't want to backup all the useless session data every night.

Answer: You can run cleanup database cron job.

Or just before doing a backup command (mysgldump), you can truncate session table:

nmysql -u<kohauser -p<password <koha-db-nane -e ' TRUNCATE TABLE sessi ons'

J.10. Hardware

J.10.1. Barcode Scanners

Question: What barcode scanners have been known to work with Koha?

Answer: The simple rule of thumb is, does it act like a keyboard device?, if so, it will work. (i.e. can you take the scanner, scan a barcode and have it show up in
a text editor, if so, it will work.)

The main points to check are that it connects to your PC conveniently (can be USB or "keyboard wedge" which means it connects in line with the keyboard, which
is useful with older computers), and that it scans the barcode type that you are using.

Itis a good idea to test some 'used' barcodes if you have any, to see whether the scanner can read scuffed or slightly wrinkled ones successfully. Most scanners
are capable of reading several barcode types - there are many, and the specification should list the ones it can read. You may need to adjust settings slightly,
such as prefix and suffix characters, or whether you want to send an 'enter' character or not.

One more tip - some can be set 'always on' and may come with a stand, some have triggers under the handle, some have buttons on top, some are held like a
pen. Think about the staff working with the hardware before choosing, as a button in the wrong place can be very awkward to use.

J.10.2. Printers
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J.10.2.1. Printers used by Koha libraries

POS-X receipt printer

Star Micronics printer (exact model unknown) with a generic/plain text driver.
Star SP2000 (Nelsonville)

Star TSP-100 futurePRINT (Geauga)

"I know there have been a lot of questions on receipt printers so | thought I'd pass on my findings. We have been testing the Star TSP-100 futurePRINT. |
found this print to be VERY easy to configure for Koha. | was even able to customize the print job by adding our system logo (a .gif) to the top of every
receipt. Also with a bitmap created in Paint was able to add a message at the bottom of each receipt with the contact information, hours and website for the
library that the materials were checked out at."

Epson TM 88 IIIP thermal receipt printers

Epson TM-T88IV

1x1 labels using a Dymolabelwriter printer

J.10.2.2. Braille Support

Question: Are there any braille embosser or printer which has inbuilt braille converter and it is accessible with UNIX environment?

Answer: You may want to look into BRLTTY (http://www.emptech.info/product details.php?ID=1232).

J.10.2.3. Additional Support

http://www.nexpresslibrary.org/go-live/configure-your-receipt-printers/

Appendix K. Extending Koha

K.1. Amazon lookup script for Koha libraries

Cab VintonSeptember 2009http://lists.katipo.co.nz/pipermail/koha/2009-September/020003.html

We order most of our materials from Amazon, so I've been looking for a convenient way to tell if a book under consideration is in our catalog already.
Greasemonkey & a custom user script fit the bill nicely:

https://addons.mozilla.org/en-US/firefox/addon/748

http://userscripts.org/scripts/show/56847

A few caveats:
Like most scripts, this one was designed to work with Firefox; | haven't explored getting it to work with other browsers.
I'm not a JavaScript programmer -- this was adapted from others' work. Just a few lines would have to be changed to get the script to work with your catalog.

It depends on the existence of ISBN for the item in question, so movies, older books, etc. would not work.

Others have added all sorts of bells & whistles: xISBN lookups to search for related titles, custom messages based on the status of items (on order, on hold, etc.),
... just search the UserScripts site for Amazon + library. For a later date!

K.2. Keyword Clouds

In addition to the traditional tag cloud availabe in Koha, there is a way to generate clouds for popular subjects within Koha.

The Author/Subject Cloud cron job is used to help with this process. This cron job sends its output to files.
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/home/koha/mylibrary/koharoot/koha-tmpl/cloud-author.html
/home/kohalyourlibrary/koharoot/koha-tmpl/cloud-subject.html
This means that you can produce clouds for authors, collective author, all kind of subjects, classifications, etc. And since it works on zebra indexes, it is quick,

even on large DBs. Tags clouds are sent to files. It's up to library webmaster to deal with those files in order to include them in OPACMainUserBlock, or include
them into their library CMS.

Some libraries even send the file into a Samba shared folder where webmaster take them, eventually clean them a little bit before integrating them into navigation
widgets or pages.

Appendix L. GNU General Public License version 3

Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General
Public License is intended to guarantee your freedom to share and change all versions of a program—to make sure it remains free software for all its users. We,
the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors.
You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or
use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities
if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You
must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal
permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is
fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products
for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those
products. If such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed
to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on
general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary.

To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

“This License" refers to version 3 of the GNU General Public License.

“Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
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“The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as “you". “Licensees" and “recipients” may be individuals
or organizations.

To “modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The
resulting work is called a “modified version” of the earlier work or a work “based on" the earlier work.

A “covered work" means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable
copyright law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making
available to the public, and in some countries other activities as well.

To “convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer
network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may
convey the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a
prominent item in the list meets this criterion.

1. Source Code.

The “source code" for a work means the preferred form of the work for making modifications to it. “Object code" means any non-source form of a work.

A “Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a
particular programming language, one that is widely used among developers working in that language.

The “System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major
Component, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard
Interface for which an implementation is available to the public in source code form. A “Major Component”, in this context, means a major essential component
(kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an
object code interpreter used to run it.

The “Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object
code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or
generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding
Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms
that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.
2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This
License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the
output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works,
provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered
works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted
material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.
3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.
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4. Conveying Verbatim Copies.

You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on
each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to
the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.
5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4,
provided that you also meet all of these conditions:

The work must carry prominent notices stating that you modified it, and giving a relevant date.

The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the
requirement in section 4 to “keep intact all notices".

You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with
any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to
license the work in any other way, but it does not invalidate such permission if you have separately received it.

If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display
Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not
combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an “aggregate" if the compilation and its
resulting copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work
in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding
Source under the terms of this License, in one of these ways:

Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on
a durable physical medium customarily used for software interchange.

Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least
three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1)
a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for
software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the
Corresponding Source from a network server at no charge.

Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally
and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the
same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the
place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports
equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what
server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are
being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying
the object code work.

A “User Product" is either (1) a “consumer product", which means any tangible personal property which is normally used for personal, family, or household
purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be
resolved in favor of coverage. For a particular product received by a particular user, “normally used" refers to a typical or common use of that class of product,
regardless of the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a
consumer product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant
mode of use of the product.
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“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified
versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued
functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in
which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is
characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply
if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the
modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

“Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If
additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by
this License without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional
permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by
you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material)
supplement the terms of this License with terms:

Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works
containing it; or

Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from
the original version; or

Limiting the use for publicity purposes of names of licensors or authors of the material; or
Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual
assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it,
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains
a further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license
document, provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those
files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply
either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and
will automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means,
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after
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your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your
rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a
consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you
permission to propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a
covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to
this License. You are not responsible for enforcing compliance by third parties with this License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging
organizations. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives
whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding
Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee,
royalty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit)
alleging that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is
called the contributor's “contributor version".

A contributor's “essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a
consequence of further modification of the contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for
sale, import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a “patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an
express permission to practice a patent or covenant not to sue for patent infringement). To “grant” such a patent license to a party means to make such an
agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the
Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner
consistent with the requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge
that, but for the patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more
identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a
patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then
the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is “discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that
is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under
which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of
the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain
the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you
under applicable patent law.

12. No Surrender of Others' Freedom.
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If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the
conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from
those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the
Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU

Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is
the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the
combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar
in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License “or any later
version" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free
Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the
Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of
acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a
result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO
MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM
TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies
a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software which
everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively state the exclusion of warranty;

and each file should have at least the “copyright" line and a pointer to where the full notice is found.

one line to give the programis name and a brief idea of what it does.
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Copyright (C) year nane of author

This programis free software: you can redistribute it and/or nodify
it under the terms of the GNU General Public License as published by
the Free Software Foundation, either version 3 of the License, or
(at your option) any later version.

This programis distributed in the hope that it will be useful,
but W THOUT ANY WARRANTY; wi thout even the inplied warranty of
MERCHANTABI LI TY or FI TNESS FOR A PARTI CULAR PURPCSE. See the
G\U CGeneral Public License for nore details.

You shoul d have received a copy of the GNU General Public License
along with this program |f not, see http://ww.gnu.org/licenses/.

Also add information on how to contact you by electronic and paper mail.

If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

program Copyright (C year nanme of author

This program cones with ABSOLUTELY NO WARRANTY; for details type ‘show w .
This is free software, and you are welcone to redistribute it

under certain conditions; type ‘show c' for details.

The hypothetical commands ‘show w and ‘show c' should show the appropriate parts of the General Public License. Of course, your program's commands
might be different; for a GUI interface, you would use an “about box".

You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer" for the program, if necessary. For more
information on this, and how to apply and follow the GNU GPL, see http://www.gnu.org/licenses/.

The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider
it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Lesser General Public License instead of this
License. But first, please read http://www.gnu.org/philosophy/why-not-Igpl.html.
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